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Limited Liability Statement
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only by personnel with knowledge of and training in the use and maintenance of oceanographic
electronic equipment.

SEA-BIRD ELECTRONICS, INC. disclaims all product liability risks arising from the use or servicing
of this system. SEA-BIRD ELECTRONICS, INC. has no way of controlling the use of this equipment
or of choosing the personnel to operate it, and therefore cannot take steps to comply with laws
pertaining to product liability, including laws which impose a duty to warn the user of any dangers
involved in operating this equipment. Therefore, acceptance of this system by the customer shall be
conclusively deemed to include a covenant by the customer to defend, indemnify, and hold SEA-BIRD
ELECTRONICS, INC. harmless from all product liability claims arising from the use or servicing of
this system.
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Section 1: Introduction

This section includes a brief description of SEASOFT-Win32 and its
components, and a more detailed description of SBE Data Processing.

Sea-Bird welcomes suggestions for new features and enhancements of our
products and/or documentation. Please contact us with any comments or
suggestions (seabird@seabird.com or 425-643-9866). Our business hours are
Monday through Friday, 0800 to 1700 Pacific Standard Time (1600 to 0100
Universal Time) in winter and 0800 to 1700 Pacific Daylight Time (1500 to
0000 Universal Time) the rest of the year.

Summary

Note:

The following SEASOFT-DOS

calibration modules are not available

in SEASOFT-Win32:

e OXFIT — compute oxygen
calibration coefficients

o OXFITW — compute oxygen
calibration coefficients using
Winkler titration values

e PHFIT — compute pH coefficients

See the SEASOFT-DOS manual.

SEASOFT-Win32 consists of modular, menu-driven routines for acquisition,
display, processing, and archiving of oceanographic data acquired with
Sea-Bird equipment. SEASOFT-Win32 is designed to work with a PC running
Win 2000/XP; extensive testing has not shown any compatibility problems
when using the software with a PC running Windows Vista.

SEASOFT-Win32 is actually several stand-alone programs:

e SeatermV2 (a launcher for Seaterm232, Seaterm485, and SeatermIM),
SEATERM, and SeatermAF terminal programs that send commands for
status, setup, data retrieval, and diagnostics to a wide variety of Sea-Bird
instruments.

Note: SeatermV?2 is used with our newest generation of instruments,
which have the ability to output data in XML.

e Seasave V7 program that acquires and displays real-time and raw
archived data for a variety of sea-Bird instruments.

e SBE Data Processing program that converts, edits, processes, and plots
data for a variety of Sea-Bird instruments.

e  Plot39 program for plotting SBE 39, 39-IM, and 48 data.

This manual covers only SBE Data Processing.
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Notes:

e SBE 37-Sl and 37-SIP - SBE Data
Processing can be used with data
uploaded from firmware version 3.0
and later. Earlier versions of these
MicroCATSs did not have internal
memory, and SBE Data
Processing is not compatible with
real-time MicroCAT data.

e SBE 39, 39-IM, and 48 data -

SBE Data Processing support is
limited; see Processing SBE 39,
39-IM, and 48 Data in Section 3:
Typical Data Processing
Sequences.

System Requirements

Sea-Bird recommends the following minimum system requirements for
SEASOFT-Win32: Windows 2000 or later, 500 MHz processor, 256 MB
RAM, and 90 MB free disk space for installation.

Products Supported

SBE Data Processing supports the following Sea-Bird products:

e SBE 9plus CTD with SBE 11plus Deck unit (often referred to as 911plus)
or with SBE 17 or 17plus SEARAM (often referred to as 917plus)

e SBE 16 SEACAT C-T (optional pressure) Recorder
e SBE 16plus and 16plus-IM SEACAT C-T (optional pressure) Recorder

e SBE 16plus V2 and 16plus-IM V2 SEACAT C-T (optional pressure)
Recorder

e SBE 19 SEACAT Profiler

e SBE 19plus SEACAT Profiler

e SBE 19plus V2 SEACAT Profiler

e SBE 21 SEACAT Thermosalinograph
e SBE 25 SEALOGGER CTD

e SBE 37-SM, 37-SMP, 37-IM, 37-IMP, 37-SI, and 37-SIP MicroCAT
Conductivity and Temperature (optional pressure) Recorder

e SBE 39 and 39-IM Temperature (optional pressure) Recorder

e SBE 45 MicroTSG Thermosalinograph

e SBE 48 Hull Temperature Sensor

e SBE 49 FastCAT CTD Sensor

Additionally, SBE Data Processing supports many other sensors / instruments
interfacing with the instruments listed above, including Sea-Bird oxygen, pH,

and ORP sensors; SBE 32 Carousel Water Sampler and SBE 55 ECO Water
Sampler; and assorted equipment from third party manufacturers.
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Software Modules

SBE Data Processing includes the following modules:

See Section 9.

Type Module Name Module Description
Ins“?umen.t . Define instrument configuration and
configuration Configure o .

. calibration coefficients.
See Section 4.
Convert raw .hex or .dat data to
Data engineering units, and store converted
Conversion | data in .cnv file (all data) and/or .ros file
Data
. (water bottle data).
conversion Bottle Summarize data from water sampler .ros
See Section 5. . .
Summary file, storing results in .btl file.
Mark Scan Create .bsr bottle scan range file from
.mrk data file.
Align data (typically conductivity,
Align CTD temperature, and oxygen) relative
to pressure.
Bin Average Average data, basing blgs on pressure,
depth, scan number, or time range.
Compute Brunt Viiséld buoyancy and
Buoyancy it
stability frequency.
Data Cell Thermal | Perform conductivity thermal
processing Mass mass correction.
Performed on . Calculate salinity, density, sound
converted data Derive .
velocity, oxygen, etc.
from a .cnv file. -
See Section 6. Filter Low-pass filter columns of data.
Mark scan with badflag if scan fails
Loop Edit pressure reversal or minimum
velocity test.
wild Edit Mark dgta value with badflag to eliminate
wild points.
Window Eilter Filter Qata with tr}angle., cosine, boxcar,
Gaussian, or median window.
Add header information to .asc file
ASCIlIn containing ASCII data.
Output data and/or header from
.cnv file to ASCII file (.asc for data,
ASCII Out .hdr for header). Useful for exporting
File converted data for processing by
manipulation non-Sea-Bird software.
See Section 7. Section Extract data rows from .cnv file.
. Split data in .cnv file into upcast and
Split
downcast files.
Strip Extract data columns from .cnv file.
Convert data in .cnv file from ASCII to
Translate . .
binary, or vice versa.
] Plot data (C, T, P as well as derived
Da;a pltzittlng variables, overlay plots, and TS contour
Performed on plots). Plots can be sent to printer, or
converted data Sea Plot .
saved to file or clipboard. Sea Plot can
from a .cnv file. .
See Section 8. plot data. at any point after Data
Conversion has been run.
Miscellaneous
Performed on Calculate derived variables from one
data typed in SeacalcW user-input scan of temperature,
by user. pressure, etc.




Section 1: Introduction

Differences from SEASOFT-DOS

SEASOFT was previously available in a DOS version. Following are the main
differences between SEASOFT-Win32 and SEASOFT-DOS, as they relate to
data processing:

1. SEASOFT-Win32 does not include the following calibration modules that
are available in SEASOFT-DOS:
e  OXFIT — Compute oxygen coefficients.
e  OXFITW — Compute oxygen coefficients using Winkler
titration values.
e PHFIT — Compute pH coefficients.

2. SEASOFT-Win32 includes several stand-alone programs; you can install
any or all of these programs as desired:

e SBE Data Processing — replaces the data processing programs and
SEACON in SEASOFT-DOS.

e  Terminal Programs — Windows-based terminal programs SeatermV?2
(a launcher for Seaterm232, Seaterm485, and SeatermIM),
SEATERM, and SeatermAF replace the terminal programs in
SEASOFT-DOS (TERM1621, TERM17, TERM19, TERM25,
TERM37, TERMAFM, TERM11, and TMODEM).

e Seasave — Windows-based Seasave V7 replaces SEASAVE and
SEACON in SEASOFT-DOS.

e Plot39 - Windows-based plotting program for SBE 39, 39-IM, and
48 data.

3. The SBE 9plus (with SBE 11plus Deck Unit or SBE 17 or 17plus
SEARAM) is the only version of the SBE 9 that is supported in SBE Data
Processing. Sea-Bird has been manufacturing the SBE 9plus since 1991.

4. The SBE 31 is not supported in SBE Data Processing.
5. Processing capability (for example, interfacing to additional auxiliary

sensors) added to our software after November 2000 has been added only
to the Windows version.
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Section 2: Installation and Use

SEASOFT-Win32 requires approximately 90 Mbytes of disk space during
installation. Ensure there is room on your hard drive before proceeding.
Sea-Bird recommends the following minimum system requirements for
SEASOFT-Win32: Windows 2000 or later, 500 MHz processor, and

256 MB RAM.

Installation

Note:

Sea-Bird supplies the current version

of our software when you purchase

an instrument. As software revisions
occur, we post the revised software
on our FTP site.

e You may not need the latest
version. Our revisions often include
improvements and new features
related to one instrument, which
may have little or no impact on
your operation.

See our website (www.seabird.com)

for the latest software version

number, a description of the software
changes, and instructions for
downloading the software from the

FTP site.

1. Ifnot already installed, install SBE Data Processing and other Sea-Bird
software programs on your computer using the supplied software CD:

A. Insert the CD in your CD drive.

B. Double click on Seasoft-Win32date.exe (where date is the date the
software release was created).

C. Follow the dialog box directions to install the software.
The default location for the software is c:\Program Files\Sea-Bird. Within
that folder is a sub-directory for each program. The installation program

allows you to install the desired components. Install all the components,
or just install SBE Data Processing.

10
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Getting Started

Note:

SBE Data Processing modules can
be run from the command line.
Also, batch file processing can be
used to process a batch file to
automate data processing tasks.
See Appendix I: Command Line
Options, Command Line Operation,
and Batch File Processing.

SBE Data Processing Window

To start SBE Data Processing:

Double click on SBEDataProc.exe

(default location c:\Program Files\Sea-Bird\SBEDataProcessing-Win32), or
(for Windows 98 and later) Left click on Start and follow the path
Programs\Sea-Bird\SBEDataProcessing-Win32

The SBE Data Processing window looks like this:

& SBE Data Processing =10 x|
RFun Configure Help

1. Data Conversian. ..
. Filker...

. align CTO. ..

. Cell Therrnal Mass..
. Loop Edit. ..

, Derive, ..

. Bin Average. ..

it = T o R A o Y % |

&, Bottle Summary. ..
9, Mark Scan...
- 10, Buoyancy..,
11, wild Edit...
12, window Filker, ..

13, ASCII In...
14, ASCIT Out, .,
15, Section. ..
16, Split...

17, Strip...

18, Translate, ..

19, Sea Plat. ..

20, Seacalch' Yersion 1.0...

Cammand Line Options. ..

Exit

The window’s menus are described below.
Run -

>

>

List of data processing modules, separated into categories: typical
processing for profiling CTDs (1-7), other data processing (8-12), file
manipulation (13-18), plotting (19), and seawater calculator (20).
Select the desired module to set up the module parameters and
process data. Module Dialog Box provides an overview of the module
dialog box for all modules except Sea Plot and SeacalcW; Sections 5
through 9 provide details for each module.

Command Line Options: Select Command Line Options to assist in
automating processing. See Appendix I: Command Line Options,
Command Line Operation, and Batch File Processing.

Exit: Select to exit the program.

Configure - List of instruments that require a configuration (.con) file,
which defines the number and type of sensors interfacing with the
instrument, as well as the sensor calibration coefficients. Select the
desired instrument to modify or create a .con file. See Section 4:
Configuring Instrument (Configure).

Help - General program help files as well as context-specific help.

11
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Note:

Versions 5.30a and earlier of SBE
Data Processing used program setup
files with a .psu extension instead of
a .psa extension. Program setup files
with a .psa extension can be opened,
viewed, and modified in any text
editor or XML editor.

SBE Data Processing can still use
your existing .psu files. However, if
you make any changes to the setup
(for example, change output
variables), SBE Data Processing will
save the changes to a new .psa file.

Note:

The dialog box for Sea Plot and
SeacalcW differ from the other
modules. See Section 8:

Data Plotting Module — Sea Plot

and Section 9: Miscellaneous Module
- SeacalcW.

Module Dialog Box

To open a module, select it in the Run menu of the SBE Data Processing
window. Each module’s dialog box has three menus:

[ ]
n

VVVVVYVYY

ile -

Start Process - begin to process data as defined in dialog box
Open - select a different program setup (.psa) file

Save or Save As - save all current settings to a .psa file

Restore - reset all settings to match last saved .psa file

Default File Setup - reset all settings on File Setup tab to defaults
Default Data Setup - reset all settings on Data Setup tab to defaults
Exit or Save & Exit - exit module and return to SBE Data
Processing window

e  Options (where applicable) -

>

Confirm Program Setup Change -

- If selected, program provides a prompt to save the program setup
(.psa) file if you make changes and click the Exit button or select Exit
in the File menu without clicking or selecting Save or Save As.

- If not selected, program changes EXxit to Save & Exit; to exit
without saving changes, use the Cancel button.

Confirm Instrument Configuration Change -

- If selected, program provides a prompt to save the configuration
(.con) file if you make changes and then click the Exit button in the
Configuration dialog box without clicking Save or Save As.

- If not selected, program changes Exit button to Save & EXxit; to exit
without saving changes, use the Cancel button.

Overwrite Output File Warning -

- If selected, program provides a warning if output data will
overwrite an existing file.

- If not selected, program automatically overwrites an existing file
with the same file name as the output file.

Inconsistent Data Setup Warning -

- If selected, program provides a warning if the configuration (.con)
file and/or the input data file are inconsistent with the selected output
variables. For example, if the user-selected output variables include
conductivity difference, but you remove the second conductivity
sensor from the .con file, a warning will appear. The warning details
what output variable cannot be calculated, and allows you to retain
the change to the .con file (and remove the inconsistent output
variable) or restore the .con file to the previous configuration.

- If not selected, program automatically changes the user-selected
output variables to be consistent with the selected configuration or
data file.

Sort Input Files —

- If selected, Sea Plot sorts the input files in alphabetical order.

- If not selected, Sea Plot maintains the order of the files as you
selected them using the Ctrl key; use this feature if there is a
particular data set you want to use as the base on a waterfall overlay
plot. Note that using the Shift key to select files will not maintain the
selected order.

e Help - contains general program help files as well as context-specific help
(where applicable)

Each module’s dialog box typically has three tabs - File Setup, Data Setup,
and Header View. The File Setup and Header View tabs are similar for most
modules, and are discussed below. The Data Setup tab contains input
parameters specific to the module. Additionally, Data Conversion and Derive
have a fourth tab — Miscellaneous. See the module discussions in Sections 5
through 7 for details.

12
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Note:

Versions 5.30a and earlier of SBE

Data Processing used

files with a .psu extension instead of a
.psa extension. Program setup files

The following examples and discussion of the File Setup and Header View
tabs is for Data Conversion. The other modules (except Sea Plot and

SeacalcW) are similar; however, not all fields are applicable to all modules.
program setup

with a .psa extension can be opened, File Setup Tab

viewed, and modified in any text editor

or XML editor.
SBE Data Processing
your existing .psu files

make any changes to the setup (for

example, change outp
SBE Data Processing

changes to a new .psa file.

can still use
. However, if you

Directory and file name for file to store all information input in File Setup and Data
Setup tabs. Open to select a different .psa file, Save or Save As to save current
settings, or Restore to reset all settings to match last saved version.

See note above.

ut variables),
will save the

Directory and file name for
instrument configuration
(.con) file, which defines
instrument configuration
and sensor calibration
coefficients. This file is
used in Data Conversion,
Bottle Summary, and
Derive. Select to pick a
different file, or Modify to
view and/or modify
instrument configuration.

&E Data Conversion =10 x]
File Options Help
e Select to have program find .con file with same
File Setup | Data Setupl Mizcellaneous | Headér View name and in same directory as data file. For
example, if processing test.dat and this option
Frogram setup file is selected, program searches for test.con (in

- - same directory as test.dat).

|K.\.data\.Dehhm\.DatEnv.psa e Also select if more than 1 data file is to be

Open.. B | Saveds. |  Restors | processed, and data files have different con
files. For example, if processing test.dat and

: T testl.dat, and this option is selected, program

Instrument configuration file searches for test.con and testl.con (in same

|K:\data\D ebbictest con directory as test.dat and testl.dat).

Select... P adify... | | | ch Instrument configuration to input file

Directory and file names
for input data. Select to
pick a different file. To
process multiple data files
from same directory:

1. Click Select.

2. In Select dialog box,
hold down Ctrl key
while clicking on each
desired file.

If multiple files are

selected, header in each

file must contain same set
of sensors and variables.

Input directom

|K:\data\D ebbie

Ihput files, 1 selected

Itest.dat j Select,.. I

Output directory

[:\data\Debbie Select... |
Directory and file name for output data.

« If more than 1 data file is to be processed, Output file field disappears
g and output file name is set to match input file name. For example,
Dutput file |test_w if processing test.dat and testl.dat, output files will be test.cnv

and testl.cnv.

Mame append I

Click Start Process to
begin processing data.
Status field shows
Processing complete
when done.

- e SBE Data Processing adds Name append to (each) output file name,

Mot processing before extension. For example, if processing test.dat and testl.dat

| with a Name append of datcnv, output files will be testdatcnv.cnv and
testldatcnv.cnv. Use Name append to save intermediate data files

when input and output files have same extension.

AN T
\

Start Process / Exit Cancel
/

/

Return to SBE Data Processing window.

o If Confirm Program Setup Change was selected in Options menu - If you made
changes and did not Save or Save As, program asks if you want to save changes.

o |f Confirm Program Setup Change was not selected in Options menu - Button says
Save & Exit. If you do not want to save changes, use Cancel button to exit.
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Header View Tab
-1l ]

File Options Help
File Setupl Data Setupl Miscellanenus  Header View I

Friar I Hext I

*Sea-Bird SBE 9 Raw Data File: ;I
* FileMare = CACTDDATANDIT 01 22 DAT

* Software Wersion 4.216

* Temperature SH = 2037

* Conductivity SM = 1562

* Mumber of Bytes Per Scan = 27

* Mumber of Woltage Words = 3

* Syztemn UpLoad Time = Jan 101336 16:09:21

* latitude: 56 005

* longitude: 173 D0E

=

“EMD*™
Begin processing data.
Status field on File Setup tab _lLI
shows Processing complete KX .
when done.

\Start Pmcessl 1 E it I Cancel |

/

/

Return to SBE Data Processing window.

* If Confirm Program Setup Change was selected in Options menu -
If you made changes in the File Setup or Data Setup tab and did not
Save or Save As, program asks if you want to save changes.

o |f Confirm Program Setup Change was not selected in Options menu -
Button says Save & Exit. If you do not want to save changes made on
the File Setup or Data Setup tab, use Cancel button to exit.
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File Formats

File extensions are used by SEASOFT to indicate the file type:

Extension

Description

.afm

Bottle sequence, date and time, firing confirmation, and 5 scans
of CTD data, created by Auto Fire Module (AFM) or (when used
for autonomous operation) SBE 55 ECO Water Sampler.

.asc

Data file:

e Data portion of .cnv converted data file written in ASCII by
ASCII Out

e File written by SEATERM for data uploaded from SBE 37
(firmware < 3.0), 39, 39-IM, or 48. (Note: Convert button on
SEATERM’s toolbar can convert .asc file to .cnv file that can
be used by SBE Data Processing to process data.)

bl

Bottle log information - output bottle file, containing bottle firing
sequence number and position, date, time, and beginning and
ending scan numbers for each bottle closure. Beginning and
ending scan numbers correspond to approximately 1.5-second
duration for each bottle. Seasave writes information to file each
time bottle fire confirmation is received from SBE 32 Carousel
Water Sampler or SBE 55 ECO Water Sampler or (only when
used with SBE 911plus) G.O. 1016 Rosette. File can be used by
Data Conversion.

.bmp

Sea Plot output bitmap graphics file.

.bsr

Bottle scan range file created by Mark Scan, and used by Data
Conversion to create a .ros file.

btl

Averaged and derived bottle data from .ros file, created by Bottle
Summary.

.cnv

Converted (engineering units) data file, with ASCII header

preceding data. Created by:

e Data Conversion, or

e Convert . XML data file in Tools menu in SeatermV2,
Seaterm232, Seaterm485, or SeatermIM (SBE 37 only,
firmware version 3.0 and later)

o SEATERM'’s Convert button (SBE 37, 39, 39-IM, or
48 only).

.con

Instrument configuration (number and type of sensors, channel
assigned to each sensor, and calibration coefficients). SBE Data
Processing uses this information to interpret raw data from
instrument. Latest version of .con file for your instrument is
supplied by Sea-Bird when instrument is purchased, upgraded, or
calibrated. If you make changes to instrument (add or remove
sensors, recalibrate, etc.), you must update .con file. Can be
viewed and/or modified in SBE Data Processing in Configure,
Data Conversion, Derive, and Bottle Summary; and in Seasave.

.dat

Data file - binary raw data file created by older versions
(Version < 6.0) of Seasave from real-time data stream from
SBE 911plus. File includes header information.

.hdr

Header recorded when acquiring real-time data (same as header
information in .hex or .dat data file), or header portion of .cnv
converted data file written by ASCII Out. Header information
includes software version, sensor serial numbers, instrument
configuration, etc.
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.hex

Data file:

e Hexadecimal raw data file created by Seasave from real-time
data stream from SBE 9plus (Seasave version > 7.0), 16,
16plus, 16plus V2, 19, 19plus, 19plus V2, 21, 25, or 49.

e Data uploaded from memory of SBE 16, 16plus, 16plus-IM,
16plus V2, 16plus-IM V2, 17plus (used with SBE 9plus
CTD), 19, 19plus, 19plus V2, 21, or 25.

e Converted (engineering units) data file created by Seasave
from real-time data stream from SBE 45.

File includes header information.

Jpg

Sea Plot output JPEG graphics file.

.mrk

Mark scan information - output marker file containing sequential
mark number, system time, and data for selected variables.
Information is written to file by Seasave when user clicks on
Mark Scan during real-time data acquisition to mark significant
events in the cast. File can be used by Mark Scan.

.psa

File containing input file name and data path, output data path,
and module-specific parameters used by SBE Data Processing.
Default location for .psa files is
%USERPROFILE%\Application Data\Sea-Bird\
SBEDataProcessing-Win32\

(example c:\Documents and Settings\dbresko\Application Data\
Sea-Bird\SBEDataProcessing-Win32\DatCnv.psa).

PostProcSuite.ini contains a list of paths and file names for
recently used .psa files. To view list, click File in module dialog
box and select Recent Setup Files. PostProcSuite.ini is in
%USERPROFILE%\Local Settings\Apps\Sea-Bird\

(example c:\Documents and Settings\dbresko\

Local Settings\Apps\Sea-Bird\PostProcSuite.ini).

.ros

File containing data for each scan associated with a bottle
closure, as well as data for a user-selected range of scans before
and after each closure; created by Data Conversion.

Ixt

Easy-to-read file (for viewing and printing only; cannot be
modified) that shows all parameters in .con file. Created by
clicking Report in Configuration dialog box, or by running
ConReport.exe.

wmf

Sea Plot output Windows metafile graphics file.

Note:

Versions 5.30a and earlier of SBE
Data Processing used program
setup files with a .psu extension
instead of a .psa extension. Program
setup files with a .psa extension can
be opened, viewed, and modified in
any text editor or XML editor.

SBE Data Processing can still use
your existing .psu files. However, if
you make any changes to the setup
(for example, change output
variables), SBE Data Processing will
save the changes to a new .psa file.

xml

o Sensor calibration coefficient file. This file can be exported
and/or imported from the dialog box for a sensor. This allows
you to move a sensor from one instrument to another and
update the instrument’s .con file while eliminating need for
typing or resulting possibility of typographical errors.

o File written by Seaterm232, Seaterm485, or SeatermIM for
data uploaded from SBE 37 with firmware version 3.0 and
later (Note: Use Convert .XML data file in Tools menu in
SeatermV2, Seaterm232, Seaterm485, or SeatermIM to
convert .xml file to .cnv file that can be used by SBE Data
Processing to process data).
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Converted Data File (.cnv) Format

Converted files consist of a descriptive header followed by converted data in
engineering units. The header contains:

1. Header information from the raw input data file (these lines begin with *).

2. Header information describing the converted data file (these lines begin
with #). The descriptions include:
e number of rows and columns of data
e variable for each column (for example, pressure, temperature, etc.)
e interval between each row (scan rate or bin size)
e historical record of processing steps used to create or modify file

3. ASCII string *END to flag the end of the header information.
Converted data is stored in rows and columns of ASCII numbers
(11 characters per value) or as a binary data stream (4 byte binary floating

point number for each value). The last column is a flag field used to mark
scans as bad in Loop Edit.
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Editing .hex and .dat Data Files

Note:

See Section 5: Raw Data
Conversion Modules and
Section 7: File Manipulation
Modules for converting the data
to a .cnv file and then editing
the data.

Note:
Although we provide this
technique for editing a raw .hex

Sometimes users want to edit the raw .hex or .dat data file before beginning
processing, to remove data at the beginning of the file corresponding to
instrument soak time, remove blocks of bad data, edit the header, or add
explanatory notes about the cast. Editing the raw .hex or .dat file can
corrupt the data, making it impossible to perform further processing
using Sea-Bird software. We strongly recommend that you first convert
the data to a .cnv file (using Data Conversion), and then use other

SBE Data Processing modules to edit the .cnv file as desired.

.hex Files

The procedure for editing a .hex data file described below has been found to
work correctly on computers running Windows 98, 2000, and NT. If the
editing is not performed using this technique, SBE Data Processing may

file, Sea-Bird’s strong
recommendation, as described
above, is to always convert the 1
raw data file and then edit the '
converted file.

reject the edited data file and give you an error message.

Make a back-up copy of your .hex data file before you begin.

2. Run WordPad.

3. In the File menu, select Open. The Open dialog box appears. For Files of
type, select All Documents (*.*). Browse to the desired .hex data file and
click Open.

4. Edit the file as desired, inserting any new header lines after the System

Upload Time line and before *END*. Note that all header lines must

begin with an asterisk (¥), and *END* indicates the end of the header. An

example is shown below, with the added lines in bold:
Sea-Bird SBE 21 Data File:
FileName = C:\Odis\SAT2-0DIS\octl14-19\ocl5 99.hex
Software Version Seasave Win32 v1.10
Temperature SN = 2366
Conductivity SN = 2366
System UpLoad Time = Oct 15 1999 10:57:19
Testing adding header lines
Must start with an asterisk
Place anywhere between System Upload Time & END of header
NMEA Latitude = 30 59.70 N
NMEA Longitude = 081 37.93 W
NMEA UTC (Time) = Oct 15 1999 10:57:19
* Store Lat/Lon Data = Append to Every Scan and Append to .NAV File When
<Ctrl F7> is Pressed
** Ship: Sea-Bird
Cruise: Sea-Bird Header Test
Station:
Latitude:
Longitude:
*END*

ok % % b ok ok b % X o

**
*k
*x

**

5. In the File menu, select Save (not Save As). If you are running

Windows 2000, the following message displays:
You are about to save the document in a Text-Only format, which
will remove all formatting. Are you sure you want to do this?

Ignore the message and click Yes.
6. In the File menu, select Exit.

.dat Files
Sea-Bird is not aware of a technique for editing a .dat file that will not
corrupt it. Opening a .dat file with any text editor corrupts the file by leaving
behind invisible characters (for example, carriage returns, line feeds, etc.)
when the file is closed. These characters, inserted semi-randomly through the
file, corrupt the data format. Sea-Bird distributes a utility program, called
Fixdat, which may repair a corrupted .dat file.
o Fixdat.exe is installed with, and located in the same directory as,

SBE Data Processing.
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Section 3:
Typical Data Processing Sequences

Notes:

The processing sequence may

differ for your application.

Sea Plot can display data at

any point after a .cnv file has

been created.

Use ASCII Out to export

converted data (without header)

to other software.

Oxygen computed by Seasave

and Data Conversion differs

from oxygen computed by

Derive. Both algorithms use the

derivative of the oxygen signal

with respect to time:

» Quick estimate - Seasave and
Data Conversion compute the
derivative looking back in
time, because Seasave
cannot use future values
while acquiring
real-time data.

» Most accurate results - Derive
uses a user-input centered
window (equal number of
points before and after scan)
to compute the derivative.

This section includes typical data processing sequences for each instrument,
broken into four categories:

e Profiling CTDs that have a configuration (.con) file—
SBE 9plus, 19, 19plus, 19plus V2, 25, and 49

e  Other instruments (moored CTDs and thermosalinographs) that have a
configuration (.con) file — SBE 16, 16plus, 16plus-IM, 16plus V2,
16plus-IM V2, 21, and 45

e  Moored instruments that do not have a configuration (.con) file —
SBE 37-SM, 37-SMP, 37-IM, 37-IMP, 37-SI, and 37-SIP

e  Moored instruments that do not have a configuration (.con) file and have
limited compatibility with SBE Data Processing — SBE 39, 39-IM, and 48
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Notes:

e The example assumes that a
configuration (.con) file is
available. A .con file is provided by
Sea-Bird when the instrument is
purchased, based on the user-
specified configuration and the
factory-calibration. An existing
.con file can be modified in
Configure, Data Conversion,
Derive, or Bottle Summary, or in
Seasave. If you do not have a
.con file, use SBE Data
Processing’s Configure menu to
create the .con file.

The order for running Bin Average
and Derive can be switched,
unless oxygen is being
computed in Derive.

See the program modules for Sea-
Bird recommendations for typical
parameter values for filtering,
aligning, etc. Use judgment in
evaluating your data set to
determine the best values.

Processing Profiling CTD Data (SBE 9plus, 19, 19plus, 19plus V2, 25, and 49)

The processing sequence is based on a typical situation with a boat at low
latitude lowering an instrument at 1 meter/second.

Program / Module

Function

1. Seasave,
Seaterm?232,
SEATERM, or
SeatermAF

Acquire real-time raw data (Seasave) or
upload data from memory (Upload menu in
Seaterm232 for 19plus V2, or Upload button in
SEATERM or SeatermAF, as applicable).

2. Data
Conversion

Convert raw data to a .cnv file, selecting ASCII as

data conversion format. Converted data includes:

e pressure, temperature, and conductivity

e (if applicable) dissolved oxygen current and
dissolved oxygen temperature (SBE 13 or 23);
dissolved oxygen signal (SBE 43)

e (if applicable) light transmission, pH,
fluorescence, etc.

3. Filter

Low-pass filter pressure to increase pressure
resolution for Loop Edit, and low-pass filter

temperature and conductivity to smooth high
frequency data.

4. Align CTD

Advance conductivity, temperature, and oxygen
relative to pressure, to align parameters in time.
This ensures that calculations of salinity, dissolved
oxygen, and other parameters are made using
measurements from same parcel of water.

5. Cell Thermal
Mass

Perform conductivity cell thermal mass correction if
salinity accuracy of better than 0.01 PSU is desired in
regions with steep gradients.

6. Loop Edit

Mark scans where CTD is moving less than minimum
velocity or traveling backwards due to ship roll.

7. Derive

Compute:

e salinity, density, and other parameters

e oxygen from oxygen current and oxygen
temperature (SBE 13 or 23) or oxygen signal
(SBE 43)

Note that input file must include conductivity,

temperature, and pressure.

8. Bin Average

Average data into desired pressure or depth bins.

9. Sea Plot

Plot data.
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Processing SBE 16, 16plus, 16plus-IM, 16plus V2, 16plus-IM V2, 21, and 45 Data

Notes:

e The example assumes that a
configuration (.con) file is available.
A .con file is provided by Sea-Bird
when the instrument is purchased,
based on the user-specified
configuration and the factory-
calibration. An existing .con file can
be modified in Configure, Data
Conversion, Derive, or Bottle
Summary, or in Seasave. If you do
not have a .con file, use SBE Data
Processing’s Configure menu to
create the .con file.

e Even if your instrument does not
have a pressure sensor (SBE 21
and 45; SBE 16, 16plus, 16plus-IM,

16plus V2, and 16plus-IM V2 without

optional pressure sensor): Select
pressure as an output variable in
Data Conversion if you plan to
calculate salinity, density, or other
parameters that require pressure in
Derive or Sea Plot. For the SBE 16
series instruments, Data Conversion
inserts a column with the moored
pressure (entered in the .con file
Data dialog) in the output .cnv file.
For the SBE 21 and 45, Data
Conversion inserts a column of 0’s
for pressure in the output .cnv file.
e The SBE 45 outputs data in
engineering units. However, you

must still run Data Conversion to put

the data in a format that can be
used by SBE Data Processing’s
other modules.

e For an SBE 21 or 45: If the
thermosalinograph has a remote
temperature sensor, Seasave, Data
Conversion, and Derive all use the
remote temperature data to

calculate density and sound velocity.

Program / Module Function
1. Seasave, Acquire real-time raw data (Seasave) or
Seaterm232, upload data from memory:
Seaterm485, e Upload menu in Seaterm232 or Seaterm485 for
SeatermIM, or 16plus V2 or SeatermIM for 16plus-IM V2;
SEATERM e Upload button in SEATERM.
Convert raw data to a .cnv file, selecting ASCII as
data conversion format. Converted data includes:
e pressure, temperature, and conductivity
2. Data e (if applicable) dissolved oxygen current and
Conversion dissolved oxygen temperature (SBE 13 or 23);
dissolved oxygen signal (SBE 43)
e (if applicable) light transmission, pH,
fluorescence, etc.
Compute:
e salinity, density, and other parameters.
e oxygen from oxygen current and oxygen
3. Derive temperature (SBE 13 or 23) or oxygen signal
(SBE 43)
Note that input file must include conductivity,
temperature, and pressure.
4. Sea Plot Plot data.
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Processing SBE 37-SM, 37-SMP, 37-IM, 37-IMP, 37-SI, and 37-SIP Data

Note: Program / Module Function

SBE 37-Sl and 37-SIP with firmware Seaterm232, Seaterm4835, or SeatermIM for SBE 37
version 3f0 l?nd tI;lter havedlnternal with firmware version > 3.0 - Use Upload menu to
Mematy; 10 oW 1 Procectire upload data (in engineering units) in XML (.xml)

described here to upload and .
process the data. EZrIier versions of format. Use Convert . XML data file in Tools menu to

the 37-SI and 37-SIP did not have 1. Seaterm232, convert .xml to .cnv file, which can be used by SBE
internal memory; SBE Data Seaterm485, Data Processing.

Processing cannot be used to SeatermIM, or or

process the real-time data obtained SEATERM SEATERM for SBE 37 with firmware version < 3.0 -
with these older instruments. Use Upload button to upload data (in engineering

units) in ASCII (.asc) format. Use Convert button to
convert .asc to .cnv file, which can be used by
SBE Data Processing.

Compute salinity, density, and other parameters.
Note: An SBE 37 stores calibration coefficients
internally, and does not have a .con file. However,
Derive requires you to select a .con file before it will
process data. You can use a .con file from any other
Sea-Bird instrument; the contents of the .con file will
2. Derive not affect the results. If you do not have a .con file for
another Sea-Bird instrument, create one:
1. Click SBE Data Processing’s Configure menu
and select any instrument.
2. In the Configuration dialog box, click Save As,
and save the .con file with the desired name
and location.

3. Sea Plot Plot data.

Processing SBE 39, 39-IM, and 48 Data

Note: Program / Module Function
The .cnv file from an SBE 39, 39-IM, Use Upload button to upload data (in engineering
or 48 cannot be processed by any 1 SEATERM units) in ASCII (.asc) format. Use Convert button to
SBE Data Processing modules ' convert .asc to .cnv file, which can be used by
other than Sea Plot and ASCII Out. SBE Data Processing.

2. SeaPlot Plot data.
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Section 4. Configuring Instrument

(Configure)

Module Name Module Description

Define instrument configuration and

Configure calibration coefficients.

Introduction

Notes:

e Sea-Bird supplies a .con file with

each instrument. The .con file
must match the existing

instrument configuration and

contain current sensor
calibration information.

¢ An existing .con file can be
modified in Configure; in Data
Conversion, Derive, or Bottle
Summary; or in Seasave.

e Appendix Il: Configure (.con) File

Format contains a line-by-line

description of the contents of the

.con file.

e An SBE 37, 39, 39-IM, and 48
stores calibration coefficients
internally, and does not have a
.con file.

Configure creates or modifies a configuration (.con) file to define the
instrument configuration and sensor calibration coefficients. The .con file is
used in both SBE Data Processing and in Seasave. Configure is applicable to
the following instruments:

The

SBE 9plus with SBE 11plus Deck Unit or SBE 17plus SEARAM
(SBE 9plus is listed as the 911/917plus in the Configure menu)
SBE 16

SBE 16plus (including 16plus-IM)

SBE 16plus V2 (including 16plus-IM V2)

SBE 19

SBE 19plus

SBE 19plus V2

SBE 21

SBE 25

SBE 45

SBE 49

discussion of Configure is in four parts:

Instrument Configuration covers the Configuration dialog box - number
and type of sensors on the instrument, etc. - for each of the instruments
listed above. Unless noted otherwise, SBE Data Processing supports only
one of each brand and type of auxiliary sensor (for example, you cannot
specify two Chelsea Minitracka fluorometers, but you can specify a
Chelsea Minitracka and a Chelsea UV Aquatracka fluorometer). See the
individual sensor descriptions in Calibration Coefficients for Voltage
Sensors for those sensors that SBE Data Processing supports in a
redundant configuration (two or more of the same sensor interfacing with
the CTD).

Calibration Coefficients for Frequency Sensors covers calculation of
coefficients for each type of frequency sensor (temperature, conductivity,
Digiquartz pressure, IOW sound velocity, etc.).

Calibration Coefficients for A/D Count Sensors covers calculation of
coefficients for A/D count sensors (temperature and strain gauge pressure)
used on the SBE 16plus (and -IM), 16plus (and -IM) V2, 19plus,

19plus V2, and 49.

Calibration Coefficients for Voltage Sensors covers calculation of

coefficients for each type of voltage sensor (strain gauge pressure, oxygen,
pH, etc.).
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Access Configure by selecting the desired instrument in the Configure
menu in the SBE Data Processing window.

e Before selecting the instrument, review the status of Confirm
Configuration Change in the Configure menu. If Confirm Configuration
Change is selected, the program provides a prompt to save the
configuration (.con) file if you make changes and then click the Exit button
in the Configuration dialog box without clicking Save or Save As. If not
selected, the program changes the Exit button to Save & Exit; to exit
without saving changes, use the Cancel button.

B SBE Data Processing = |I:I|5|
Run | Configure Help

. SBE 16 Seacat CTD...

. SBE 16plus Seacat CTD...

. 3BE 16plus ¥z Seacat CTD..,

. SBE 19 Seacat CTD, ..

. 3BE 19plus Seacat CTO..,

. SBE 19plus ¥Z Seacat CTO...

. 3BE 21 Seacat Thermosalinograph. ..
. 3BE 25 Sealogger CTO...

. 3BE 45 MicroT5G Thermosalinograph. ..
10, SBE 49 Faskcat CTD...

11, SBE 911plusfa17plus CTO..,

L e o L L I o

v Confirm Configuration Change
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Instrument Configuration

SBE 9plus Configuration

Channel/Sensor table reflects this choice. Voltage
channel 0 in .con file corresponds to sensor wired to
channel 0 on end cap connector, voltage channel 1 to

- sensor wired to channel 1 on end cap connector, etc.
Channel/Sensor 'table reflects this Total voltage words is 4; each word contains data from
ch0|c_e. Typically: ) two 12-bit A/D channels. Deck Unit and SEARAM
* 0=SBE 3 or 4 plugged into JB5 suppress words above highest numbered voltage
on 9plus (dual redundant sensor word used.
configuration) ) Words to suppress = 4 - Words to Keep
e 1=SBE 3 or 4 plugged into
JB4 on 9plus and not using JB5

External Voltage Connector Words to Keep

connector (single redundant : o ; (not spare)
censor con(figuﬁ]'ation) Configuration file opened: Mone Oor1 AUX 1 1
e 2 =no redundant T or C sensors 20r3 AUX 2 2
Frequency channels suppressed m 40r5 AUX 3 3
6or7 AUX 4 4
For full rate (24 Hz) data, set to 1. Yoltage words suppressed T
Example: If number of scans to IEEE-448 or RS-232C for CTD data

average=24, Seasave averages

] interface between Deck Unit and computer.
24 scans, saving data to computer at \Eumputer interface IHS-232C :‘:I P

1 scan/second.
Scang to average !1

o NMEA - Select if NMEA
navigation device used, and if ¥ WMEA position data added I WHES depth data added
NMEA depth data and NMEA time
data were also appended. % WMEA device connected to deck unit [T HMES tre added
Seasave adds current latitude, Shaded sensors cannot be
longitude, and universal time code [ | ™ WMEA device connected ta P removed or changed to
to data header; appends NMEA anqtherI type; others are

. i optional.

ﬂfﬁf (?;;“{os_cna;\,’ fa”r;de\:,\,;l:; ?ime ¥ Surface PAR voltage added [ Scantime added P
Ctrl F7 is pressed or Add to .nav
File is clicked. Channel Sensor | Mew |New to create new
Note: Whether NMEA device was 1. Frequency Temperature .con file for this CTD.
connected to a deck unit or - - Open... |Open to select
directly to computer during data 2. Frequency Conductivity ————different .con file.
acquisition in Seasave has no 3 Frequency Pressure, Digiquartz with TC 5.,. |Save or Save As to
effect on data file used by SBE e e e e | save current .con file
Data Processing, and therefore 4. A/D voltage 0 pH £ ave fg |SEMINGS.
has no effect on data processing. 5. AD voltage 1 Owygen, SBE 43

e Surface PAR - Select if Surface T o . .
PAR sensor used; must agree _E,&{Dlult_age_z_ Fluorometer, Biospherical Matural

with Deck Unit setup (AddSpar=). 7. 4/0 volage 3 Altimeter
Seasave appends Surface PAR ———— :
data to every scan. Adds 2 ES_P-‘E‘-H viltage Unavailable

channels to Channel/Sensor table.| 3 SPAR vaoltage SPARSurtace [radiance
Do not decrease Voltage words T
suppressed to reflect this; Voltage £
words suppressed reflects only

Click a sensor and click Modify
to view/change calibration
coefficients for that sensor.

Click a (non-shaded) sensor and click Select to pick a
_|different sensor for that channel; dialog box with list of

external voltages going directly to sensors appears. After sensor is selected, dialog box for

9plus from auxiliary sensors. See —| calibration coefficients appears. Select sensors after
Application Note 11S. _|Frequency channels suppressed and Voltage words

* Scan time - Select to include time suppressed have been specified above.
of each scan (seconds since -]

January 1, 1970 GMT) with data.

ﬁepnrt...l Help... | E:-ci\ | Cancel I

\
Opens a .txt file (for viewing and Return tO_SBE Dgta Prqcessing window. . )
printing only; cannot be modified) that o If Confirm Conﬂguranon Change was selected in Conflgure menu - If you made
shows all parameters in .con file. changes and did not Save or Save As, program asks if you want to save
For command line generation of report, changes. , _ . .
see Appendix Ill: Generating .con File e |f Confirm Conflguratlon Change was not selected in Configure menu - Button .
Reports — ConReport.exe. says Save & Exit. If you do not want to save changes, use Cancel button to exit.
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Shown below is an example status (DS) response in SEATERM that
corresponds to the setup shown in the Configuration dialog box above, for an
SBE 9plus used with an SBE 11plus Deck Unit. Shown below the appropriate
lines are the commands used in SEATERM to modify the setup of parameters
critical to use of the 9plus with Seasave and processing of data with

SBE Data Processing, as well as any explanatory information.

SBE 11plus V 5.1F

Number of scans to average = 1
(11plus reads this from .con file in Seasave after Deck Unit is reset.)

pressure baud rate = 9600
NMEA baud rate = 4800

surface PAR voltage added to scan
(Enabling of surface PAR [AddSpar=] must match Surface PAR voltage added in
.con file.)

A/D offset = 0O

GPIB address = 1
(GPIB address must be 1 [GP1B=1] to use Seasave, if Computer interface is IEEE-
488 (GPIB) in .con file.)

advance primary conductivity 0.073 seconds
advance secondary conductivity 0.073 seconds

autorun on power up is disabled
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SBE 16 SEACAT C-T Recorder Configuration

Select strain gauge, Digiquartz with or without

temperature compensation, or no pressure sensor. If no
pressure sensor or Digiquartz without Temp Comp is
selected, Data button accesses dialog box to input
Canfiguration file opened: Mone additional parameter(s) needed to process data.

Channel/Sensor table reflects this Configuration for the SBE 16 Seacat CTD
choice. Must agree with SBE 16 setup

for SVn (n=0, 1, 2, 3, 4); see reply from
DS. Voltage channel 0 in .con file
corresponds to sensor wired to channel

0 on end cap connector, voltage Fressure sersor bpe I |
: Ay | Dala.
channel 1 in .con file corresponds to Ho Pressure Sensor J

sensor wired to channel 1 on end cap |— See reply from DS. Used to determine strain gauge
connector, etc. External voltage channels |2 vl pressure sensor data format.
Firmware wersion |"-"er$iclr| v=4.0 j Select to include time of each scan (seconds

since January 1, 1970 GMT) with data.

Time between scans. Must agree with | — Sample interval seconds I
SBE 16 setup (Sl); see reply from DS. 15

Shaded sensors cannot be removed

) HEd position data added [ Scan lime added or changed to another type of

sensor. All others are optional.

Select if using with deck unit 1

connected to NMEA navigation Channel aensor | New New to create new
device. Seasave adds current 1. Frequency Temperatue / con file for this CTD.
latitude, longitude, and universal time —_— R Oper... Open to select

code to data header; appends NMEA 2 Frequency Conductivity different con file.
data to every scan; anc_i writes NMEA 3. 4/D voltage 0 User Palynomial Save |Save or Save As to
data to .nav file every time Ctrl F7 is R T : 3 : : ~——|save current .con file
pressed or Add to .nav File is clicked. 4. &0 vaoltage 1 P&Rnadiance, Biospherical/Licor Save As |settings. '

Click a (non-shaded) sensor and click Select to pick a Click a sensor
different sensor for that channel. A dialog box with a | Select | and click Modify
___|list of sensors appears. Select sensors after number to change
of voltage channels have been specified above. Mc-dih(l/ calibration
' coefficients for

that sensor.

Opens a .txt file (for viewing and
printing only; cannot be modified) that |~
shows all parameters in .con file.

Hepml...l Help... | Ezit Cancel |

For command line generation of Return to SBE Data Processing window.
report, see Appendix Ill: Generating e If Confirm Configuration Change was selected in Configure menu - If you made
.con File Reports — ConReport.exe. changes and did not Save or Save As, program asks if you want to save changes.

o If Confirm Configuration Change was not selected in Configure menu - Button says
Save & Exit. If you do not want to save changes, use Cancel button to exit.

Shown below is an example status (DS) response in SEATERM that
corresponds to the setup shown in the Configuration dialog box above.
Shown below the appropriate lines are the commands used in SEATERM
to modify the setup of parameters critical to use of the SBE 16 with
Seasave and processing of data with SBE Data Processing, as well as any
explanatory information.

SEACAT V4.0h SERIAL NO. 1814 07/14/95 09:52:52.082

(If pressure sensor installed, pressure sensor information appears here in status
response; must match Pressure sensor type in .con file.)

clk = 32767.789, iop = 103, vmain = 8.9, vlith = 5.9

sample interval = 15 sec
(Sample interval [SI] must match Sample interval seconds in .con file.)

delay before measuring volts = 4 seconds
samples = 0, free = 173880, lwait = 0 msec
SW1 = C2H, battery cutoff = 5.6 volts

no. of volts sampled = 2
(Number of auxiliary voltage sensors enabled [SVn] must match External voltage
channels in .con file.)

mode = normal
logdata = NO
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Note:

The SBE 16plus is available with an
optional RS-485 interface. All
commands to a particular 16plus with
RS-485 are preceded by #ii, where

il = instrument ID (0-99). Therefore,
commands mentioned in the dialog
box description below have a slightly
different form for the RS-485 version
(#iDS, #iiPType=, #iiVoltn=, and
#iiSamplelnterval=).

Channel/Sensor table reflects
this choice (0, 1, 2, 3, or 4).
Must agree with 16plus setup

SBE 16plus or 16plus-IM SEACAT C-T Recorder Configuration

The SBE 16plus can interface with one SBE 38 secondary temperature sensor,
one SBE 50 pressure sensor, Or up to two Pro-Oceanus Gas Tension Devices
(GTDs) through the SBE 16plus optional RS-232 connector. Data from an

SBE 50 pressure sensor is appended to the data stream, and does not replace the
(optional) internally mounted pressure sensor data.

The SBE 16plus-IM can interface with one SBE 38 secondary temperature
sensor through the 16plus-IM optional RS-232 connector, but cannot interface
with an SBE 50 or GTD. All commands to a particular 16plus-IM are
preceded by #ii, where ii = instrument ID (0-99). Therefore, commands
mentioned in the dialog box description below have a slightly different form for
the 16plus-IM (#iiDS, #iiPType=, #iiVoltN=, and #iiSamplelnterval=).

Internally mounted pressure sensor: select strain gauge,
Digiquartz with temperature compensation, or no pressure
sensor. If no pressure sensor is selected, Data button accesses
a dialog box to input additional parameter needed to process
data. Must agree with 16plus setup (PType=); see reply from
DS. Selection applies only to internally mounted pressure
sensor; if instrument has no internally mounted pressure sensor

for VoltN= (N=0, 1, 2, and 3); but is interfacing with SBE 50 pressure sensor, select No
see reply from DS. Voltage Ennﬁguratm" for the SBE IEplus Seacat pressure sensor here and then select SBE 50 in Serial RS-232C

channel 0 in .con file

sensor field below. Note: Digiquartz without temperature

corresponds to first external Canfiguration file opened: None compensation is not applicable.

voltage in data stream, voltage
channel 1 to second external
voltage in data stream, etc.

Select if using with deck unit
connected to a NMEA
navigation device. Seasave

Pressure sengor tupe |5lrain Gauge ll Data. |

N
External voltage channels 5 W Select none, 1 SBE 38 (secondary temperature),
1 SBE 50 pressure sensor, or up to 2 GTDs
Time bet (dissolved oxygen or nitrogen). Must agree with
Ime between scans. Senial B5-232C sensar I + || 16plus setup; see reply from DS. Channel/Sensor
Must agree with 16plus setup Temperatue, SEES —| table lists RS-232 sensors below voltage channels.
(Samplelnterval=); see reply

from DS. Sample interval secands Im

/l; NMEA, pasiion data added Shaded sensors cannot be removed or changed to

Channel Sensor | Hew | |

another type of sensor. All others are optional.

data to .nav file every time Ctrl

is clicked.

adds current latitude, longitude, 1. Count

and universal time code to data e — a7 Open... o t lect
header; appends NMEA data to 2. Frequency Conductivity — diggpen(i Sc?);}(:file
every scan; and writes NMEA 3. Court Pressure, Strain Gauge 5avE |Save or Save As to

F7is pressed or Add to .nav File| 4 A/D valtage 0
b A0 voltage 1 pH

Temnerature New to create new
P .con file for this CTD.

save current .con file
Owpgen, SBE 43 & ave As| settings.

B. Senial AS5-232 Temperature, SBE 38

Click a (non-shaded) sensor and click Select to pick a different sensor for

that channel. A dialog box with a list of sensors appears. Select sensors W adify | Click a sensor
after number of voltage channels have been specified above. Lk

/felec:t... |

~and click Modify

to change
- calibration

Fha}aurt...l Help... | E:-:y Cancel | coefficients for
7 that sensor.

/
Opens a .txt file (for viewing and
printing only; cannot be modified) that
shows all parameters in .con file.
For command line generation of report,
see Appendix Ill: Generating .con File
Reports — ConReport.exe.

/
Return to SBE Data Processing window.
¢ If Confirm Configuration Change was selected in Configure menu - If you made
changes and did not Save or Save As, program asks if you want to save changes.
¢ [f Confirm Configuration Change was not selected in Configure menu - Button says
Save & Exit. If you do not want to save changes, use Cancel button to exit.
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Shown below is an example status (DS) response in SEATERM for a 16plus
with standard RS-232 interface that corresponds to the setup shown in the
Configuration dialog box above. Shown below the appropriate lines are the
commands used in SEATERM to modify the setup of parameters critical

to use of the SBE 16plus with Seasave and processing of data with

SBE Data Processing, as well as any explanatory information.

SBE 16plus V 1.6e SERIAL NO. 4300 03 Mar 2005 14:11:48

vbatt 10.3, vlith = 8.5, ioper = 62.5 ma,
ipump 21.6 ma, iextO0l = 76.2 ma, iserial = 48.2 ma

status = not logging

sample interval = 10 seconds, number of measurements
per sample = 2

(Sample interval [Samplelnterval=] must match Sample interval seconds in
.con file.)

samples = 823, free = 465210

run pump during sample, delay before sampling =
2.0 seconds

transmit real-time = yes
(Real-time data transmission must be enabled [TxReal Time=Y] to acquire data
in Seasave.)

battery cutoff = 7.5 volts

pressure sensor = strain gauge, range = 1000.0
(Internal pressure sensor [PType=] must match Pressure sensor type in .con file.)

SBE 38 = yes, SBE 50 = no, Gas Tension Device = no
(Selection/enabling of RS-232 sensors [SBE38=, SBE50=, GTD=, DualGTD=] must
match Serial RS-232C sensor in .con file.)

Ext Volt 0 = yes, Ext Volt 1 = yes, Ext Volt 2 = no, Ext
Volt 3 = no

(Number of external voltage sensors enabled [VoltO= through Volt3=] must match
External voltage channels in .con file.)

echo commands = yes

output format = raw HEX
(Output format must be set to raw Hex [OutputFormat=0] to acquire data in
Seasave.)

serial sync mode disabled
(Serial sync mode must be disabled [SyncMode=N] to acquire data in Seasave.)
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SBE 16plus V2 or 16plus-IM V2
SEACAT C-T Recorder Configuration

The SBE 16plus V2 and 16plus-IM V2 can interface with one SBE 38
secondary temperature sensor, one SBE 50 pressure sensor, Or up to two Pro-
Oceanus Gas Tension Devices (GTDs) through the CTD’s RS-232 sensor

Note:
The SBE 16plus V2 is available with
an optional RS-485 interface. All

commands to a particular 16plus V2 connector. Data from an SBE 50 pressure sensor is appended to the data stream,
with RS-485 are preceded by #ii, and does not replace the (optional) internally mounted pressure sensor data.
where ii = instrument ID (0-99).

Therefore, commands mentioned in All commands to a particular 16plus-IM V2 are preceded by #ii, where ii =

the dialog box description below have instrument ID (0-99). Therefore, commands mentioned in the dialog box

a slightly different form for the description below have a slightly different form for the 16plus-IM V2

RS-485 version (#iiGetCD, #iDS, (#iiGetCD, #iiDS, #iiPType=, #iiVoltN=, and #iiSamplelnterval=).

#iiPType=, #iiVoltn=, and
#iiSamplelnterval=).

Internally mounted pressure sensor: strain gauge, Digiquartz
with temperature compensation, or no pressure sensor. If no
pressure sensor is selected, Data button accesses dialog box to
input additional parameter needed to process data. Must agree
with 16plus V2 setup (PType=); see reply from GetCD or DS.
Channel/Sensor table reflects Selection applies only to internally mounted pressure sensor; if
this choice (0, 1, 2, 3, 4, 5, or 6). 16plus V2 has no internally mounted pressure sensor but is
Must agree with 16plus V2 (01 T = L R 1 e e L | T et | interfacing with SBE 50 pressure sensor, select No pressure
setup for VoltN= (N=0, 1, 2, 3, sensor here and then select SBE 50 in Serial RS-232C sensor
4, and 5); see reply from GetCD field below. Note: Digiquartz without temperature compensation
or DS. Voltage channel 0 in .con

Configuration fle opened: 16plusy2.con

is not applicable.
file corresponds to first external

voltage in data stream, voltage Fressure sensor bype |Slrain Gauge ;l Data, |
channel 1 to second external NG
voltage in data stream, etc. External voltage channels |2 vl Select none, 1 SBE 38 (secondary temperature),

1 SBE 50 pressure sensor, or up to 2 GTDs
. ] (dissolved oxygen or nitrogen). Must agree with
Time between scans. Must IR e ITemperature, SBE 38/:' 16plus V2 setup; see reply from GetCD or DS.
Channel/Sensor table lists RS-232 sensors below

agree with 16plus V2 setu :
(Sgamplelnterr\)/al=)' see regly Sample intereal seconds |1[| voltage channels.

from GetCD or DS. I
I MME&L position data added Shaded sensors cannot be removed or changed to
Select if using with deck unit / another type of sensor. All others are optional.

1
connected to a NMEA Chariel Sengar /T Mew

L . New to create new
navigation device. Seasave ) i
adds current latitude, longitude, 1. Caunt Temperature .con file for this CTD.

e s Open..|
and universal time code to data 2. Frequency Conductivity e gl)i?fgpetn? SC(_:(‘Z:ﬁCfEle
header; appends NMEA data to e —— : :

every scan; and writes NMEA 3. Count Frezsure, Strain Gauge Save |Save or Save As to
data to .nav file every time Ctrl 4. 4/ voltage 0 Owwgen, SBE 43 zz;snctslrrent .con file
F7ispressedor Add to .nav File| — - o 5 Save fg gs.

is clicked b A/D voltage 1 Fluarameter, Tumer SCUFA

E. Serial B5-232 Temperature, SBE 38

Click a (non-shaded) sensor and click Select to pick a different sensor for | SElect. |
that channel. A dialog box with a list of sensors appears. Select sensors -
after number of voltage channels have been specified above. Mﬂdlf.'r'...\L

Click a sensor
~and click Modify
to change
calibration
coefficients for
that sensor.

H/aﬁl:urt...l Help... | Eyh I Cancel |
/ /

A
Opens a .txt file (for viewing and : Return to SBE Data Processing window.
printing only; cannot be modified) that ¢ If Confirm Configuration Change was selected in Configure menu - If you made
shows all parameters in .con file. changes and did not Save or Save As, program asks if you want to save changes.
For command line generation of report, ¢ If Confirm Configuration Change was not selected in Configure menu - Button says
see Appendix Ill: Generating .con File Save & Exit. If you do not want to save changes, use Cancel button to exit.
Reports — ConReport.exe.
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Shown below is an example status (DS) response in a terminal program for a
16plus V2 with standard RS-232 interface that corresponds to the setup shown
in the Configuration dialog box above. Shown below the appropriate lines are
the commands used in the terminal program to modify the setup of parameters
critical to use of the SBE 16plus V2 with Seasave and processing of data with
SBE Data Processing, as well as any explanatory information.

SBE 16plus V 2.0 SERIAL NO. 6001 24 Oct 2007 14:11:48

vbatt 10.3, vlith = 8.5, ioper = 62.5 ma,
ipump 21.6 ma, iextO0l = 76.2 ma, iserial = 48.2 ma

status = not logging
samples = 0, free = 3463060

sample interval = 10 seconds, number of measurements
per sample = 1

(Sample interval [Samplelnterval=] must match Sample interval seconds in
.con file.)

pump = run pump during sample, delay before sampling =
2.0 seconds

transmit real-time = yes
(Real-time data transmission must be enabled [TxReal Time=Y] to acquire data
in Seasave.)

battery cutoff = 7.5 volts

pressure sensor = strain gauge, range = 1000.0
(Internal pressure sensor [PType=] must match Pressure sensor type in .con file.)

SBE 38 = yes, SBE 50 = no, Gas Tension Device = no
(Selection/enabling of RS-232 sensors [SBE38=, SBE50=, GTD=, DualGTD=] must
match Serial RS-232C sensor in .con file.)

Ext Volt 0 = yes, Ext Volt 1 = yes,
Ext Volt 2 = no, Ext Volt 3 = no,

Ext Volt4 = no, Ext Volt 5 = no

(Number of external voltage sensors enabled [VoltO= through Volt5=] must match
External voltage channels in .con file.)

echo characters = yes

output format = raw HEX
(Output format must be set to raw Hex [OutputFormat=0] to acquire data in
Seasave.)

serial sync mode disabled
(Serial sync mode must be disabled [SyncMode=N] to acquire data in Seasave.)
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quring Instrument (Configure)

SBE 19 SEACAT Profiler Configuration

Seasave and SBE Data Processing always treat the SBE 19 as if it is a Profiling

instrument
Moored M

(i.e., it is in Profiling mode). If your SBE 19 is in
ode, you must treat it like an SBE 16 (when setting up the .con file,

select the SBE 16).

Channel/Sensor table reflects this

choice. Must agree with SBE 19 setu 5 : 3
for SVn (n=0, 3 or 4); see reply ol Configuration for the SBE 19 Seacat CTD i ﬂ

DS. Voltage channel 0 in .con file
corresponds to sensor wired to channel

0 on end cap connector, voltage EDHHQU[EHDH fI|E! EIIIIE!FIE!IjZ NEIFIE! with temperature compensation.

channel 1 in .con file corresponds to
sensor wired to channel 1 on end cap
connector, etc. Pressure sensor tpe

Number of 0.5 second intervals
between samples. Must agree with

SBE 19 setup (SR); see reply from DS. . ;
Firmware wersion

External voltage channels

Select strain gauge or Digiquartz

Strain [aune / j

See reply from DS. Used to
, determine strain gauge pressure
Werzion »= 30 | |sensor data format.

LLlil

« Surface PAR - Select if using with 0.5 zecond intervalz 1
deck unit connected to Surface PAR Select to include time of each scan
sensor. Seasave appends Surface (second_s since January 1, 1970
PAR data to every scan. Adds 2 IF Suiface PAR "."I:I|tE|§|E added I- Can e added GMT) with data.
channels to Channel/Sensor table.

Do not increase External voltage

channels to reflect this; External \F NME'{-,‘ pDSitiElr'l data E|I:|I:|E!I:| Shaded sensors cannot be removed or changed to
voltage channels reflects only another type of sensor. All others are optional.
external voltages going directly to

SBE 19 from auxiliary sensors. See Channel Cansar | Mew |

Application Note 47.

* NMEA - Select if using with deck unit| | Fraguenc Temperatune New to create new
connected to NMEA navigation il Y : DFIEFI .con file for this CTD.
device. Seasave adds current Ennductivit o Qpen to select_
latitude, longitude, and universal 2 FTEIJUEHC_I,' Y different .con file.
time code to data header; appends H £ 4y Save or Save As to
NMEA data to every scan; and 34D Wltage 0 P . —Isave current .con file
writes NMEA data to .nav file every | 4 Afiyoltage1 | Transmissometer, Chelsea/Seatech/\Wetlab settings.

time Ctrl F7 is pressed or Add to

Save A

L

Pressure, Strain (auge

B. SPAR vokage | Unavallable —
i GeiEct., =
7 GPAR voltage | SPAR/Surface Inadiance Click a sensor
{ ; and click Modify
Click a (non-shaded) sensor and click Select to pick a different sensor for Modlfp/ to ghan_ge
that channel. A dialog box with a list of sensors appears. Select sensors Ca|lblfa_tI0n
after number of voltage channels have been specified above. [ coefficients for
that sensor.
/Hepl:lrt... | Help... | Eut Canicel

A
Opens a .txt file (for viewing
and printing only; cannot be
modified) that shows all
parameters in .con file.
For command line generation
of report, see Appendix III:
Generating .con File Reports
— ConReport.exe.

Return to SBE Data Processing window.

o If Confirm Configuration Change was selected in
Configure menu - If you made changes and did
not Save or Save As, program asks if you want to
save changes.

¢ |f Confirm Configuration Change was not selected
in Configure menu - Button says Save & Exit. If
you do not want to save changes, use Cancel
button to exit.
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Shown below is an example status (DS) response in SEATERM that
corresponds to the setup shown in the Configuration dialog box above.
Shown below the appropriate lines are the commands used in SEATERM
to modify the setup of parameters critical to use of the SBE 19 with
Seasave and processing of data with SBE Data Processing, as well as any
explanatory information.

SEACAT PROFILER V3.1B SN 936 02/10/94 13:33:23.989

strain gauge pressure sensor: S/N = 12345,

range = 1000 psia, tc = 240

(Pressure sensor (strain gauge or Digiquartz) must match Pressure sensor type in
.con file.)

clk = 32767.766 iop = 172 vmain = 8.1 vlith = 5.8

mode = PROFILE ncasts = 0
(Mode must be profile [MP] if setting up .con file for SBE 19; create .con file for
SBE 16 for SBE 19 in moored mode [MM].)

sample rate = 1 scan every 0.5 seconds
(Sample rate [SR] must match 0.5 second intervals in .con file.)

minimum raw conductivity frequency for pump turn on =
3206 hertz

pump delay = 40 seconds
samples = 0 free = 174126 lwait = 0 msec
battery cutoff = 7.2 volts

number of voltages sampled = 2
(Number of auxiliary voltage sensors enabled [SVn] must match External voltage
channels in .con file.)

logdata = NO
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Channel/Sensor table reflects this
choice (0, 1, 2, 3, or 4). Must agree
with 19plus setup for VoltN=

(N=0, 1, 2,and 3); see reply from
DS. Voltage channel 0 in .con file
corresponds to first external
voltage in data stream, voltage
channel 1 to second external
voltage in data stream, etc.

Interval between scans in Moored
mode. Must agree with 19plus

setup (Samplelnterval=); see reply\— Sample interval seconds 11

from DS.

o NMEA - Select if NMEA navigation
device used, and if NMEA depth
data and NMEA time data were
also appended. Seasave adds
current latitude, longitude, and
universal time code to data
header; appends NMEA data to
every scan; and writes NMEA data
to .nav file every time Ctrl F7 is
pressed or Add to .nav File is
clicked.

Note: Whether NMEA device was
connected to a deck unit or directly
to computer during data
acquisition in Seasave has no
effect on data file used by SBE
Data Processing, and therefore
has no effect on data processing.

e Surface PAR - Select if using with
deck unit connected to Surface
PAR sensor. Seasave appends
Surface PAR data to every scan.
Adds 2 channels to
Channel/Sensor table. Do not
increase External voltage channels
to reflect this; External voltage
channels reflects only external
voltages going directly to 19plus
from auxiliary sensors. See
Application Note 47.

e Scan time added - Select to
include time of each scan
(seconds since January 1, 1970
GMT) with data.

SBE 19plus SEACAT Profiler Configuration

Configuration file opened: None

Pressure sensor ype

External voltage channels

tode

Scang to average

X

Select strain gauge (only

selection applicable to 19plus).

Shrain Gauge

i =

&

Must agree with 19plus setup (MP for

mode, MM for Moored mode); see reply from DS.

Profiing

Profie 7]

Number of samples to average (samples at 4 Hz)
in Profiling mode. Must agree with 19plus setup

(NAvg=); see reply from DS.

[V NME posiion data added

{* NMEA device connected to deck unit

" MMEZ device cannected to FC

[~ MME& depth data added
[~ HMEA fime added

[™ Suiace PAR voltage added

[~ Sian time added

Chanel Sensar | New
1. Caunt Temperature Shaded sensors
o cannot be Elpen...
removed or e
2. Frequency Conduchiity | e
2. Caunt Pressure, Strain augg another type of Cae
Owgen SBE43  |are i?ft}ﬂgfmers
KYEN, .
4. 4/0 voltage i T
B4 voltage1 | pH
F.A/D voltage 2 | Transmissometer, Chelsea/Seatech/wetlab
. Select.
T A valtage 3 | Alimeter /JE 2

New to create
new .con file for
this CTD.

Open to select
different .con
file.

Save or Save
As to save
current .con file
settings.

Click a (non-shaded) sensor and click Select to pick a
—| different sensor for that channel. Dialog box with a list of
sensors appears. Select sensors after number of voltage
——{ channels have been specified above.

W adifi="]

Fiepnrlt...

Help... |

[

Click a sensor
and click
Modify to
change
calibration
coefficients for
that sensor.

| Exit | Cancel

[

Opens a .txt file (for viewing
and printing only; cannot be
modified) that shows all
parameters in .con file.

For command line generation of
report, see Appendix Ill:
Generating .con File Reports —

ConReport.exe.

Return to SBE Data Processing window.

o If Confirm Configuration Change was selected in
Configure menu - If you made changes and did not Save
or Save As, program asks if you want to save changes.

o If Confirm Configuration Change was not selected in
Configure menu - Button says Save & Exit. If you do not
want to save changes, use Cancel button to exit.
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Shown below is an example status (DS) response in SEATERM that
corresponds to the setup shown in the Configuration dialog box above.
Shown below the appropriate lines are the commands used in SEATERM
to modify the setup of parameters critical to use of the 19plus with
Seasave and processing of data with SBE Data Processing, as well as any
explanatory information.

SeacatPlus V 1.5 SERIAL NO. 4000 22 May 2005 14:02:13

vbatt 9.6, vlith = 8.6, ioper = 61.2 ma,
ipump = 25.5 ma, iextOl = 76.2 ma, iext23 = 65.1 ma

status = not logging

number of scans to average = 1
(Scans to average [NAvg=] must match Scans to Average in .con file.)

samples = 0, free = 381300, casts = 0

mode = profile, minimum cond freq = 3000,
pump delay = 60 sec
(Mode [MP for profile or MM for moored] must match Mode in .con file.)

autorun = no, ignore magnetic switch = no
battery type = ALKALINE, battery cutoff = 7.3 volts

pressure sensor = strain gauge, range = 1000.0
(Pressure sensor [PType=] must match Pressure sensor type in .con file.)

SBE 38 = no, Gas Tension Device = no
(RS-232 sensors (which are used for custom applications only) must be disabled to
use Seasave.)

Ext Volt 0 = yes, Ext Volt 1 = yes, Ext Volt 2 = yes,

Ext Volt 3 = yes

(Number of external voltage sensors enabled [VoltO= through Volt3=] must match
External voltage channels in .con file.)

echo commands = yes

output format = raw Hex
(Output format must be set to raw Hex [OutputFormat=0] to acquire data
in Seasave.)
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Channel/Sensor table reflects this
choice (0, 1, 2, 3, 4, 5, or 6). Must
agree with 19plus V2 setup for
VoltN= (N=0, 1, 2, 3, 4, and 5); see
reply from GetCD or DS. Voltage
channel 0 in .con file corresponds
to first external voltage in data
stream, voltage channel 1 to
second external voltage in data
stream, etc.

Interval between scans in Moored
mode. Must agree with 19plus V2
setup (Samplelnterval=); see reply
from GetCD or DS.

o NMEA - Select if NMEA navigation
device used, and if NMEA depth
data and NMEA time data were
also appended. Seasave adds
current latitude, longitude, and
universal time code to data
header; appends NMEA data to
every scan; and writes NMEA data
to .nav file every time Ctrl F7 is
pressed or Add to .nav File is
clicked.

Note: Whether NMEA device was
connected to a deck unit or directly
to computer during data
acquisition in Seasave has no
effect on data file used by SBE
Data Processing, and therefore
has no effect on data processing.

e Surface PAR - Select if using with
deck unit connected to Surface
PAR sensor. Seasave appends
Surface PAR data to every scan.
Adds 2 channels to
Channel/Sensor table. Do not
increase External voltage channels
to reflect this; External voltage
channels reflects only external
voltages going directly to
19plus V2 from auxiliary sensors.
See Application Note 47.

e Scan time added - Select to
include time of each scan
(seconds since January 1, 1970
GMT) with data.

SBE 19plus V2 SEACAT Profiler Configuration

X

Caonfiguration file opened: Mone

Select strain gauge or Digiquartz
with temperature compensation.

Pressure sensor bype

&

IStrain Gauge

External voltage channels |4 j

GetCD or DS.

Mode

Must agree with 19plus V2 setup (MP for Profiing
mode, MM for Moored mode); see reply from

A

Profile = =

Senal R5-232C sensar Mane

|

Sample interval zeconds i voltage channels.

—

SBE 38 (secondary temperature), or up to 2 GTDs
(dissolved oxygen or nitrogen). Must agree with
19plus V2 setup; see reply from GetCD or DS.
Channel/Sensor table lists RS-232 sensors below

Scans o average

|

Number of samples to average (samples at 4 Hz)
in Profiling mode. Must agree with 19plus V2
setup (NAvg=); see reply from GetCD or DS.

¥ NME#A position data added

(¢ NMEA device connected to deck unit [ 1MES Hime added

" NME4 device connected to PC

[~ MMEA depth data added

[ Surface PAR voltage added [ Scan time added

New to create
Chatinel Senor Mew  |new .con file for
T this CTD.
1. Count emperature Shaded sensors Open to select
i cannot be removed |:||:|Eﬂ... d'?fe 0 Selec
2. Frequency Conductrity or changed to ﬁlleerent .con
: another type of o :
_3 _l:_':"‘_"-_'t_ Pressure, Stiain GaU38 Soncor. All others are |2/ iz"t‘; 2;5:"9
4. 440 volage 0 Owxpgen, 3BE 43 optional. R current .con file
ave Az, settings.
5 40 voltage 1 | pH

B A/D wolkage 2 | Transmissometer, Chelsea/Seatech/wetlab

7. 840 yoltage 3

Altimeter

Click a (non-shaded) sensor and click Select to pick a
different sensor for that channel. Dialog box with a list of
—|sensors appears. Select sensors after number of voltage
channels have been specified above.

Help.. Bit |

aelech

i, |

Click a sensor
and click
Modify to
change
calibration
coefficients for
that sensor.

Cancel |

Hepnpt...
/

Opens a .txt file (for viewing and
printing only; cannot be modified) that
shows all parameters in .con file.

For command line generation of report,
see Appendix Ill: Generating .con File
Reports — ConReport.exe.

__|Return to SBE Data Processing window.
o If Confirm Configuration Change was selected in
Configure menu - If you made changes and did not Save
or Save As, program asks if you want to save changes.

o If Confirm Configuration Change was not selected in
Configure menu - Button says Save & Exit. If you do not
want to save changes, use Cancel button to exit.
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Shown below is an example status (DS) response in a terminal program that
corresponds to the setup shown in the Configuration dialog box above.

Shown below the appropriate lines are the commands used in the terminal
program to modify the setup of parameters critical to use of the 19plus V2 with
Seasave and processing of data with SBE Data Processing, as well as any
explanatory information.

SeacatPlus V 2.0 SERIAL NO. 4000 22 Oct 2007 14:02:13

9.6, vlith = 8.6, ioper = 61.2 ma,
25.5 ma, iextOl = 76.2 ma, iext2345 = 65.1 ma

vbatt
ipump

status = not logging

number of scans to average = 1
(Scans to average [NAvg=] must match Scans to Average in .con file.)

samples = 0, free = 4386532, casts = 0

mode = profile, minimum cond freq = 3000,
pump delay = 60 sec
(Mode [MP for profile or MM for moored] must match Mode in .con file.)

autorun = no, ignore magnetic switch = no
battery type = ALKALINE, battery cutoff = 7.5 volts

pressure sensor = strain gauge, range = 1000.0
(Pressure sensor [PType=] must match Pressure sensor type in .con file.)

SBE 38 = no, Gas Tension Device = no
(Selection/enabling of RS-232 sensors [SBE38=, GTD=, DualGTD=] must match
Serial RS-232C sensor in .con file.)

Ext Volt 0 = yes, Ext Volt 1 = yes
Ext Volt 2 = yes, Ext Volt 3 = yes
Ext Volt 4 = no, Ext Volt 5 = no

(Number of external voltage sensors enabled [VoltO= through Volt3=] must match
External voltage channels in .con file.)

echo characters = yes

output format = raw Hex
(Output format must be set to raw Hex [OutputFormat=0] to acquire data
in Seasave.)
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SBE 21 Thermosalinograph Configuration

Channel/Sensor table reflects this choice (shows additional frequency-based temperature channel
if SBE 3 selected, or RS-232 channel if SBE 38 selected). Must agree with SBE 21 setup (SBE3=
and SBE38=); see reply from DS. If remote temperature is selected, Seasave, Data Conversion,
and Derive use remote temperature data when calculating density and sound velocity.

NMEA - Select if NMEA
navigation device used, and if
NMEA depth data and NMEA
time data were also appended.
Seasave adds current latitude,
longitude, and universal time
code to data header; appends
NMEA data to every scan; and
writes NMEA data to .nav file
every time Ctrl F7 is pressed or
Add to .nav File is clicked.
Note: NMEA time can only be
appended if NMEA device
connected to computer.

Note: Whether NMEA device
was connected to a deck unit
or directly to computer during
data acquisition in Seasave
has no effect on data file used
by SBE Data Processing, and
therefore has no effect on data
processing.

Configuration file opened; None
Remote temperature
E ternal voltage channels

1 =

Sample interval seconds |5

|SBE ki "I

Iy

X

Channel/Sensor table reflects this choice. Must agree
with SBE 21 setup for SVx (x=0, 1, 2, 3, or 4); see reply
from DS. Voltage channel 0 in .con file corresponds to
sensor wired to channel 0 on end cap connector,
voltage channel 1 in .con file corresponds to sensor
wired to channel 1 on end cap connector, etc.

Time between scans.
Must agree with SBE 21 setup
(Sl); see reply from DS.

¥ NMEA position data added

1+ NMEA device connected to deck unit

" NMEA device connected ta PC

™ NMEA depth data added

[ HWES tme added

[ Scantime added —

Select to include time of each scan (seconds
since January 1, 1970 GMT) with data.

New to create new

Open to select
different .con file.
Save or Save As to
save current .con file

Charinel Serzar | New
1. Fraquency T emperature : .con file.
T i ...
2. Frequency Conductivity P
3 Senal RS-232 Temperature, SBE 38 SavE
4 A0 voltage 0 pH T settings.
Shaded sensors cannot be removed or changed to |——x—""1
another type of sensor. All others are optional.
I F—aelect,

Click a (non-shaded) sensor and click Select to pick a different sensor for that
channel. A dialog box with a list of sensors appears. Select sensors after
number of voltage and frequency channels have been specified above.

1oy :I/

ﬁpnrt...l Help... |

that shows all parameters in
.con file.

report, see Appendix IlI:
Generating .con File Reports —
ConReport.exe.

Opens a .txt file (for viewing and
printing only; cannot be modified)

For command line generation of

Exit I Cancel |

Click a sensor
and click Modify
to change
calibration
coefficients for
that sensor.

Return to SBE Data Processing window.

o If Confirm Configuration Change was selected in
Configure menu - If you made changes and did
not Save or Save As, program asks if you want to
save changes.

o If Confirm Configuration Change was not selected
in Configure menu - Button says Save & Exit. If
you do not want to save changes, use Cancel
button to exit.
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Shown below is an example status (DS) response in SEATERM that
corresponds to the setup shown in the Configuration dialog box above.
Shown below the appropriate lines are the commands used in SEATERM
to modify the setup of parameters critical to use of the SBE 21 with
Seasave and processing of data with SBE Data Processing, as well as any
explanatory information.

SEACAT THERMOSALINOGRAPH V4._.2a SERIAL NO. 4300 05/15/2003
14:23:14

ioper = 50.7 ma, vmain = 11.4, vlith = 8.8,
iextOl = 76.2 ma

samples = 0, free = 1396736

sample interval = 5 seconds
(Sample interval [SI] must match Sample interval seconds in .con file.)

sample external SBE 38 temperature sensor
(External temperature sensor [SBE38=, SBE3=] must match Remote temperature in
.con file.)

no. of volts sampled = 1
(Number of auxiliary voltage sensors enabled [SVx] must match External voltage
channels in .con file.)

output format = SBE21
(Output format must be set to SBE 21 [F1] to acquire data in Seasave.)

start sampling when power on = yes
average data during sample interval = yes
logging data = no

voltage cutoff = 7.5 volts
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Used to determine strain gauge
pressure sensor data format. See
reply from DS.

o NMEA - Select if NMEA navigation
device used, and if NMEA depth
data and NMEA time data were
also appended. Seasave adds
current latitude, longitude, and
universal time code to data
header; appends NMEA data to
every scan; and writes NMEA data
to .nav file every time Ctrl F7 is
pressed or Add to .nav File is
clicked.

Note: Whether NMEA device was
connected to a deck unit or directly
to computer during data
acquisition in Seasave has no
effect on data file used by SBE
Data Processing, and therefore
has no effect on data processing.

e Surface PAR - Select if using with
deck unit connected to Surface
PAR sensor. Seasave appends
Surface PAR data to every scan.
Adds 2 channels to
Channel/Sensor table. Do not
increase External voltage channels
to reflect this; External voltage
channels reflects only external
voltages going directly to SBE 25
from auxiliary sensor See
Application Note 47.

e Scan time added - Select to
include time of each scan
(seconds since January 1, 1970
GMT) with data.

SBE 25 SEALOGGER Configuration

Configuration fle opened: Mone

Firrniarare wersion

~E#temal vakage channels Ig vl

I‘Jersinn r=2l "I

Channel/Sensor table reflects this choice (0 - 7). Must
agree with SBE 25 setup (CC); see reply from DS.
Voltage channel 0 in .con file corresponds to first external
voltage in data stream, voltage channel 1 to second

external voltage in data stream, etc.

1, 2, 4, or 8 scans/second. Must agree with
SBE 25 setup (CC); see reply from DS.

Real time data output rate |1 scandsen vl/

¥ MME& position data added

(¢ NMEA device connected to deck unit
" NMEA device connected to PC

[~ NMEA depth data added

[~ HHES time added

¥ Suface PAR voltage added

[ Scan time added

Channel Senzar Mew |
1. Frequency Temperature Shaded sensors i
2 Frequenc_l,l El:lnductivity cannot be removed

Fressure, Shain Gau
Owygen, SBE 43

or changed to
another type of
sensor. All others
are optional.

Fluorometer, Chelzea dqua 3

Lnavailable

——————————— : Selent |

7. SPAR voltage | SPAR/Surface Imadiance 3, .

b Tl Click a sensor

fadiii. 7] |and click Modify

r Click a (non-shaded) sensor and click Select to change
to pick a different sensor for that channel. calibration
A dialog box with a list of sensors appears. coefficients for
Select sensors after number of voltage that sensor.
channels have been specified above.

\Fiepn:lrl... | Help... | /Emt Cancel

)\ /

Saveds.

il

New to create new
.con file for this CTD.
Open to select
different .con file.
Save or Save As to
save current .con file
settings.

Opens a .txt file (for viewing
and printing only; cannot be
modified) that shows all
parameters in .con file.

For command line generation
of report, see Appendix IlI:
Generating .con File Reports

— ConReport.exe.
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button to exit.

Return to SBE Data Processing window.

o If Confirm Configuration Change was selected in
Configure menu - If you made changes and did
not Save or Save As, program asks if you want to

¢ If Confirm Configuration Change was not selected
in Configure menu - Button says Save & Exit. If
you do not want to save changes, use Cancel
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Shown below is an example status (DS) response in SEATERM that
corresponds to the setup shown in the Configuration dialog box above.
Shown below the appropriate lines are the commands used in SEATERM
to modify the setup of parameters critical to use of the SBE 25 with
Seasave and processing of data with SBE Data Processing, as well as any
explanatory information.

SBE 25 CTD V 4.1a SN 323 04/26/02 14:02:13

external pressure sensor, range = 5076 psia, tcval = -55
xtal=9437363 clk=32767.107 vmain=10.1 iop=175 vlith=5.6
ncasts=0 samples=0 free = 54980 lwait = 0 msec

stop upcast when CTD ascends 30 % of full scale pressure
sensor range (2301 counts)

CTD configuration:

number of scans averaged=1, data stored at 8 scans
per second

real time data transmitted at 1 scans per second
(real-time data transmission [CC] must match Real time data output rate in
.con file.)

minimum conductivity frequency for pump turn on = 2950
pump delay = 45 seconds
battery type = ALKALINE

2 external voltages sampled
(Number of auxiliary voltage sensors enabled [CC] must match External voltage
channels in .con file.)

stored voltage #0 external voltage 0O

stored voltage #1 = external voltage 1
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Define data in SBE 45 data

stream:

e Output conductivity - Must
agree with SBE 45 setup
(OutputCond=).

e Output salinity — Must agree
with SBE 45 setup
(QutputSal=).

e Output sound velocity —
Must agree with SBE 45
setup (OutputSV=).

See reply from DS for setup

programmed into SBE 45.

Configuration file opened: Hone

GHE 4% Mig il

SBE 45 MicroTSG Configuration

The SBE 45 transmits ASCII converted data in engineering units. It converts
the raw data internally to engineering units, based on the programmed
calibration coefficients. See the SBE 45 manual.

Time between scans. Must agree with SBE 45
setup (Interval=); see reply from DS.

Sample interval seconds |-| / Mew  [New to create new
s S | = |.confile.
¥ Output conductivity ' ¥ Use junction box ' Open Open to select
i , —_ldifferent .con file.
1
[ Output zalinity ' ¥ SBE3A temperature added, Goye |S@veorSave Asto
' | ———jsave current .con file
™ Output sound velocity 1 ¥ NMEA data added ! settings.
utput sound welociky l_l__ ______ I_g_a_a__la_______. Save b
1
Report... Help... i Euit \ i Cancel
1

connected to NMEA navigation device. Seasave adds current
latitude, longitude, and universal time code to data header;
appends NMEA data to every scan; and writes NMEA data to .nav
file every time Ctrl F7 is pressed or Add to .nav File is clicked.

e Use junction box - Select if SBE 45 data is transmitted to - -
computer through optional 90402 — SBE 45 Interface Box. Interface | |Return to SBE Data Processing window.
Box can append optional SBE 38 and NMEA data to SBE 45 data e If Confirm Configuration Change was selected
stream. in Configure menu - If you made changes and
o SBE 38 temperature added — Select if 90402 — SBE 45 Interface did not Save or Save As, program asks if you
Box is connected to SBE 38 remote temperature sensor. Seasave want to save ch_ange_s.
appends SBE 38 data to data stream. Seasave, Data Conversion, e If Confirm Configuration Change was not
and Derive use remote temperature data when calculating density selected in Configure menu - Button says
and sound velocity. Save & Exit. If you do not want to_ save
o NMEA data added - Select if 90402 — SBE 45 Interface Box is changes, use Cancel button to exit.

Shown below is an example status (DS) response in SEATERM that
corresponds to the setup shown in the Configuration dialog box above.
Shown below the appropriate lines are the commands used in SEATERM
to modify the setup of parameters critical to use of the SBE 45 with
Seasave and processing of data with SBE Data Processing, as well as any
explanatory information.

SBE45 V 1.1 SERIAL NO. 1258
logging data

sample interval = 1 seconds
(Sample interval [Interval=] must match Sample interval seconds in .con file.)

output conductivity with each sample
(Enabling of conductivity output [OutputCond=] must match Output conductivity
in .con file.)

do not output salinity with each sample
(Enabling of salinity output [OutputSal=] must match Output salinity in
.con file.)

do not output sound velocity with each sample
(Enabling of sound velocity output [OutputSV=] must match Output sound velocity
in .con file.)

start sampling when power on

do not power off after taking a single sample
(Power off after taking a single sample must be disabled [SingleSample=N] to
acquire data in Seasave.)

do not power off after two minutes of inactivity

A/D cycles to average = 2
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SBE 49 FastCAT Configuration

Configuration for the SBE 49 Fastcat CTD

Configuration file opened: Mone

Scanz to average |-| |

Select to include time
of each scan (seconds
since January 1, 1970
GMT) with data.

\
[T Scan time added

x|

Number of samples to average per scan. SBE 49 samples at 16 Hz
(0.0625 seconds), averages data, and transmits averaged data real-
time. Must agree with SBE 49 setup (NAvg=); see reply from DS.

MHew

COpen...

Save

ave bz

New to create new
.con file for this CTD.
Open to select
different .con file.
Save or Save As to
save current .con file
settings.

Mu:udif_l,l..:l

Canhcel

Click a sensor
and click Modify
to change
calibration
coefficients for

Channel Senzor
1. Count
2. Frequency Conductivity
3. Count Frezsure, Shain Gauge
5
Hepn:-r)(.. | Help... E:-:it/ I
/

/

Opens a .txt file (for viewing and
printing only; cannot be modified) that
shows all parameters in .con file.

For command line generation of report,
see Appendix lll: Generating .con File
Reports — ConReport.exe.

Return to SBE Data Processing window.

If Confirm Configuration Change was selected in
Configure menu - If you made changes and did
not Save or Save As, program asks if you want to
save changes.

If Confirm Configuration Change was not selected
in Configure menu - Button says Save & Exit. If
you do not want to save changes, use Cancel
button to exit.

that sensor.

Shown below is an example status (DS) response in SEATERM that
corresponds to the setup shown in the Configuration dialog box above.
Shown below the appropriate lines are the commands used in SEATERM
to modify the setup of parameters critical to use of the SBE 49 with
Seasave and processing of data with SBE Data Processing, as well as any
explanatory information.

SBE 49 FastCAT V 1.2 SERIAL NO. 0055

number of scans to average = 1
(Scans to average [NAvg=] must match Scans to average in .con file.)

pressure sensor = strain gauge, range

1000.0

minimum cond freq = 3000, pump delay = 30 sec

start sampling on power up = yes

output format = raw HEX
(Output format must be set to raw Hex [OutputFormat=0] to acquire data
in Seasave.)

temperature advance

0.0625 seconds

celltm alpha = 0.03

celltm tau

7.0

real-time temperature and conductivity correction disabled
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Accessing Calibration Coefficients Dialog Boxes

In the Configure menu, select the desired instrument.

In the Configuration dialog box, click Open. Browse to the desired .con
file and click Open.

3. In the Configuration dialog box, click a sensor and click Modify to change
the calibration coefficients for that sensor (or right click on the sensor and
select Modify . . Calibration, or double click on the sensor); the calibration
coefficients dialog box for the sensor appears (example is shown for a

pH sensor).

Serial number [|

N —

Calibration date |

Slope {0.0000

Dffset Ig_ 0000

Import | Export Il oK I Cancel |

Importing and Exporting Calibration Coefficients

Calibration coefficient dialog boxes contain Import and Export buttons, which
can be used to simplify entering calibration coefficients. These buttons are
particularly useful when swapping sensors from one instrument to another,
allowing you to enter calibration coefficients without the need for typing or the
resulting possibility of typographical errors. An example dialog box is shown
above for a pH sensor.

The Export button allows you to export coefficients for the selected sensor to
an . XML file. If you move that sensor onto another instrument, you can then
import the coefficients from the . XML file when setting up the .con file for that
instrument.

The Import button allows you to import coefficients for the selected sensor

from another .con file or from an . XML file. When you click the Import button,

a dialog box appears. Select the desired file type, and then browse to and select

the file:

e .con file — opens a .con file, retrieves the calibration coefficients from the
.con file for the type of sensor you selected, and enters the coefficients in
the calibration coefficients dialog box. If the .con file contains more than
one of that type of sensor (for example, SBE Data Processing can process
data for an instrument interfacing with up to two SBE 43 oxygen sensors,
so the .con file could contain coefficients for two SBE 43 sensors), a dialog
box allows you to select the desired sensor by serial number. If the .con file
does not contain any of that type of sensor, SBE Data Processing responds
with an error message.

o XML file — imports an . XML file that contains calibration coefficients for
one sensor. If the XML file you select is not compatible with the selected
sensor type, SBE Data Processing responds with an error message.
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Calibration Coefficients for Frequency Sensors

Notes:

¢ Coefficients g, h, i, j, and fO
provide ITS-90 (Too)
temperature; a, b, c, d, and fO
provide IPTS-68 (Tesg)
temperature. The relationship
between them is:

Teg =1.00024 Tgo

e See Application Note 31 for
computation of slope and offset
correction coefficients from pre-
and post-cruise calibrations
supplied by Sea-Bird.

e See Calibration Coefficients for
A/D Count Sensors below for
information on temperature
sensors used in the
SBE 16plus (and -IM),
16plus (and -IM) V2, 19plus,
19plus V2, and 49.

View and/or modify the sensor calibration coefficients by selecting the sensor
and clicking the Modify button in the instrument Configuration dialog box. For
all calibration dialog boxes, enter the sensor serial number and calibration date.
Many sensor calibration equations contain an offset term. Unless noted
otherwise, use the offset (default = 0.0) to make small corrections for sensor
drift between calibrations.

Calibration coefficients are discussed below for each type of sensor.
Temperature, conductivity, and Digiquartz pressure sensors are covered first,
followed by the remaining frequency sensor types in alphabetical order.

Temperature Calibration Coefficients

Enter g, h, i, j (or a, b, c, d), and fO from the calibration sheet.
Enter values for slope (default = 1.0) and offset (default = 0.0) to make small
corrections for temperature sensor drift between calibrations:

Corrected temperature = (slope * computed temperature) + offset

where

slope = true temperature span / instrument temperature span

offset = (true temperature — instrument reading) * slope; measured at 0 °C

Temperature Slope and Offset Correction Example

At true temperature = 0.0 °C, instrument reading = 0.0015 °C
At true temperature = 25.0 °C, instrument reading = 25.0005 °C
Calculating the slope and offset:

Slope = (25.0 — 0.0) / (25.0005 — 0.0015) = + 1.000040002
Offset = (0.0 — 0.0015) * 1.000040002 = - 0.001500060

Sea-Bird temperature sensors usually drift by changing offset, typically
resulting in higher temperature readings over time for sensors with serial
number less than 1050 and lower temperature readings over time for sensors
with serial number greater than 1050. Sea-Bird’s data indicates that the drift is
smooth and uniform with time, allowing users to make very accurate
corrections based only on pre- and post-cruise laboratory calibrations.
Calibration checks at sea are advisable to ensure against sensor malfunction;
however, data from reversing thermometers is rarely accurate enough to make
calibration corrections that are better than those possible from shore-based
laboratory calibrations.

Sea-Bird temperature sensors rarely exhibit span errors larger than £ 0.005 °C
over the range —5 to +35 °C (0.005 °C/(35 -[-5])C/year = 0.000125 °C/C/year),
even after years of drift. A span error that increases more than

+ 0.0002 °C/C/year may be a symptom of sensor malfunction.
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Note:

Use coefficients g, h, i, j, Ctcor,
and Cpcor (if available on
calibration sheet) for most
accurate results; conductivity for
older sensors was calculated

based on a, b, ¢, d, m, and Cpcor.

Note:

See Application Note 31 for
computation of slope and offset
correction coefficients from pre-
and post-cruise calibrations
supplied by Sea-Bird or from
salinity bottle samples taken at
sea during profiling.

Conductivity Calibration Coefficients

Enter g, h, 1, j, Ctcor (or a, b, ¢, d, m) and Cpcor from the calibration sheet.

e  Cpcor makes a correction for the highly consistent change in dimensions of
the conductivity cell under pressure. The default is the compressibility
coefficient for borosilicate glass (-9.57e-08). Some sensors fabricated
between 1992 and 1995 (serial numbers between 1100 and 1500) exhibit a
compression that is slightly less than pure borosilicate glass. For these
sensors, the (hermetic) epoxy jacket on the glass cell is unintentionally
strong, creating a composite pressure effect of borosilicate and epoxy.

For sensors tested to date, this composite pressure coefficient ranges from -
9.57e-08 to -6.90e-08, with the latter value producing a correction to deep
ocean salinity of 0.0057 PSU in 5000 dbars pressure (approximately

0.001 PSU per 1000 dbars).

Before modifying Cpcor, confirm that the sensor behaves differently from
pure borosilicate glass. Sea-Bird can test your cell and calculate Cpcor.
Alternatively, test the cell by comparing computed salinity to the salinity
of water samples from a range of depths, calculated using an AutoSal.

Enter values for slope (default = 1.0) and offset (default = 0.0) to make small
corrections for conductivity sensor drift between calibrations:

Corrected conductivity = (slope * computed conductivity) + offset

where

slope = true conductivity span / instrument conductivity span

offset = (true conductivity — instrument reading) * slope; measured at 0 S/m

Conductivity Slope and Offset Correction Example

At true conductivity = 0.0 S/m, instrument reading = -0.00007 S/m
At true conductivity = 3.5 S/m, instrument reading = 3.49965 S/m
Calculating the slope and offset:

Slope = (3.5 - 0.0) / (3.49965 - [- 0.00007]) =+ 1.000080006
Offset = (0.0 - [-0.00007]) * 1.000080006 =+ 0.000070006

The sensor usually drifts by changing span (slope of the calibration curve),
typically resulting in lower conductivity readings over time. Offset error

(error at 0 S/m) is usually due to electronics drift, and is typically less than

+ 0.0001 S/m per year. Because offsets greater than + 0.0002 S/m are a
symptom of sensor malfunction, Sea-Bird recommends that drift corrections be
made by assuming no offset error, unless there is strong evidence to the
contrary or a special need.

Wide Range Conductivity Sensors

A wide range conductivity sensor has been modified to provide conductivity
readings to 15 Siemens/meter by inserting a precision resistor in series with the
conductivity cell. Therefore, the equation used to fit the calibration data is
different from the standard equation. The sensor’s High Range Conductivity
Calibration sheet includes the equation as well as the cell constant and series
resistance to be entered in the program.

If the conductivity sensor serial number includes a W (an indication that it is a

wide range sensor):

1. After you enter the calibration coefficients and click OK, the Wide Range
Conductivity dialog box appears.

2. Enter the cell constant and series resistance (from the High Range
Conductivity Calibration sheet) in the dialog box, and click OK.
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Note:

See Calibration Coefficients for
A/D Count Sensors below for
information on strain gauge
pressure sensors used on the
SBE 16plus (and -IM),

16plus (and -IM) V2, 19plus,
19plus V2, and 49.

See Calibration Coefficients for
Voltage Sensors below for
information on strain gauge
pressure sensors used on
other instruments.

Pressure (Paroscientific Digiquartz) Calibration Coefficients

Enter the sets of C, D, and T coefficients from the calibration sheet. Enter zero

for any higher-order coefficients that are not listed on the calibration sheet.

Enter values for slope (default = 1.0; do not change unless sensor has been

recalibrated) and offset (default = 0.0) to make small corrections for

sensor drift.

e  For the SBE 9plus, also enter AD590M and AD590B coefficients from the
configuration sheet.

Bottles Closed (HB - IOW) Calibration Coefficients

No calibration coefficients are entered for this parameter.
The number of bottles closed is calculated by Data Conversion
based on frequency range.

Sound Velocity (IOW) Calibration Coefficients

Enter coefficients a0, al, and a2.
Value = a0 + al * frequency + a2 * frequency
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Calibration Coefficients for A/D Count Sensors

Notes:

e These coefficients provide
ITS-90 (Tgo) temperature.

e See Application Note 31 for
computation of slope and offset
correction coefficients from pre-
and post-cruise calibrations
supplied by Sea-Bird.

Note:

See Calibration Coefficients for
Voltage Sensors below for
information on strain gauge
pressure sensors used on other
instruments. See Calibration
Coefficients for Frequency
Sensors above for information
on Paroscientific Digiquartz
pressure sensors.

View and/or modify the sensor calibration coefficients by selecting the sensor
and clicking the Modify button in the instrument Configuration dialog box. For
all calibration dialog boxes, enter the sensor serial number and calibration date.
Many sensor calibration equations contain an offset term. Unless noted
otherwise, use the offset (default = 0.0) to make small corrections for sensor
drift between calibrations.

Calibration coefficients are discussed below for each type of sensor:
temperature and strain gauge pressure sensor.

Temperature Calibration Coefficients

For SBE 16plus (and -IM), 16plus (and-IM) V2, 19plus, 19plus V2, and 49:
Enter a0, al, a2, and a3 from the calibration sheet.
Enter values for slope (default = 1.0) and offset (default = 0.0) to make small
corrections for temperature sensor drift between calibrations:

Corrected temperature = (slope * computed temperature) + offset

where

slope = true temperature span / instrument temperature span

offset = (true temperature — instrument reading) * slope; measured at 0 °C

Temperature Slope and Offset Correction Example

At true temperature = 0.0 °C, instrument reading = 0.0015 °C
At true temperature = 25.0 °C, instrument reading = 25.0005 °C
Calculating the slope and offset:

Slope = (25.0 — 0.0) / (25.0005 — 0.0015) = + 1.000040002
Offset = (0.0 — 0.0015) * 1.000040002 = - 0.001500060

Sea-Bird temperature sensors usually drift by changing offset, typically
resulting in lower temperature readings over time. Sea-Bird’s data indicates that
the drift is smooth and uniform with time, allowing users to make very accurate
corrections based only on pre- and post-cruise laboratory calibrations.
Calibration checks at sea are advisable to ensure against sensor malfunction;
however, data from reversing thermometers is rarely accurate enough to make
calibration corrections that are better than those possible from shore-based
laboratory calibrations.

Sea-Bird temperature sensors rarely exhibit span errors larger than + 0.005 °C
over the range —5 to +35 °C (0.005 °C/(35 -[-5])C/year = 0.000125 °C/C/year),
even after years of drift. A span error that increases more than

1 0.0002 °C/C/year may be a symptom of sensor malfunction.

Pressure (Strain Gauge) Calibration Coefficients

For SBE 16plus (and -IM), 16plus (and IM) V2, 19plus, and 19plus V2
configured with a strain gauge pressure sensor, and for all SBE 49s: Enter pA0,
pAl, pA2, ptempAO, ptempAl, ptempA2, pTCAO, pTCAL, pTCA2, pTCBO,
pTCBI, and pTCB2 from the calibration sheet. Offset is normally zero, but
may be changed for non-zero sea-surface condition. For example, if the in-air
pressure reading is negative, enter an equal positive value.
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Calibration Coefficients for Voltage Sensors

Note:

Unless noted otherwise, SBE Data
Processing supports only one of each
auxiliary sensor model on a CTD (for
example, you cannot specify two
Chelsea Minitracka fluorometers, but
you can specify a Chelsea Minitracka
and a Chelsea UV Aquatracka
fluorometer. See the sensor
descriptions below for those sensors
that SBE Data Processing supports
in a redundant configuration (two or
more of the same model interfacing
with the CTD).

Note:

See Calibration Coefficients for A/D
Count Sensors above for information
on strain gauge pressure sensors
used on the SBE 16plus (and -IM),
16plus (and -IM) V2, 19plus,
19plus V2, and 49.

See Calibration Coefficients for
Frequency Sensors above for
information on Paroscientific
Digiquartz pressure sensors.

Note:

In Seasave, enter the altimeter
alarm set point, alarm hysteresis,
and minimum pressure to enable
alarm.

View and/or modify the sensor calibration coefficients by selecting the sensor
and clicking the Modify button in the instrument Configuration dialog box. For
all calibration dialog boxes, enter the sensor serial number and calibration date.
Many sensor calibration equations contain an offset term. Unless noted
otherwise, use the offset (default = 0.0) to make small corrections for sensor
drift between calibrations.

Calibration coefficients are discussed below for each type of sensor. Strain
gauge pressure sensors are covered first, followed by the remaining voltage
sensor types in alphabetical order.

Pressure (Strain Gauge) Calibration Coefficients

Enter coefficients:
e  Pressure sensor without temperature compensation

> Enter A0, Al, and A2 coefficients from the calibration sheet

» For older units with a linear fit pressure calibration, enter M (A1) and
B (A0) from the calibration sheet, and set A2 to zero.

» For all units, offset is normally zero, but may be changed for non-zero
sea-surface condition. For example, if the in-air pressure reading is
negative, enter an equal positive value.

e  Pressure sensor with temperature compensation

Enter ptempAOQ, ptempA 1, ptempA2, pTCAO, pTCAL, pTCA2, pTCBO,

pTCBI, pTCB2, pAO, pAl, and pA2 from the calibration sheet.

Altimeter Calibration Coefficients

Enter the scale factor and offset.

altimeter height = [300 * voltage / scale factor] + offset

where

scale factor = full scale voltage * 300/full scale range

full scale range is dependent on the sensor (e.g., 50m, 100m, etc.)
full scale voltage is from calibration sheet (typically 5V)

Fluorometer Calibration Coefficients

e Biospherical Natural Fluorometer
Enter Cfn (natural fluorescence calibration coefficient), A1, A2, and B
from calibration sheet.
natural fluorescence Fn = Cfn * 10Y
production = A1 * Fn/ (A2 + PAR)
chlorophyll concentration Chl = Fn /(B * PAR)
where
V is voltage from natural fluorescence sensor
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Note:

See Application Note 39 for complete
description of calculation of Chelsea
Aqua 3 calibration coefficients.

Note:

See Application Note 61 for complete
description of calculation of Chelsea
Minitracka calibration coefficients.

Chelsea Aqua 3

Enter VB, V1, Vacetone, slope, offset, and SF.

Concentration (ug/l) = slope*[(10.0(V/SF) - 10.0VB)/(10.0V! - 10.0Vacetone)]
+ offset

where

VB, V1, and Vacetone are from calibration sheet

Slope (default 1.0) and offset (default 0.0) adjust readings to conform to

measured concentrations

Scale factor SF = 1.0 if CTD gain is 1; SF =2 if CTD gain is 2.0

V is output voltage measured by CTD

Note: SBE Data Processing can process data for an instrument interfacing

with up to two Chelsea Aqua 3 fluorometers

Chelsea Aqua 3 Example - Calculation of Slope and Offset

Current slope = 1.0 and offset = 0.0

Two in-situ samples:
Sample 1 -
Concentration (from SBE Data Processing) = 0.390
Concentration (from water sample) = 0.450
Sample 2 —
Concentration (from SBE Data Processing) = 0.028
Concentration (from water sample) = 0.020

Linear regression to this data yields slope = 1.188 and offset = - 0.013

Chelsea UV Aquatracka

Enter A and B.

Concentration (ug/l)=A *10.0V - B
where

A and B are from calibration sheet
V is output voltage measured by CTD

Chelsea Minitracka

Enter Vacetone, Vacetone100, and offset.

Concentration = (100 *[V - Vacetone]/[Vacetonel00 - Vacetone]) + offset
where

Vacetone (voltage with 0 ng/l chlorophyll) and Vacetonel00 (voltage with
100 pg/l chlorophyll) are from calibration sheet

Dr Haardt Fluorometer - Chlorophyll a, Phycoerythrin, or
Yellow Substance
Enter AO, Al, BO, and BI.
These instruments may have automatic switching between high and low
gains. Select the gain range switch:
» Output Voltage Level if the instrument indicates gain by output voltage
level (< 2.5 volts is low gain, > 2.5 volts is high gain)
Low gain: value = A0 + (Al * V)
High gain: value =B0 + (B1 * V)
» Modulo Bit if the instrument has control lines custom-wired to bits in
the SBE 9plus modulo word
Bit not set: value = A0 + (Al * V)
Bit set: value =BO0 + (Bl * V)
» None if the instrument does not change gain
value = A0 + (A1 * V)
where
V = voltage from sensor

Dr Haardt Voltage Level Switching Examples

Example: Chlorophyll a

Low range scale = 10 mg/l and Gain = 10/2.5 =4 mg/l/volt
A0=0.0 Al1=4.0

High range scale =100 mg/l and Gain = 100/2.5 = 40 mg/l/volt
B0 =-100 B1=40.0
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Note:

See Application Note 54 for complete
description of calculation of Seapoint
fluorometer calibration coefficients.

Notes:

e See Application Note 9 for
complete description of calculation
of WET Labs FLF and Sea Tech
fluorometer calibration coefficients.

e Offset and scale factor may be
adjusted to fit a linear regression of
fluorometer responses to known
chlorophyll a concentrations.

Seapoint

Enter gain and offset.

Concentration = (V * 30/gain) + offset

where

Gain is dependent on cable used (see cable drawing, pins 5 and 6)

Note: SBE Data Processing can process data for an instrument interfacing
with up to two Seapoint fluorometers.

Seapoint Rhodamine

Enter gain and offset.

Concentration = (V * 30/gain) + offset

where

Gain is dependent on cable used (see cable drawing, pins 5 and 6)

Sea Tech and WET Labs Flash Lamp Fluorometer (FLF)
Enter scale factor and offset.

Concentration = (voltage * scale factor / 5) + offset

where

Scale factor is dependent on fluorometer range

Fluorometer - Switch-SeIecta_bIe Range Scale
(milligrams/m3 or micrograms/liter) Factor
Sea Tech 0-3 3
0 — 10 (default) 10
0-30 30
0-100 100
0-300 300
0-1000 1000
WET Labs 0-100 100
FLF 0 —300 (default) 300
0-1000 1000

Offset is calculated by measuring voltage output when the light sensor is
completely blocked from the strobe light with an opaque substance such as
heavy black rubber: offset = - (scale factor * voltage) / 5

Turner 10-005
This sensor requires two channels - one for the fluorescence voltage and
the other for the range voltage. Make sure to select both when configuring
the instrument.
For the fluorescence voltage channel, enter scale factor and offset.
concentration = [fluorescence voltage * scale factor / (range * 5)] + offset
where
range is defined in the following table

Range Voltage Range

<0.2 volts 1.0

>0.2volts and <0.55 volts 3.16
>0.55volts and < 0.85 volts 10.0
> (.85 volts 31.0

Turner 10-AU-005

Enter full scale voltage, zero point concentration, and full scale
concentration from the calibration sheet.

concentration = [(1.195 * voltage * (FSC — ZPC)) / FSV] + ZPC
where

voltage = measured output voltage from fluorometer

FSV = full scale voltage; typically 5.0 volts

FSC = full scale concentration

ZPC = zero point concentration
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Notes:

e To enable entry of the mx, my,
and b coefficients, you must
first select the Turner SCUFA
OBS/Nephelometer.

e See Application Note 63 for
complete description of calculation
of Turner SCUFA calibration
coefficients.

Notes:

e For complete description of
calibration coefficient calculation,
see Application Note 41 for
WetStar and Application Note 62
for ECO-AFL, ECO-FL, and
ECO-FL-NTU.

e For ECO-FL-NTU, a second
channel is required for turbidity.
Set up the second channel as a
User Polynomial, with:
a0 = - Vblank * scale factor
al = scale factor (NTU/volts)
a2=a3=0
where scale factor and Vblank are
for the turbidity measurement.

Turner SCUFA

Enter scale factor, offset, units, mx, my, and b from the calibration sheet.
chlorophyll = (scale factor * voltage) + offset

corrected chlorophyll = (mx * chlorophyll) + (my * NTU) +b

where

NTU = results from optional turbidity channel in SCUFA (see Turner
SCUFA in OBS equations below)

Note: SBE Data Processing can process data for an instrument interfacing
with up to two Turner SCUFA sensors.

WET Labs AC3

This sensor requires two channels - one for fluorometer voltage (listed
under fluorometers in the dialog box) and the other for transmissometer
voltage (listed under transmissometers). Make sure to select both when
configuring the instrument.

Enter kv, Vh20, and A*X.

concentration (mg/m’) = kv * (Vout - Vh20) / A*X

where

Vout = measured output voltage

kv = absorption voltage scaling constant (inverse meters/volt)

Vh20 = measured voltage using pure water

A”X = chlorophyll specific absorption coefficient

WET Labs WetStar, ECO-AFL, and ECO-FL

Enter Vblank and scale factor.

Concentration (pg/l) = (Vsample - V blank) * scale factor

where

Vsample = in situ voltage output

Vblank = clean water blank voltage output

Scale factor = multiplier (ng/l/Volt)

The calibration sheet lists either:

» Vblank and scale factor, OR

» Vblank and Vcopro (voltage output measured with known
concentration of coproporphyrin tetramethyl ester). Determine an
initial value for the scale factor by using the chlorophyll concentration
corresponding to Vcopro:
scale factor = chlorophyll concentration / (Vcopro - Vblank)

Perform calibrations using seawater with phytoplankton populations that

are similar to what is expected in situ.

Note: SBE Data Processing can process data for an instrument interfacing

with up to two WET Labs WetStar sensors, and up to two ECO-AFL

(or ECO-FL) sensors.

WET Labs CDOM (colored dissolved organic matter)

Enter Vblank and scale factor.

Concentration (pg/l) = (Vsample - V blank) * scale factor

where

Vsample = in situ voltage output

Vblank = clean water blank voltage output

Scale factor = multiplier (ng/l/Volt)

The calibration sheet lists Vblank and Vedom (voltage output measured
with known concentration of colored dissolved organic matter). Determine
an initial value for the scale factor by using the colored dissolved organic
matter concentration corresponding to Vedom:

scale factor = cdom concentration / (Vedom - Vblank)

Perform calibrations using seawater with cdom types that are similar to
what is expected in situ.
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Methane Sensor Calibration Coefficients

The Capsum METS sensor requires two channels — one for the methane
concentration and the other for the temperature measured by the sensor. Make
sure to select both when configuring the instrument.

For the concentration channel, enter D, A0, A1, BO, B1, and B2.

Methane concentration

=exp {DIn[(BO+Blexp-Vt y*( 1 _ 1 I} [umol /1]
Where B2 Vm AO0-Al*Vt
Vt = Capsum METS temperature voltage
Vm = Capsum METS methane concentration voltage

For the temperature channel, enter T1 and T2.
Gas temperature = (Vt * T1) + T2 [°C]

OBS/Nephelometer Calibration Coefficients
In general, turbidity sensors are calibrated to a standard (formazin). However,

particle size, shape, refraction, etc. in seawater varies. These variations affect
the results unless field calibrations are performed on typical water samples.

e Downing & Associates [D&A] OBS-3

Note: Enter gain and offset.
See Application Note 16 for output = (volts * gain) + offset
complete description of calculation of where

OBS-3 calibration coefficients. gain = range/5; see calibration sheet for range

Note: SBE Data Processing can process data for an instrument interfacing
with up to two OBS-3 sensors.

e Downing & Associates [D & A] OBS-3+

Note: Enter AO, Al, and A2.
e See Application Note 81 for output = A0 + (Al * V) + (A2 * V?)
complete description of calculation where
of OBS-3+ calibration coefficients. V = voltage from sensor (MilliVolts)
* You can interface to two OBS-3+ A0, A1, and A2 = calibration coefficients from D & A calibration sheet

sensors, or to both the 1X and 4X
ranges on one OBS-3+ sensor,
providing two channels of
OBS-3+ data.

Note: SBE Data Processing can process data for an instrument interfacing
with up to two OBS-3+ sensors.

e Chelsea

Enter clear water value and scale factor.

turbidity [F.T.U.] = (10.0Y — C) / scale factor

where

V = voltage from sensor

See calibration sheet for C (clear water value) and scale factor.

e Dr. Haardt Turbidity

Enter AO, A1, B0, and B1. Select the gain range switch:

» Output Voltage Level if the instrument indicates gain by output voltage
level (< 2.5 volts is low gain, > 2.5 volts is high gain)
Low gain: value = A0 + (Al * V)
High gain: value =B0 + (B1 * V)

» Modulo Bit if the instrument has control lines custom-wired to bits in
the SBE 9plus modulo word
Bit not set: value = A0 + (Al * V)
Bit set: value =B0 + (B1 * V)

» None if the instrument does not change gain
value = A0 + (A1 * V)

where

V = voltage from sensor
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Note:

See Application Note 48 for complete
description of calculation of Seapoint
Turbidity calibration coefficients.

IFREMER
This sensor requires two channels - one for the direct voltage and the other
for the measured voltage. Make sure to select both when configuring the
instrument.

For the direct voltage channel, enter vm0, vd0, d0, and k.

diffusion = [k * (vm — vm0) / (vd — vd0)] — d0

where

k = scale factor

vm0 = measured voltage offset
vd0 = direct voltage offset

vm = measured voltage
vd = direct voltage
d0 = diffusion offset

Seapoint Turbidity

Enter gain setting and scale factor.

output = (volts * 500 * scale factor)/gain

where

Scale factor is from calibration sheet

Gain is dependent on cable used (see cable drawing)

Note: SBE Data Processing can process data for an instrument interfacing
with up to two Seapoint Turbidity sensors.

Seatech LS6000 and WET Labs LBSS

Enter gain setting, slope, and offset.

Output = [volts * (range / 5) * slope] + offset

where

Slope is from calibration sheet.

Range is based on sensor ordered (see calibration sheet) and cable-
dependent gain (see cable drawing to determine if low or high gain):

Range for High Gain Range for Low Gain
2.25 7.5
7.5 25
75 250
225 750
33 100

Notes:

e To enable entry of the mx, my,
and b coefficients for the
SCUFA fluorometer, you must
first select the Turner SCUFA
OBS/Nephelometer.

e See Application Note 63 for
complete description of calculation
of Turner SCUFA calibration
coefficients.

Note:

See Application Note 19 for complete
description of calculation of ORP
calibration coefficients.

Note: SBE Data Processing can process data for an instrument interfacing
with up to two Seatech LS6000 or WET Labs LBSS sensors.

Turner SCUFA

Enter scale factor and offset.

NTU = (scale factor * voltage) + offset

corrected chlorophyll = (mx * chlorophyll) + (my * NTU) + b

where

mx, my, and b = coefficients entered for Turner SCUFA fluorometer
chlorophyll = results from fluorometer channel in SCUFA (see Turner
SCUFA in fluorometer equations above)

Note: SBE Data Processing can process data for an instrument interfacing
with up to two Turner SCUFA sensors.

Oxidation Reduction Potential (ORP) Calibration Coefficients

Enter M, B, and offset (mV).
Oxidation reduction potential = [(M * voltage) + B] + offset
Enter M and B from calibration sheet.
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Notes:

e See Application Notes 13-1 and 13-3
for complete description of
calibration coefficients for Beckman-
or YSI-type sensors.

e See Application Notes 64 and 64-2
for complete description of SBE 43
calibration coefficients.

e The Tau correction ([tau(T,P) * 3V/at]
in the SBE 43 or [tau * doc/dt] in the
SBE 13 or 23) improves response of
the measured signal in regions of
large oxygen gradients. However,
this term also amplifies residual
noise in the signal (especially in
deep water), and in some situations
this negative consequence
overshadows the gains in signal
responsiveness. To perform this
correction, select Apply Tau
correction on Data Conversion’s or
Derive’s Miscellaneous tab.

e |f the Tau correction is enabled,
oxygen computed by Seasave and
Data Conversion differ from values
computed by Derive. Both
algorithms compute the derivative of
the oxygen signal with respect to
time, and require a user-input
window size:

» Quick estimate -
Seasave and Data Conversion
compute the derivative looking
back in time, because they share
common code and Seasave
cannot use future values while
acquiring real-time data.
» Most accurate results -
Derive uses a centered window
(equal number of points before
and after scan) to compute
the derivative.
In Data Conversion or Derive, the
window size is input on the
Miscellaneous tab.

¢ A hysteresis correction can be
applied in Data Conversion for the
SBE 43. To perform this correction,
select Apply hysteresis correction on
Data Conversion’s Miscellaneous
tab. H1, H2, and H3 coefficients for
hysteresis correction (entered in the
.con file) are available on calibration
sheets for SBE 43s calibrated after
October 2008.

Oxygen Calibration Coefficients

Enter the coefficients, which vary depending on the type of oxygen sensor,

from the calibration sheet:

e Beckman- or YSI-type sensor (manufactured by Sea-Bird or other
manufacturer) - These sensors require two channels - one for oxygen
current (enter m, b, soc, boc, tcor, pcor, tau, and wt) and the other for
oxygen temperature (enter k and c). Make sure to select both when
configuring the instrument.

Note: SBE Data Processing can process data for an instrument interfacing
with up to two Beckman- or Y SI-type oxygen sensors.

o |OW sensor - These sensors require two channels - one for oxygen current
(enter b0 and bl) and the other for oxygen temperature (enter a0, al, a2,
and a3). Make sure to select both when configuring the instrument.
Value =b0 + [bl * (a0 +al * T+ a2 * T>+a3 * T°) * C]
where T is oxygen temperature voltage, C is oxygen current voltage

e Sea-Bird sensor (SBE 43) - This sensor requires only one channel.

In Spring of 2008, Sea-Bird began using a new equation, the Sea-Bird
equation, for calibrating the SBE 43. Calibration sheets for SBE 43s
calibrated after this date will only include coefficients for the Sea-Bird
equation, but our software (Seasave-Win32, Seasave V7, and SBE Data
Processing) supports both equations. We recommend that you use the
Sea-Bird equation for best results.

Sea-Bird: Enter Soc, Voffset, A, B, C, E, Tau20, D1, D2, H1, H2, and H3.
OX =
Soc * [V + Voffset + tau(T,P) * §V/dt] * OxSOL(T,S) *
(1.0 + A*T + B*T* + C*T?) * ¢ ®P/0)
where
- OX = dissolved oxygen concentration (ml/l)
- T, P = measured temperature (°C) and pressure (decibars) from CTD
- S = calculated salinity from CTD (PSU)
- V = temperature-compensated oxygen signal (volts)
- Soc = linear scaling calibration coefficient
- Voffset = voltage at zero oxygen signal
- tau(T,P) = sensor time constant at temperature and pressure
- tau20 = sensor time constant tau(T,P) at 20 C, 1 atmosphere, 0 PSU,
slope term in calculation of tau(T,P)
- D1, D2 = calibration terms used in calculation of tau(T,P)
- 8V/8t = time derivative of oxygen signal (volts/sec)
- H1, H2, H3 = calibration terms used for hysteresis correction
- K = absolute temperature (Kelvin)
- Oxsol(T,S) = oxygen saturation (ml/l); a parameterization from Garcia

and Gordon (1992)

OR

Owens-Millard: Enter Soc, Boc, Voffset, tcor, pcor, and tau.

O[;S(OE* {(V+Voffset)+(tau* dV/dt)}+Boc*exp(-0.03T)]*exp(tcor* T+pcor*P)*Oxsat(T,S)
wnere

OX = dissolved oxygen concentration (ml/1)

T = measured temperature from CTD (°C)

P = measured pressure from CTD (decibars)

S = calculated salinity from CTD (PSU)

V = temperature-compensated oxygen signal (volts)
dV/dt = derivative of oxygen signal (volts/sec)
Oxsat(T,S) = oxygen saturation (ml/l)

Note: SBE Data Processing can process data for an instrument interfacing
with up to two SBE 43 oxygen sensors.
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Note:

See Application Notes 11 LICOR
(LI-COR sensor), 11 QSP-L
(Biospherical sensor with built-in
log amplifier), and 11-QSP-PD
(Biospherical sensor without
built-in log amplifier) for complete
description of calculation of
calibration coefficients.

Notes:
e Selection of Par / Irradiance,

Biospherical / Licor as the voltage

sensor is also applicable to the
Chelsea PAR sensor.

o For complete description of
calculation of calibration
coefficients for surface PAR,
see Application Note 11S
(SBE 11plus Deck Unit) or
47 (SBE 33 or 36 Deck Unit).

PAR/Irradiance Calibration Coefficients

Underwater PAR Sensor
Enter M, B, calibration constant, multiplier, and offset.
PAR = [multiplier * (10° * 10(V-B)/M) / calibration constant] + offset
where
Calibration constant, M, and B are dependent on sensor type:
e Biospherical PAR sensor
- PAR sensor with built-in log amplifier (QSP-200L, QSP-2300L,
QCP-2300L, or MCP-2300)]:
Typically, M = 1.0 and B = 0.0.
Calibration constant
=10 / wet calibration factor from Biospherical calibration sheet.
- PAR sensor without built-in log amplifier (QSP-200PD, QSP-2200 (PD),
or QCP 2200 (PD)):
M and B are taken from Sea-Bird calibration sheet.
Calibration constant
= Cg calibration coefficient from Sea-Bird calibration sheet
=10 ?/ calibration coefficient from Biospherical calibration sheet
e LI-COR PAR sensor
Calibration constant is LI-COR in water calibration constant.
Enter calibration constant, M, and B from calibration sheet.

e Chelsea PAR sensor
Calibration constant
=10°/0.01 (for units of microEinsteins/sec—m?) or
=109/0.04234 (for units of quanta/sec—m?)
M=1.0/(loge* Al * 1000) = 1.0/ (0.43429448 * A1 * 1000)
B=-M*loge* A0=-M *(0.43429448 * A0
where A0 and A1 are constants from Chelsea calibration sheet with an
equation of form: PAR = A0 + (Al * mV)
Multiplier can be used to scale output, and is typically set to 1.0.
Note: SBE Data Processing can process data for an instrument interfacing with
up to two PAR/irradiance sensors.

Biospherical Surface PAR Sensor

A surface PAR sensor is selected by clicking Surface PAR voltage added in the
Configure dialog box. Enter conversion factor and ratio multiplier.
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Notes:

e See Application Notes 18-1, 18-2,
and 18-4 for complete description
of calculation of pH calibration
coefficients.

e SEASOFT-DOS < version 4.008
ignored temperature compensation
of a pH electrode. The relationship
between the two methods is:
pH = pH old + (7 — 2087/°K)

For older sensors, run pHfit version
2.0 (in SEASOFT-DOS) using
Vout, pH, and temperature values
from the original calibration sheet
to compute the new values for
offset and slope.

pH Calibration Coefficients

Enter the slope and offset from the calibration sheet:
pH =7+ (Vout — offset) / (°K * 1.98416e-4 * slope)
where

°K = temperature in degrees Kelvin

Pressure/FGP (voltage output) Calibration Coefficients

Enter scale factor and offset.

output [Kpa] = (volts * scale factor) + offset

where:

scale factor = 100 * pressure sensor range [bar] / voltage range [volts]

Note: SBE Data Processing can process data for an instrument interfacing with
up to eight pressure/fgp sensors.

Suspended Sediment Calibration Coefficients

The Sequoia LISST-25 sensor requires two channels — one for scattering
output and the other for transmission output. Make sure to select both when
configuring the instrument.

For the scattering channel, enter Total volume concentration constant (Cal),
Sauter mean diameter calibration (o), Clean H,O scattering output (Vg), and
Clean H,O transmission output (V1) from the calibration sheet. For the
transmission channel, no additional coefficients are required; they are all
defined for the scattering channel.

Optical transmission =t = V1 / Vg

Beam C = -1n (1) /0.025 [1/ meters]

Total Volume Concentration =TV =Cal * [ (Vs/1)- Vg ] [uliters / liter]
Sauter Mean Diameter =SMD=a * [ TV/(-In(t)] [microns]

where

V1 = transmission channel voltage output

Vg = scattering channel voltage output

The calibration coefficients supplied by Sequoia are based on water containing
spherical particles. Perform calibrations using seawater with particle shapes
that are similar to what is expected in situ.
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Transmissometer Calibration Coefficients

Note: e Sea Tech, Chelsea (Alphatracka), and WET Labs Cstar

See Application Note 7 for Enter M, B, and path length (in meters)

complete description of Path length (distance between lenses) is based on sensor size
computation of M and B. (for example, 25 cm transmissometer = 0.25m path length, etc.).

light transmission (%) =M * volts + B

beam attenuation coefficient (c) = - (1/z) * In (light transmission [decimal])

where

M=(Tw/[W0-Y0])(A0O-Y0)/(Al-Y1)

B=-M*Yl

and

A0 = factory voltage output in air (factory calibration from transmissometer

manufacturer)

A1 = current (most recent) voltage output in air

YO0 = factory dark or zero (blocked path) voltage (factory calibration from

transmissometer manufacturer)

Y1 = current (most recent) dark or zero (blocked path) voltage

WO = factory voltage output in pure water (factory calibration from

transmissometer manufacturer)

Tw = % transmission in pure water

(for transmission relative to water, Tw = 100%; or

for transmission relative to air, Tw is defined by table below.

Tw = % Transmission in Pure Water
(relative to AIR)

Wavelength 10 cm Path Length 25 cm Path Length
488 nm (blue) 99.8% 99.6%
532 nm (green) 99.5% 98.8%

660 nm (red) 96.0 - 96.4% 90.2-91.3%

Transmissometer Example

(from calibration sheet) AO = 4.743 volts, YO = 0.002 volts,

W0 =4.565 volts

Tw = 100% (for transmission relative to water)

(from current calibration) A1 =4.719 volts and Y1 = 0.006 volts
M =22.046

B=-0.132

Note: SBE Data Processing can process data for an instrument interfacing
with up to two transmissometers in any combination of Sea Tech,
Chelsea Alphatracka, and WET Labs Cstar.

e WET Labs AC3
This sensor requires two channels - one for fluorometer voltage (listed
under fluorometers in the dialog box) and the other for transmissometer
voltage (listed under transmissometers). Make sure to select both when
configuring the instrument.
Enter Ch20, Vh20, VDark, and X from calibration sheet.
Beam attenuation = {[log (Vh2o - VDark) - log (V - VDark)] /X} + Ch2o0
Beam transmission (%) = exp ( -beam attenuation * X) * 100
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User Polynomial (for user-defined sensor)
Calibration Coefficients

The user polynomial allows you to define an equation to relate the sensor
output voltage to calculated engineering units, if your sensor is not pre-defined
in Sea-Bird software.

Enter a0, al, a2, and a3.

Val=a0 + (al * V) + (a2 * V2) + (a3 * V?)

where:

V = voltage from sensor

a0, al, a2, and a3 = user-defined sensor polynomial coefficients

If desired, enter the sensor name. This name will appear in the data file header.
Note: SBE Data Processing can process data for an instrument interfacing with
up to three sensors defined with user polynomials.

Wet Labs ECO-FL-NTU Example

For the turbidity channel, NTU = (Vsample — Vblank) * scale factor

Set this equal to user polynomial equation and calculate a0, al, a2, and a3.
(Vsample — Vblank) * scale factor = a0 + (al * V) + (a2 * V2) + (a3 * V?)
Expanding left side of equation and using consistent notation (Vsample = V):
scale factor * V — scale factor * Vblank = a0 + (al * V) + (a2 * V2) + (a3 * V?)
Left side of equation has no V2 or V3 terms, so a2 and a3 are 0; rearranging:

(— scale factor * Vblank) + (scale factor * V) = a0 + (al * V)

a0 = — scale factor * Vblank al = scale factor a2=a3=0

Zaps Calibration Coefficients

Enter M and B from calibration sheet.
z= (M * volts) + B [nmoles]
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Section 5;: Raw Data Conversion Modules

Module Name

Module Description

Data
Conversion

Convert raw data from CTD (.hex or .dat file) to
engineering units, storing the converted data in
.cnv file (all data) and/or .ros file (water bottle data).

Bottle
Summary

Summarize data from water sampler bottle .ros file,
storing the results in .btl file.

Mark Scan

Create .bsr bottle scan range file from .mrk data file.
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Data Conversion

Note:

Versions 5.30a and earlier of SBE
Data Processing used program setup
files with a .psu extension instead of a
.psa extension. Program setup files
with a .psa extension can be opened,
viewed, and modified in any text editor
or XML editor.

SBE Data Processing can still use
your existing .psu files. However, if you
make any changes to the setup (for
example, change output variables),
SBE Data Processing will save the
changes to a new .psa file.

Location to store all information
input in File Setup and Data
Setup tabs. Open to select
different .psa file, Save or
Save As to save current
settings, or Restore to reset

Data Conversion:

Converts raw data to engineering units from:

- a .dat file from an SBE 911plus, acquired with Seasave versions < 6.0 or
- .hex file from other CTDs (acquired with any version of Seasave) or
from an SBE 911plus (acquired with Seasave versions > 7.0).

Stores the converted data in a .cnv file and (optional) .ros file.

The File Setup tab in the dialog box looks like this:

Help

EE Data Conversion

File Options

File Setup I Data Setupl Miscellaneousl Header Viewl

all settings to match last saved

Frogram zetup file

e Select to have program find .con file
with same name and in same directory
as data file. For example, if processing
test.dat and this option is selected,
program searches for test.con
(in same directory as test.dat).

e Also select if more than 1 data file is to
be processed, and data files have
different con files. For example, if
processing test.dat and testl.dat, and
this option is selected, program
searches for test.con and testl.con (in
same directory as test.dat and

version. See note above. IS~
|K:\data'\Debbie\DatCnv.psa
Instrument configuration file Open... Save | Save s, I Fiestare I
location. Select to pick a
different .con file, or Modify
to view and/or modify Instrument configuration file
instrument configuration. I IK'\dala\Debbie\test — testl.dat).
See Section 4: Configuring : g /
Instrument (Configure). Select . b adify... | [atch instrument configuration bo input fil
Directory and file names for Iiput dirsctany
raw data (.hex or .dat). Select
to pick a different file. To |K:\datatDebhie
process multiple raw data files lemLi e ] eelaeiad
from same directory: N~ ‘
1. Click Select. test dat - Select.
2. In Select dialog box, hold I J _I
down Ctrl key while clicking :
on each desired file. Dutput directary
[K:\data\Debbie ,

Output file

MHame append

test. oy

Click Start Process to begin

Mat processing

processing data. Status field |
shows Processing complete
when done.

Directory and file names for converted output (.cnv) data.

If more than 1 data file is to be processed, Output file field
disappears and output file name is set to match input file
name. For example, if processing test.dat and testl.dat,
output files will be named test.cnv and testl.cnv.

SBE Data Processing adds Name append to (each) output
file name, before .cnv extension. For example, if processing
test.dat and testl.dat with a Name append of 06-20-00,
output files will be test06-20-00.cnv and test106-20-00.cnv.

étan Process

/ Exit
/

Cancel |

VA

Return to SBE Data Processing window.

o If Confirm Program Setup Change was selected in Options menu - If you made
changes and did not Save or Save As, program asks if you want to save changes.

« If Confirm Program Setup Change was not selected in Options menu - Button says
Save & Exit. If you do not want to save changes, use Cancel button to exit.
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The Data Setup tab in the dialog box looks like this:

o]

Program skips first scans to skip Fil=  Options  Help

over scans.

o If Process scans to end of file File Setup  Data Setup I Mizcelaneous I Header Visw |
selected: process alll e Binary - smaller file, processed faster than ASCII
remaining scans (upcast ¥ Process scans to end of file file by other SBE Data Processing modules.
and downcast scans if Upcast _ e ASCII - larger file, can be viewed with a text editor.
and downcast selected; Soans to skip over ID Translate can translate converted data file from

binary to ASCII or vice versa.

downcast scans only if —
downcast selected). Scans to process IlEIIZIu 1l

e If Process scans to end of file

Convert downcast data, or upcast and downcast data.
not selected: process next

Output format
scans to process. E ASCI output [T
Carvert data from ||_|pca$t and downcﬁj Create converted data file only,
. bottle file only (for subsequent
Lreate file ypes | Create bath data and bottle file I processing by Bottle Summary),
or both.
o Source of scan range data ; b |
Select to replace existing Scans marked with bottle confirm bit
header in input file with header - -
in .hdr file. Program looks for a Scan range offset [5] 0 Source of data for creating bottle file:
file with a matching name (but 5 AirsBang] * In same directory as input data file, with
.hdr extension) in same Con el Al DL 2 same file name - auto fire module or
directory as input file. \'_ Define scans from CTD ECO .afm file, bottle log .bl file, or bottle
. |data file to be included scan range .bsr file, or
M te header file |. ) . ' -
SI9E SEPASE REARETIE in bottle file. See Data e Scans marked with bottle confirm bit in
Select which variables to Conversion: Creating input data file
convert and output I~~~ Select Dutput Variables... I Water Bottle (.ros) See Data Conversion: Creating Water
(see dialog box below). Files below. Bottle (.ros) Files below.

Return to SBE Data Processing window.

o If Confirm Program Setup Change was selected in Options menu - If you made
changes and did not Save or Save As, program asks if you want to save changes.

« If Confirm Program Setup Change was not selected in Options menu - Button says
Save & Exit. If you do not want to save changes, use Cancel button to exit.

Begin processing data. Status
field on File Setup tab shows

; Start Process E it Cancel
Processing complete when done.

j/

The Select Output Variables dialog box (which appears when you click
Select Output Variables on the Data Setup tab) looks like this:

Select Dutput Yanables B
Seq. # Variable Mame [unit] |- I$ Average Sound YVelocity :-_j Shrink Al |

1 Pressure, Digiquartz [db] Battles Fired

2 Temperature [ T5-90, deq C] Lharge | Battorn Cantact Expand Al |
3 Canductivity [S/m] - Byte Courit

= Conductivity Shiink |
~8m
e mSdem Expand |

. uS/em
22 Cohductivity, 2
+- Conductivity Differerice, 2 -1

Dielete
e Add variable: click blank field in Variable Name column, click desired m,,é
variable in list, click Add. ||| et |
e Change variable: click existing variable in Variable Name column, | Dilet Al |
click desired variable in list, click Change. —
e Insert variable: click existing variable below desired sequence # in

L1

Variable Name column, click desired variable in list, click Insert.
If Data Conversion requires additional information to compute a variable,
a dialog box appears after variable is selected, with fields for required &

List includes all variables

Densit, )
: that can be converted from

Drengity Difference, 2- 1

r-input parameter — Diepth input data file or derived
eeTnpt paTomerers [ Descent Rate from variables in input
13| - data file.

=

|- Frequency Channel

Click Data to view/modify user-input parameters for selected variable (if || - . Modula Efror Count

applicable). Some variables share a user-input parameter, so changinga | |+| | i_'!_‘

parameter for one variable automatically changes it for the other:

o Depth and average sound velocity use same latitude (if NMEA data Carcel |
not available).

o Descent rate and acceleration use same time window size.

« All oxygen sensors use same time window size, Tau correction, and
(SBE 43 only) hysteresis correction.

Note: An alternate method of entering these parameters is on

Miscellaneous tab in Data Conversion dialog box.
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Note:

Values for these parameters can be
changed on the Miscellaneous tab
or by double clicking on the output
variable in the Select Output
Variables dialog box (above);
changes made in one location are
automatically made in the other
location.

The Miscellaneous tab in the Data Conversion dialog box looks like this:

EE R

File ©ptions Help
File Selupl Data Setup  Miscellansous | Header ‘\-"iewl

Thig tab configures mizcellansous data for calculations,
Mote: Walues entered only affect indicated calculations.

Depth and Average Sound Yelocity

Latitude when MMEA is not available ID

Average Sound Yelocity Flume dniomaly

Minimurn prezsure [db] Izg— Theta-B

Minimurm salinity [peu] Igg— S alinity-B

Prezzure window size [db] Izg— Theta~” / Salinity-=
Tirne window size [3] I'ED— Fieference pressune [dh]

Dezcent and Acceleration
Window size [2] |2

D=pgen

Windaw size [3] Iz

IV Apply Tau comection

11|

¥ Apply hysteresis comection ta SBE 43 when Sea-Bird equation selected in . con file

Potential Temperature Anomaly

A0 o A1 g AT Mulipler [sainy v
Set to Defaults |
Start Process | E xit I Cancel |

The Miscellaneous tab defines parameters required for output of specific
variables (depth, average sound velocity, descent rate, acceleration, oxygen,
plume anomaly, and potential temperature anomaly). Entries on this tab are
used only if you are calculating and outputting the associated variable to the
.cnv file. For example, if you do not select Oxygen in the Select Output
Variables dialog box, Data Conversion ignores the value entered for Oxygen
window size and the enabling of hysteresis and Tau corrections on the
Miscellaneous tab.
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Notes:

e You may have more than one
source of scan range data
available. For example, if Seasave
is used with an SBE 911plus and
SBE 32 Carousel Water Sampler,
a bottle log (.bl) file is created.
Additionally, if you used the Mark
Scan feature in Seasave, a .mrk
file is created.

e You can create a .bsr file in a text
editor if scan range data is not
available in any of these forms.

Data Conversion: Creating Water Bottle (.ros) Files

A .ros water bottle file contains:
e data for each scan associated with a bottle firing, and
e data for user-selected range of scans before and after each bottle firing

Scan range data for creation of a water bottle file can come from:

e Scans marked with bottle confirm bit in input data file - if used
- SBE 9plus with an SBE 11plus Deck Unit and G.O. 1015 Rosette, or
- SBE 9plus with an SBE 17plus SEARAM and SBE 32 Carousel
Water Sampler.

For these systems, the bottle confirm bit in the input (.hex or .dat) data file
is set for all scans within a 1.5-second duration after a bottle firing
confirmation is received from the water sampler.

e Bottle log (.bl) file - if used Seasave to interface with
- SBE 9plus with SBE 11plus Deck Unit and G.O. 1016 Rosette or
SBE 32 Carousel Water Sampler, or
- SBE 19, 19plus, 19plus V2, 25, or 49 with SBE 33 Deck Unit and
SBE 32 Carousel Water Sampler, or
- SBE 19, 19plus, 19plus V2, 25, or 49 with SBE 33 Deck Unit and SBE
55 ECO Water Sampler.

For these systems, Seasave creates the .bl file. Each time a bottle fire
confirmation is received, the bottle sequence number, position, date, time,
and beginning and ending scan numbers (1.5-second duration for each
bottle) are written to the .bl file.

e Auto Fire Module or ECO (.afm) file - if used
- Carousel Auto Fire Module (AFM) with SBE 19, 19plus, 19plus V2,
25, or 50 and SBE 32 Carousel Water Sampler, or
- SBE 19, 19plus, 19plus V2, 25, or 50 and SBE 55 ECO Water Sampler
(autonomous operation).

For these systems, the .afm file contains five scans of data recorded by the
AFM or SBE 55 ECO Water Sampler for each bottle firing.

e Bottle scan range (.bsr) file - if used Mark Scan feature in Seasave during
data acquisition to create a .mrk file; use Mark Scan to convert the .mrk
file to a .bsr file before running Data Conversion. The format for the .bsr
file is:
beginning scan # for bottle #1, ending scan # for bottle #1

beginning scan # for last bottle, ending scan # for last bottle
Example: test.bsr contains -
1000, 1020
2000, 2020
4000, 4020
The .ros file created using test.bsr would contain scans 1000 - 1020 for
bottle #1, 2000 - 2020 for bottle #2, and 4000 - 4020 for bottle #3.

The amount of data written to the .ros file is based on:

e Scan range offset - determines the first scan output to the .ros file for
each bottle, relative to the first scan with a confirmation bit set or written
to a .afm, .bsr, or .bl file.

e Scan range duration - determines the number of scans output to the .ros
file for each bottle.

Example: A bottle confirmation for an SBE 911plus is received at scan 10,000
(scan 10,000 and subsequent scans for 1.5 seconds have confirmation bit set).
In Data Conversion, Scan range offset is set to -2 seconds, and Scan range
duration is set to 5 seconds. If the scan rate is 24 scans/second,

10,000 - 2 second offset (24 scans/second) = 9,952

9,952 + 5 second duration (24 scans/second) = 10,072

Therefore, scans 9,952 through 10,072 will be written to the .ros file.
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Note:

If you choose to compute derived
parameters in Data Conversion,
note that the algorithms are the
same as used in Derive (with the
exception of the oxygen, descent
rate, and acceleration calculations);
see Appendix V: Derived
Parameter Formulas for
algorithms for derived variables.

Data Conversion: Notes and General Information

Data Conversion was written to accommodate most sensors that have been
installed on Sea-Bird products. See the configuration page at the beginning of
your instrument manual for the sensors that were installed on your system.

e Ifyou plan to process the data with other modules, select only the primary
variables to be converted, and then use Derive to compute derived
parameters such as salinity, density, sound velocity, and oxygen.

e Ifdesired, you can select the same variable multiple times for the output
.cnv file. If you do, data processing operations on that variable in other
modules will use the last occurrence of the variable in the file.

Example: Select Primary Conductivity, Primary Temperature, Pressure,
and Primary Conductivity (again) for output variables (columns 1, 2, 3,
and 4 respectively). Then, if you run Cell Thermal Mass, it will correct the
conductivity in column 4 only, leaving column 1 uncorrected; you could
plot the corrected and uncorrected conductivity to see the changes. If you
then run Derive to calculate salinity, it will use the corrected conductivity
in column 4 in the salinity calculation.

e If you will use Derive to compute:

» Salinity, density, or other parameters that depend on salinity -
include pressure, temperature, and conductivity in the output file.
For a moored instrument without optional pressure sensor (SBE 16,
16plus, 16plus-IM, 16plus V2, or 16plus-IM V2), if you select
pressure as an output variable, Data Conversion inserts a column with
the moored pressure (entered in the .con file Data dialog) in the
output .cnv file. For a thermosalinograph (SBE 21 or 45), if you
select pressure as an output variable, Data Conversion inserts a
column of 0’s for the pressure in the output .cnv file. The pressure
column is needed for Derive to calculate salinity, density, etc.

» Oxygen - include in the output file (along with pressure, temperature,
and conductivity)
For SBE 13 or 23 - oxygen current and oxygen temperature
For SBE 43 - oxygen value

e If you will use Bin Average:
»  With depth bins - include depth in the output file
»  With pressure bins - include pressure in the output file

e  Pressure temperature is computed using a backward-looking, 30-second
running average, to prevent bit transitions in pressure temperature from
causing small jumps in computed pressure. Because the heavily insulated
pressure sensor has a thermal time constant on the order of one hour,
the 30-second average does not significantly alter the computed
pressure temperature.

e Oxygen, descent rate, and acceleration computed by Seasave and Data
Conversion are somewhat different from values computed by Derive,
because the algorithms calculate the derivative of the signal (oxygen
signal for oxygen, pressure signal for descent rate and acceleration) with
respect to time, using a linear regression to determine the slope. Seasave
and Data Conversion compute the derivative looking backward in time,
since they share common code and Seasave cannot use future values while
acquiring data in real time. Derive uses a centered window (equal number
of points before and after the scan; time window size is user input) to
obtain a better estimate of the derivative. Use Seasave and Data
Conversion to obtain a quick look at oxygen, descent rate, and
acceleration; use Derive to obtain the most accurate values.

e Foran SBE 21 or 45 with a remote temperature sensor, Seasave,
Data Conversion, and Derive all use the remote temperature data when
calculating density and sound velocity.
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Note:

Each SBE Data Processing
module that modifies a .cnv file
adds information to the header
and updates nquan, nvalues,
name n, span n, interval, and
file_type, as applicable.

Data Conversion has the following /x parameters when run from the
Command Line Options dialog box, from the command line, or with batch file

processing:

/x Parameter

Description

/xdatenv:skipN

N = number of scans to skip.

/xdatenv:pump

For SBE 911plus, do not output scans if
pump status = off.

/xdatcnv:nomatch

Disable matching of header information to .con file -
program will continue to run even if there is a
discrepancy in header information.

See Appendix I: Command Line Options, Command Line Operation, and Batch File Processing
for details on using parameters.

Data Conversion adds the following to the data file header for a
.cnv converted data file:

Label Description
Number of columns (fields) of converted data.
Note: Data Conversion automatically adds 1 field to number
Nquan selected by user (i.e., if user selects 3 variables to convert,
then nquan=4). This added field, initially set to 0, is used by
Loop Edit to mark bad scans.
Nvalues Number of scans converted.
. Specified (indicates units are specified separately for
Units .
each variable).
Name n Sensor (and units) associated with data in column n.
Span n Span (highest - lowest value) of data in column n.
Interval Scan rate (seconds).
Start time Data start time.
Bad flag F or information only; value that Loop Edit and Wild
- Edit will use to mark bad scans and bad data values.
Sensor n Sensor description, serial number, and calibration date.
Datcnv_date Date and time that module was run.
Datcnv_in Input .hex (or .dat) and .con files.
Datcnv_skipover | Number of scans to skip over in processing.
File type Selected output file type - ASCII or binary.

Data Conversion adds the following to the data file header for a

.ros water bottle file:

Label Description
Number of columns (fields) of converted data.
Note: Data Conversion automatically adds 1 field to number
Nquan selected by user (i.e., if user selects 3 variables to convert,
then nquan=4). This added field, initially set to 0, is used by
Loop Edit to mark bad scans.
Nvalues Number of scans converted.
. Specified (indicates units are specified separately for
Units .
each variable).
Name n Sensor (and units) associated with data in column n.
Interval Scan rate (seconds).
Start time Data start time.
Sensor n Sensor description, serial number, and calibration date.
Datcnv_date Date and time that module was run.
Datcnv in Input .hex (or .dat) and .con files.
Datcnv_bottle Source of data for creating bottle file, and scan range
scan_range source | offset and duration.
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Bottle Summary

Note:

Bottle Summary was
previously called
Rosette Summary.

Note:
You can create a .sn file in a
text editor.

Bottle Summary reads a .ros file created by Data Conversion and writes a
bottle data summary to a .btl file. The .ros file must contain (as a minimum)
temperature, pressure, and conductivity (or salinity).

The output .btl file includes:

e Bottle position, optional bottle serial number, and date/time

e  User-selected derived variables - computed for each bottle from mean
values of input variables (temperature, pressure, conductivity, etc.)

e  User-selected averaged variables - computed for each bottle from
input variables

The maximum number of scans processed per bottle is 1440.
In addition to the .ros input file:

e Ifa bl file created by Seasave (same name as input data file, with .bl
extension) is found in the input file directory, Bottle Summary uses bottle
position data from the .bl file. The bottle position data defines the bottle
firing sequence - the .bl file contains the bottle firing sequence number,
bottle position, date and time, and beginning and ending scan number for
each bottle.

e Ifa .sn file (same name as input data file, with .sn extension) is found in
the input file directory, bottle serial numbers are inserted between the
bottle position and date/time columns in the .btl file output. The format
for the .sn file is:

Bottle position, serial number (with a comma separating the two fields)
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Note:

The File Setup tab and
Header View tab are similar
for all modules; see Section 2:
Installation and Use.

The Data Setup tab in the dialog

Z% Bottle Summary
File Options Help

File Setup  Data Setup I Header 'V'iewl

box looks like this:
] =10 x|

¥ Output mindmas values for averaged variables

Select Averaged Variable&...>

SE\Iect Denved Yanables... |

Select input variables to be averaged. Mean and

standard deviation will be calculated and output for

each bottle.

o [|f Output min/max values for averaged variables
is selected, minimum and maximum values will
also be output for each bottle.

etc.) for each bottle.

Select variables to derive from input data. Derived variables are computed
from mean values of input variables (temperature, conductivity, pressure,

e Oxygen can be derived if oxygen data (oxygen current and temperature
for SBE 13 or 23; oxygen signal for SBE 43) is in the .ros file.
Bottle Summary calculates the derivative of the oxygen current (or
signal), using a least squares fit to all the oxygen data for each bottle.
Oxygen is calculated using the mean values for temperature, pressure,
and salinity, the derivative, and the scan-by-scan values of oxygen
current and temperature (or signal).

Return to SBE Data Processing window.

o |f Confirm Program Setup Change was selected in Options menu - If you made
changes and did not Save or Save As, program asks if you want to save changes.

« [If Confirm Program Setup Change was not selected in Options menu - Button says
Save & Exit. If you do not want to save changes, use Cancel button to exit.

Begin processing data. Status field
on File Setup tab shows
Processing complete when done.

\ |

\Start Process |

Exit I Cancel |

Bottle Summary adds the following to the data file header:

Label*

Description

Bottlesum date | Date and time that module was run.

Bottlesum in | Input .ros and .con files.

*Labels were previously rossum_date and rossum_in.
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Mark Scan

Note:

Alternatively, an ASCII text editor can
be used to create the .bsr file. The
format for the output .bsr file is:

Beginning scan for bottle 1, ending scan for
bottle 1
Beginning scan for bottle 2, ending scan for
bottle 2

Beginning scan for last bottle, ending scan
for last bottle

Note that a comma must separate the
beginning and ending scan numbers.

Note:

The File Setup tab is similar
for all modules; see Section 2:
Installation and Use.

Mark Scan creates a bottle scan range (.bsr) file from a .mrk data file created
in Seasave. The data in the .bsr file can be used by Data Conversion to create a
.ros file, and the .ros file can be used by Bottle Summary to create a bottle data
summary .btl file.

The input .mrk file contains one scan with the mark number, system time,
and scan number for each time Mark Scan was clicked while in Seasave’s
Mark Scan Control dialog box (accessed by selecting Mark Scan Control in
Seasave’s Real-Time Control menu). Mark Scan’s output .bsr file points to a
user-defined range of adjacent scans for each marked scan. Note that the
output .bsr file only contains the pointers to the scans, and does not contain
the data.

The Data Setup tab in the dialog box looks like this:

EE Mark Scan

Fle. Optiors  Hely

= 10] x|

FileSetyp Dlata Sehup I
|

iE > Define the range of scans around each scan in
i1 0

[ffset [soafi]

the .mrk file to include in the .bsr file.

o offset - number of scans before or after scan
in .bsr file for starter pointer

e duration - number of scans to include in .bsr
file for each scan in .mrk file

Example: Offset is -5 scans and duration is

10 scans. If .mrk file contains scans 16 and

128, .bsr file will look like this:

11, 21 (16-5=11; 11+10=21)

123, 133 (128-5=123; 123+10=133)

Diuration [scans]

Return to SBE Data Processing window.
o If Confirm Program Setup Change was selected in Options menu - If you made

o |f Confirm Program Setup Change was not selected in Options menu - Button says

changes and did not Save or Save As, program asks if you want to save changes.

Save & Exit. If you do not want to save changes, use Cancel button to exit.

Begin processing data. Status field
on File Setup tab shows
Processing complete when done.

\ |
Start F'rut:essl Esit I Cancel I

Mark Scan’s output .bsr file does not have a header.
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Section 6: Data Processing Modules

All data processing is performed on converted data from a .cnv file.

Module Name Module Description
Align CTD Align de}tg relative to pressure (typically used for
conductivity, temperature, and oxygen).
Bin Average Average datg, basing bins on pressure, depth, scan
number, or time range.
BUOvaNC Compute Brunt Viisdld buoyancy and
yancy stability frequency.
Celllgﬂrggsrmal Perform conductivity thermal mass correction.
Derive Calculate salinity, density, sound velocity, oxygen,

potential temperature, dynamic height, etc.

Filter Low-pass filter columns of data.

Mark a scan with badflag if scan fails pressure reversal or

Loop Edit - .
minimum velocity tests.
Wild Edit Mark a data value with badflag to eliminate wild points.
Window Filter data with triangle, cosine, boxcar, Gaussian, or
Filter median window.
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Align CTD

Note:

Align CTD cannot be run on files that
have been averaged into pressure or
depth bins in Bin Average. If
alignment is necessary, run Align
CTD before running Bin Average.

Pressure

Aligned relative
to pressure

Downcast

Upcast and Downcast mismatch with
Respect to Pressure

Note:

Installation

The File Setup tab and
Header View tab are similar
for all modules; see Section 2:

and Use.

Align CTD aligns parameter data in time, relative to pressure. This ensures
that calculations of salinity, dissolved oxygen concentration, and other
parameters are made using measurements from the same parcel of water.
Typically, Align CTD is used to align temperature, conductivity, and oxygen
measurements relative to pressure.

There are three principal causes of misalignment of CTD measurements:

physical misalignment of the sensors in depth

inherent time delay (time constants) of the sensor responses

water transit time delay in the pumped plumbing line - the time it takes
the parcel of water to go through the plumbing to each sensor (or, for free-
flushing sensors, the corresponding flushing delay, which depends on
profiling speed)

When measurements are properly aligned, salinity spiking (and density) errors
are minimized, and oxygen data corresponds to the proper pressure (e.g.,
temperature vs. oxygen plots agree between down and up profiles).

The Data Setup tab in the dialog box looks like this:

'
&5 Align CTD = (O] =]

Eile. Options - Help

Fie Setup DataSetup | HeaderView |

Define alignment times for all data.

Return to SBE Data Processing window.

o If Confirm Program Setup Change was selected in Options menu - If you made
changes and did not Save or Save As, program asks if you want to save changes.

o |f Confirm Program Setup Change was not selected in Options menu - Button says
Save & Exit. If you do not want to save changes, use Cancel button to exit.

Begin processing data. Status field
on File Setup tab shows
Processing complete when done.

\

i |

\Stai"’t Process |

Eanbgl

+ Advance
<+—

The Enter Advance Values dialog box looks like this:

Enter Advance Yalues

7|
Define alignment times.
Diagram shows sign

Yariable Name unit] Advance [zec)

- Advance

' Temperature [ITS-80. deg 5|

convention for Advance. If

(delay) —»

Conductivity [S/m]

0 seconds is entered,

»

‘Dipgen Curient, Beckman/v5] [u4]

alignment relative to

Time =

Dioen Temperatire, Be_:_c;{(ﬂahf? Sl {den ]
Oyt BeckmanAS! [mid]

pressure (and time) remains
unchanged for that variable.

oo S| o o

See discussion below to

determine appropriate
alignment times for
conductivity, temperature,

ok | Caneel

and oxygen.
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Odb

Pressure

Align CTD: Conductivity and Temperature

Temperature and conductivity are often misaligned with respect to pressure.

Shifting temperature and conductivity relative to pressure can compensate.

As shown in the figures, indications of misalignment include:

e  Depth mismatch between downcast and upcast data

e  Spikes in the calculated salinity (which is dependent on temperature,
conductivity, and pressure) - caused by misalignment of temperature and
conductivity with each other

The best diagnostic of proper alignment is the elimination of salinity spikes
that coincide with very sharp temperature steps. To determine the best
alignment, plot 10 meters of temperature and salinity data at a depth that
contains a very sharp temperature step. For the downcast, when temperature
and salinity decrease with increasing pressure:

e A negative salinity spike at the conductivity step means that conductivity
leads temperature (conductivity sensor Sees step before temperature sensor
does). Advance conductivity relative to temperature a negative number
of seconds.

o Conversely, if the salinity spike is positive, advance conductivity relative
to temperature a positive number of seconds.

7+ Odbp T T 0dbpr—"""—
E : I : ] I E :

Negative : I ; I

2 /spike ! E Positive I E No

E e : spike I i

g : p \ J Spifel

L I of e s ol

E : | 5t : | Sk :

3 e | 13 Ey—y | 7S P,

E : Salinity T C | ol : Salinity T C I o : Salinity

E [ ok : ar

o ! g ! g

Downcast, Conductivity leads Temperature Downcast, Conductivity lags Temperature Downcast, C and T Aligned

The best alignment of conductivity with respect to temperature is obtained
when the salinity spikes are minimized. Some experimentation with different
advances is required to find the best alignment.

Typical Temperature Alignment
The SBE 19, 19plus, and 19plus V2 use a temperature sensor with a relatively

slow time response, while the SBE 9plus, 25, and 49 use a temperature sensor
with a faster time response. Typical advances are:

Instrument Advance of Temperature Relative to Pressure (seconds)
9plus 0
19, 19plus, or
19plus V2 0.5
25 0
49 * +0.0625

*The SBE 49 can be programmed to advance temperature relative to pressure
in real-time, eliminating the need to run Align CTD. See the SBE 49 manual
for details.
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Note: Typical Conductivity Alignment

ngilifelsr?;r;?}f ggﬁguucr::slsit;:,a\r/]vhich e SBE 9pl.us. - For an SBE 9plus with TC-ducted temperature and .
may eliminate the need to use Align conductivity sensors and a 3000-rpm pump, the typical lag of conductivity
CTD for conductivity. The SBE 11plus relative to temperature is 0.073 seconds. The Deck Unit can be

does not advance secondary programmed to advance conductivity relative to pressure, eliminating the
conductivity. The SBE 11plus V2 can need to run Align CTD.

advance secondary conductivity and Following is an example of determining the value to enter in Align CTD:
all voltage channels; the advance time Example: The SBE 11plus is factory-set to advance the primary

Is user-programmable. conductivity +1.75 scans (at 24 Hz, this is 1.75 /24 = 0.073 seconds).

Advance conductivity relative to temperature in Align CTD:

0.073 - 1.75/24 = 0.0 seconds  (enter 0 seconds for conductivity).
Advance C relative to T +0.073 seconds
(use SBE 11 series deck unit and/or ALIGN CTD) .
e e SBE 19plus or 19plus V2 — For an SBE 19plus or 19plus V2 with a

o/ standard 2000-rpm pump, do not advance conductivity.

/| e SBE 19 (not plus) — For an unpumped SBE 19, the conductivity

— ClagsTby —» Tima measurement may lead or lag that of temperature, because the flushing
SGEaTnaE rate of the conductivity cell depends on drop speed. If the SBE 19 is

lowered very slowly (< 20 cm/second, typically from a fixed platform or
ice), conductivity lags temperature. If the SBE 19 is lowered fast,
conductivity leads temperature. Typical advances of conductivity relative
to temperature range from 0 seconds at a lowering rate of
0.75 meters/second to -0.6 seconds for 2 meters/second (if temperature
was advanced +0.5 seconds, these correspond to conductivity advances of
+0.5 seconds and -0.1 seconds respectively).

e SBE 25 - For an SBE 25 with a standard 2000-rpm pump, a typical
advance of conductivity relative to temperature is +0.1 seconds.

e SBE 49 — For a typical SBE 49 with TC duct and 3000 rpm pump, do not
advance conductivity.

If temperature is advanced relative to pressure and you do not want to
change the relative timing of temperature and conductivity, you must add
the same advance to conductivity.

Example (typical of an unpumped SBE 19):

Advance temperature relative to pressure +0.5 seconds to compensate for slow

response time of sensor.

e Ifthe CTD is lowered at 0.75 m/s, advance conductivity relative to
temperature 0 seconds. Calculate advance of conductivity relative to
pressure to enter in Align CTD: +0.5 + 0 =+0.5 seconds

e Ifthe CTD is lowered at 2 m/s, advance conductivity relative to
temperature -0.6 seconds. Calculate advance of conductivity relative to
pressure to enter in Align CTD: +0.5 + (-0.6) = -0.1 seconds
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Align CTD: Oxygen

Oxygen data is also systematically delayed with respect to pressure. The two
primary causes are the long time constant of the oxygen sensor (for the

SBE 43, ranging from 2 seconds at 25 °C to approximately 5 seconds at 0 °C)
and an additional delay from the transit time of water in the pumped plumbing
line. As with temperature and conductivity, you can compensate for this delay
by shifting oxygen data relative to pressure. Typical advances for the SBE 43,
13, or 23 are:

Instrument Advance of Oxygen Relative to Pressure (seconds)
9plus +2 to +5
19plus or
19plus V2 o]
19 (not plus) +3 to +7 (pumped), +1 to +5 (unpumped)
25 +3 to +7

Align CTD adds the following to the data file header:

Label Description

Alignctd date | Date and time that module was run.

Alignctd in Input .cnv file.

Alignetd adv | Variables aligned and their respective alignment times.

74



Section 6: Data Processing Modules

Bin Average

Note: Bin Average averages data, using averaging intervals based on:
Align CTD, which aligns parameter

data in time, relative to pressure, e  pressure range,

cannot be run on files that have been

averaged into pressure or depth bins e depth range

in Bin Average. If alignment is
necessary, run Align CTD before

. . [ ]
running Bin Average. scan number range, or

e  time range

Note: The Data Setup tab in the dialog box looks like this:

The File Setup tab and Header View

tab are similar for all modules; see EE Bin Average Ei=l B2

; . ; ; T Average by:
Section 2: Installation and Use. Eile' Options  Help . pregsurg (with or without interpolation)

o depth (with or without interpolation)
e scan number
Hittion e time (seconds or hqurs) _ o
P IPTESSUFE If pressure (or depth) is not included in input

If selected, a column containing number of file, it will not appear on list of bin types.
scans in each bin will be added to output data. B size I

Bin size is range of data for each bin (i.e.,
pressure range, scan nhumber range, etc.).

File Getup  Data Setup | Header View i

I¢relade number of scars per bin

If selected, data from scans marked with
badflag in Loop Edit will not be used in \ﬁ ‘Ewchide stan: maked bad
calculating average. Note that values marked ' Skip first n scans of data before
with badflag by Wild Edit are never included - . beginning processing.
in calculating average. 5oang ko skip over iD 1
Cast to process iUpcast and downcast %) IProcess downcast, upcast, or both.

If selected, include surface bin (applicable only if |—f rclide surtans bir
averaging by pressure or depth). Input: Rt
e minimum and maximum values - minimum and | Syfage bin minimumn valie iD

maximum (pressure or depth, as applicable) to e o

be used in calculating surface bin Sirtace bin madimum valie iD
o value - target value (pressure or depth) to be )
associated with averages Surtace bin valus ID
Note that surface bin minimum, maximum,
and value do not affect minimum, maximum,
and center of first or subsequent bins.

Begin processing data. Status field

on File Setup tab shows N Start Process | Eit  / I Cancel
Processing complete when done. v ;
/

Return to SBE Data Processing window.

o If Confirm Program Setup Change was selected in Options menu - If you made
changes and did not Save or Save As, program asks if you want to save changes.

« If Confirm Program Setup Change was not selected in Options menu - Button says
Save & Exit. If you do not want to save changes, use Cancel button to exit.
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Bin Average: Formulas

Note: . The center value of the first (not surface) bin is set equal to the bin size.
If Exclude scans marked bad is

selected in the dialog box, data from ; ; ; .
scans marked with badflag in Loop Example (pressure bin, surface bin not included):

Edit are not used in calculating Bin size is 10 db. The first bin is defined as follows:

average. Values marked with badflag surface = 0 db
by Wild Edit are never included in
calculating the average. If the
number of points included in the
average is O (all data and/or scans in A
the bin are marked with badflag), the
average value is set to badflag.

Minimum first bin = BinMin =
bin size - (bin size/2) =5 db

First bin Center (target) first bin =
Bin size=10 db bin size=10 db
A 4 Maximum first bin = BinMax =

bin size + (bin size/2) = 15 db

Example (pressure bin, surface bin included):
Bin size is 10 db. Surface bin is included, and surface bin parameters are 0 db
minimum, 3 db maximum, and 0 db value. The bins are defined as follows:

minimum surface bin = 0 db
target surface bin = 0 db

M Surface bin
v Binsize=3 db maximum surface bin = 3 db

A Minimum first bin = BinMin =
bin size - (bin size/2) =5 db

First bin Center (target) first bin =
Bin size=10 db bin size=10 db
h 4 Maximum first bin = BinMax =

bin size + (bin size/2) = 15 db

The algorithms used for each type of averaging follow.

Pressure Bins (no interpolation)

For each bin:

BinMin = center value - (bin size / 2)
BinMax = center value + (bin size / 2)

1. Add together valid data for scans with BinMin < pressure < BinMax.
Divide the sum by the number of valid data points to obtain the average,
and write the average to the output file.

Repeat Steps 1 through 2 for each variable.

4. For the next bin, compute the center value and repeat Steps 1 through 3.

W
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Pressure Bins (with interpolation)
For each bin:
BinMin = center value - (bin size / 2)
BinMax = center value + (bin size / 2)
1. Add together valid data for scans with BinMin < pressure < BinMax.
2. Divide the sum by the number of valid data points to obtain the average.
3. Interpolate as follows, and write the interpolated value to the output file:
P, =average pressure of previous bin
X, =average value of variable in previous bin
P, =average pressure of current bin
X, =average value of variable in current bin
P; = center value for pressure in current bin
X, =interpolated value of variable (value at center pressure P;)
=((Xe-Xp) * (Pi-Py) /(P - Py) ) + X,
4. Repeat Steps 1 through 3 for each variable.
5. Compute the center value and Repeat Steps 1 through 4 for the next bin.
Values for the first bin are interpolated after averages for the second bin are
calculated; values from the next (second) bin instead of the previous bin are
used in the equations.

Depth Bins (with or without interpolation)
Depth bin processing is similar to processing pressure bins, but bin size and
center values are based on depth.

Scan Number Bins

Scan number bin processing is similar to processing pressure bins without
interpolation. If exclude scans marked bad is selected, Bin Average averages
bin size good scans (not marked with badflag in Loop Edit).

Example: Bin size is 100. First bin should include scans 50 - 149. However,
scans 93, 94, and 126 are marked with badflag in Loop Edit, and the user
selected exclude scans marked bad. To include 100 valid scans in the average,
Bin Average includes scans 50 - 152 in the first bin.

Time Bins
Time bin processing is similar to processing pressure bins without
interpolation. Bin Average determines the number of scans to include based on
the input bin size and the data sampling interval:

Number of scans = bin size [seconds] / interval or

Number of scans = (bin size [hours] x 3600 seconds/hour) / interval

Bin Average has the following /x parameter when run from the Command Line
Options dialog box, from the command line, or with batch file processing:

/x Parameter Description

/xbinavg:cN N = center value for first bin.

See Appendix I: Command Line Options, Command Line Operation, and Batch File Processing
for details on using parameters.

Bin Average adds the following to the data file header:

Label Description
Binavg date Date and time that module was run.
Binavg in Input .cnv file.

Binavg bintype | Bin type (pressure, depth, scan time in seconds or hours).

Binavg binsize | Bin size.

Binavg _excl | Ifyes, values from scans marked with badflag in Loop
bad scans Edit are not included in average.

Binavg skipover | Number of scans skipped over.

Binavg_surface | Surface bin included? Minimum and maximum values
bin for surface bin.
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Buoyancy

Note:

The input .cnv file for Buoyancy must
have been processed with Bin
Average on pressure bins (with or
without interpolation) and must
contain pressure, temperature, and
either salinity or conductivity.

Note:

The File Setup tab and
Header View tab are similar
for all modules; see Section 2:
Installation and Use.

Select buoyancy
variables to be
computed and added
to.cnvfile-1, 2,3,
or 4 variables can be
computed.

Eile: Options  Help

File Setup Data Setup | Header View

Bualiancy Variahle

Latitade

Girewity [rnd's"2]

Buoyancy calculates buoyancy (Brunt-Viisild) frequency (N) and stability (E)
using the Fofonoff adiabatic leveling method (Bray N. A. and N. P. Fofonoff
(1981) Available potential energy for MODE eddies. Journal of Physical
Oceanography, 11, 30-46.).

The Data Setup tab in the dialog box looks like this:

EZ Buoyancy Bi=l

Select variable used in buoyancy computation:

Latitude - Buoyancy uses algorithm in
UNESCO Technical Papers in Marine Science 44
to estimate local gravity from user-input latitude

Gravity

Calculate buoyancy variables for pressure values
centered in window. Buoyancy converts window
size from decibars to scans based on pressure

Wwindow sz [db] I1I:I \ interval between scans in input file. If window size

[~ Stability. E {rad"2#m]

I Stabiliy. £ [10°8 1ad"24m]

Buoyancy frequency [N°2, rad"24°2]
Buotrancy frequency (N, cuclesdhour]

is less than 3 scans, Buoyancy sets it to 3 scans.
If window size is an even number of scans,
Buoyancy adds 1 scan to window size. (see
example below)

Note: As used here, a scan is one row of output
data from Bin Average, which is an average of
many scans of original data.

Return to SBE Data Processing window.

« If Confirm Program Setup Change was selected in Options menu - If you made
changes and did not Save or Save As, program asks if you want to save changes.

o |f Confirm Program Setup Change was not selected in Options menu - Button says
Save & Exit. If you do not want to save changes, use Cancel button to exit.

Begin processing data. Status field
on File Setup tab shows
Processing complete when done.

N\ |

Start Process

Save & Exil I Canoel |

Example: For an interval of 10 db between scans, buoyancy window sizes of
5, 10, or 20 db result in a window size of 3 scans. Window sizes of
30 or 40 db result in a window size of 5 scans.

10db 20db 30db 40 db 50 db
< 5 db window = 3 scan minimum >
< 10 db window = 3 scan minimum >
<20 db window = 3 scans (10, 20, 30 db)>
N 30 db window = 4 scans (10, 20, 30, 40 db) + 1 scan to?ﬁake odd number >
N 40 db window = 5 scans (10, 20, 30, 40, 50 db) >
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Buoyancy: Formulas

The relationship between frequency N and stability E is:
N%=gE [rad¥/s’]

where g = gravity [m / s%]

The algorithm used to compute N? for the pressure value centered in the
buoyancy window is:

1. Compute averages:
p_bar = average pressure in the buoyancy window [decibars]
t bar = average temperature in the buoyancy window [deg C]
s_bar = average salinity in the buoyancy window [PSU]
rho_bar = density (s_bar, t_bar, p_bar) [Kg/m’]
2. Compute the vertical gradient:
theta = potential temperature (s, t, p, p_bar)
v =1/ density(s, theta, p_bar)
where s, t, and p are the averaged values for salinity, temperature, and
pressure calculated in Bin Average

Use a least squares fit to compute the linear gradient dv/dp in the
buoyancy window.

3. Compute N2 N, E, and 10 *E:

N?=-1.0¢*rho_bar®g? g;’— [rad */s%]

3600
N= "5 \/NZ [cycles/hour]

2
E= g— [rad ?/m]
_ SL S )
E=10 g [10 ®rad “/m]

Buoyancy adds the following to the data file header:

Label Description

Buoyancy date | Date and time that module was run.

Buoyancy in Input .cnv file.

Gravity value (input value or value based on input
Buoyancy vars | latitude) and buoyancy window size (adjusted to provide
a minimum of three scans and an odd number of scans).
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Cell Thermal Mass

Cell Thermal Mass uses a recursive filter to remove conductivity cell thermal
mass effects from the measured conductivity. In areas with steep temperature
gradients, the correction is on the order of 0.005 PSU. In other areas the
correction is negligible. Typical values for alpha and 1/beta are:

Instrument alpha | 1/beta
SBE 9plus with TC duct and 3000 rpm pump 0.03 7.0
SBE 19plus or 19plus V2 0.04 2.0
with TC duct and 2000 rpm pump ) '
SBE 19 (not plus) with TC duct and 2000 rpm pump 0.04 8.0
SBE 19 (not plus) with no pump, moving at 1 m/sec 0.042 10.0
SBE 25 with TC duct and 2000 rpm pump 0.04 8.0
SBE 49 with TC duct and 3000 rpm pump * 0.03 7.0
*The SBE 49 can be programmed to correct for conductivity cell thermal mass
effects in real-time, eliminating the need to run Cell Thermal Mass. See the
SBE 49 manual for details.

Note: The Data Setup tab in the dialog box looks like this:
The File Setup tab and
Header View tab are similar BT Cell Thermal Mass = B

for all modules; see Section 2:

. File' Options  Help
Installation and Use. Ele. Options - Help

File Setup  Data Setup | Header View |

I¥ Correct primane conductivity values

Temperatute sehsar bo use

Use primary or secondary
temperature sensor data for
filtering the conductivity data.

Themal atidmaly ampltude [alphal

IIZI.IZG
Filter primary and/or

secondary conductivity Thermal anamaly fime constant [1/b=tal  [7

values.

v iCamect secondany conduchivity values

Tempetature zenzor o Lze

Thermal ariamaly amplitude [slphal ||:|_ o2
T hermal aromaly time constant [1/beta] I?

Return to SBE Data Processing window.

o If Confirm Program Setup Change was selected in Options menu - If you made
changes and did not Save or Save As, program asks if you want to save changes.

o If Confirm Program Setup Change was not selected in Options menu - Button says
Save & Exit. If you do not want to save changes, use Cancel button to exit.

Begin processing data. Status field

on File Setup tab shows ™ start Process I \ Esit I Cance) |

Processing complete when done.

80



Section 6: Data Processing Modules

Cell Thermal Mass: Formulas
The algorithm used is:

a =2 * alpha / (sample interval * beta + 2)

b=1-(2 *a/alpha)

dce/dT =0.1 * (1 +0.006 * [temperature - 20])

dT = temperature - previous temperature

ctm [S/m] =-1.0 * b * previous ctm + a * (de¢/dT) * dT

where
sample interval is measured in seconds and temperature in °C
ctm is calculated in S/m

If the input file contains conductivity in units other than S/m, Cell Thermal
Mass applies the following scale factors to the calculated ctm:

ctm [mS/cm] = ctm [S/m] * 10.0

ctm [uS/cm] = ctm [S/m] * 10000.0

corrected conductivity = ¢ + ctm

To determine the values for alpha and beta, see:
Lueck, R.G., 1990: Thermal Inertia of Conductivity Cells: Theory., American
Meteorological Society Oct 1990, 741-755.

Cell Thermal Mass adds the following to the data file header:

Label Description
Celltm_date Date and time that module was run.
Celltm in Input .cnv file.
Celltm_alpha Value used for alpha.
Celltm_tau Value used for 1/beta.
Celltm_temp_sensor | Temperature sensor for primary conductivity filter,
use for cond temperature sensor for secondary conductivity filter.
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Derive

Notes:

e The File Setup tab for Derive
requires selection of both an input
data file and an instrument
configuration (.con) file before it will
process data. However, an
SBE 37 stores calibration
coefficients internally, and does not
have a .con file. You can use a
.con file from any other Sea-Bird
instrument; the contents of the file
will not affect the results. If you do
not have a .con file for another
Sea-Bird instrument, create one in
SBE Data Processing’s Configure
menu (select any instrument in the
Configure menu, then click Save
As in the Configuration dialog box).

¢ Derive is not compatible with a .cnv
file from an SBE 39, 39-IM, or 48.

e For an SBE 21 or 45 with a remote
temperature sensor, Seasave,
Data Conversion, and Derive all
use the remote temperature data
when calculating density and
sound velocity.

e thermosteric anomaly
specific volume

specific volume anomaly
geopotential anomaly
dynamic meters

salinity

average sound velocity

specific conductivity

Note:

The File Setup tab and
Header View tab are similar
for all modules; see Section 2:
Installation and Use.

depth (salt water, fresh water)

Derive uses pressure, temperature, and conductivity from the input .cnv file to
compute the following oceanographic parameters:
e density (density, sigma-theta, sigma-1, sigma-2, sigma-4, sigma-t)

sound velocity (Chen-Millero, DelGrosso, Wilson)

potential temperature (reference pressure = 0.0 decibars)
potential temperature anomaly

derivative variables (descent rate and acceleration) - if input file has not

been averaged into pressure or depth bins

e oxygen (if input file contains pressure, temperature, and either
conductivity or salinity, and has not been averaged into pressure or
depth bins) - also requires oxygen current and oxygen temperature
(for SBE 13 or 23) or oxygen signal (for SBE 43)

e corrected irradiance (CPAR)

See Appendix V: Derived Parameter Formulas for the formulas used by

Derive, Data Conversion, and Seasave to calculate these parameters.

The Data Setup tab in the dialog box looks like this:

File Options Help

File Setup  ['ata Setup | Miscellaneousl HeaderViewI

Select Denved Variables. .. ‘I-\

Select variables to
be calculated.

=10l ]

Return to SBE Data Processing window.

o |f Confirm Program Setup Change was selected in Options menu - If you made
changes and did not Save or Save As, program asks if you want to save changes.

o |f Confirm Program Setup Change was not selected in Options menu - Button says
Save & Exit. If you do not want to save changes, use Cancel button to exit.

on File Setup tab shows

Begin processing data. Status field

\

Processing complete when done. \tan s |

E it \

Cancel
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The Select Derived Variables dialog box looks like this:

Seq. f ariable Mame [urit]

1 Density [density, Kg/m™3]

2 Depth [zalt water, m]

3 Sound Yelocity [Chen-Millero, m/z]

4 Salimity [PSLI]

e

e Add variable: click blank field in Variable Name column,
click desired sensor in sensor list, click Add.
e Change variable: click existing sensor in Variable Name

column, click desired sensor in sensor list, click Change.

e Insert variable: click existing sensor below desired
sequence # in Variable Name column, click desired
sensor in sensor list, click Insert.

If Derive requires additional information to compute a

variable, a dialog box appears after variable is selected,

with fields for required user-input parameters.

£ +|- &cceleration | Shrink Al |
I$‘ Average Sound Velocity —
Charge | [=I- Diensity Exp_éh'dAlll
o odensit), Kadn3
Delete | L sigmadtheta, Kgdn3 Shiink: I
e L e sigmadt, Kgdm®2
mmé Insst | © esigmad, Kgdm™3 Egpand |
I | § e sigmad, Kagdm™3
Ml L L sigmadd, Kadm™3
[ Depth
[ Descent Rats List includes all variables
| - Dinamic Meters [10J/Kg) that can be derived from
] - Geopotentisl anomaly kgl [variables in input data file.
— [#- Oupgen Saturation
— Ii‘ Potential Temperature
— Ii‘ Potential Temperature Anomaly
I - i Salinity [P5L]
Rl HAt | [#- Sourid Welooity :!
\ ot | Cancel

e Descent rate and acceleration use
¢ All oxygen sensors use same time

Click Data to view/modify user-input parameters for selected variable (if applicable). Some variables share a
user-input parameter, so changing a parameter for one variable automatically changes it for the other:
¢ Depth and average sound velocity use same latitude (if NMEA data not available).

same time window size.
window size and Tau correction.

Note: An alternate method of entering these parameters is on Miscellaneous tab in Derive dialog box.

The Miscellaneous tab in the Derive dialog box looks like this:

Note:

Values for these parameters can be
changed on the Miscellaneous tab
or by double clicking on the output
variable in the Select Derived
Variables dialog box (above);
changes made in one location are
automatically made in the other
location.

File ©Options  Help

File Selupl Data Setup  Miscellansous I

Thiz tab configures miscellaneous data for calculations.
Mote: Walues entered only affect indicated calculations.

=10l

Depth and Awverage Sound YWelocity
Latitude when NMEA iz not available

—

Average Sound Welocity

Finimum pressure [dh]

r—
—

Minimum zalinity [pau]

Dezcent and Acceleration

Window size [z]

pra—

Oxpgen
Window size [g] Ig

[V Apply Tau comection

Patential Temperature dnomaly

Al ||3 A1 Ip

A1 Mulipler  [Sainy ]

Set to Defaults |

Start Process |

Exit I

Cancel |

The Miscellaneous tab defines parameters required for output of specific
variables (depth, average sound velocity, descent rate, acceleration, oxygen,
and potential temperature anomaly). Entries on this tab are used only if you are
calculating and outputting the associated variable to the .cnv file. For example,
if you do not select Oxygen in the Select Derived Variables dialog box, Derive
ignores the value entered for Oxygen window size and the enabling of the Tau
correction on the Miscellaneous tab.

&3



Section 6: Data Processing Modules

In Derive, derivative variables (oxygen, descent rate, and acceleration) are
computed by looking at data centered around the current data point with a time
span equal to the user-input time window size and using a linear regression to
determine the slope. This differs from how the calculation is done in Seasave
and Data Conversion, which compute the derivative looking backward in time,
since they share common code and Seasave cannot use future values while
acquiring data in real-time.

Derive has the following /x parameter when run from the Command Line
Options dialog box, from the command line, or with batch file processing:

/x Parameter Description
For SBE 911plus, do not output scans if
pump status = off.

See Appendix I: Command Line Options, Command Line Operation, and Batch File Processing
for details on using parameters.

/xderive:pump

Derive adds the following to the data file header:

Label Description
Derive date Date and time that module was run.
Derive in Input .cnv and .con files.

Window size for oxygen derivative
calculation (seconds).

Window size for descent rate and
acceleration calculation (seconds).

Derive time_window_docdt

Derive time window_dzdt
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Filter

Filtered |

Data \ !
i '\ Original
/| Data

Time

Note:

The File Setup tab and
Header View tab are similar
for all modules; see Section 2:
Installation and Use.

Filter runs a low-pass filter on one or more columns of data. A low-pass filter
smoothes high frequency (rapidly changing) data. To produce zero phase
(no time shift), the filter is first run forward through the data and then run
backward through the data. This removes any delays caused by the filter.

Pressure data is typically filtered with a time constant equal to four times the
CTD scan rate. Conductivity and temperature are typically filtered for some
CTDs. Two time constants can be specified, so different parameters can be
filtered with different time constants in one run of Filter. Typical time

constants are:

Instrument Temperature | Conductivity Pressure
(seconds) (seconds) (seconds)

SBE 9plus - - 0.15
SBE 19plus or 19plus V2 0.5 0.5 1.0
SBE 19 (not plus) with or
without TC duct and pump 0.5 0.5 2.0
SBE 25 0.1 0.1 0.5
SBE 49 with TC duct and
3000 rpm pump * 0.085 0.085 0.25

*The SBE 49 can be programmed to filter the data in real-time with a cosine
window filter (see WFilter), eliminating the need to run Filter on temperature
and conductivity data. See the SBE 49 manual for details.

The Data Setup tab in the dialog box looks like this:

B Filter |_ (O]
Eile Options  Help

File Setup. Data Setup | Headeriew |

Low pass filter &, lime constant [=] 10_1[‘
Low pass filter B, time constart [] !D_15 ;

Specify Filters.y

Desired filter time constants

Select which variables to apply
filter to, and which time constant
to use for each variable.

Return to SBE Data Processing window.

o [|f Confirm Program Setup Change was selected in Options menu - If you made
changes and did not Save or Save As, program asks if you want to save changes.

o If Confirm Program Setup Change was not selected in Options menu - Button says
Save & Exit. If you do not want to save changes, use Cancel button to exit.

Begin processing data. Status field \
on File Setup tab shows =
Start Process | Exit I

Processing complete when done.

Cancel
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The Specify Filters dialog box looks like this:

Specify Filters Ed

Variable Mame furit] | Fier Tupe.

- Temperature [|TS-30 deg C] IWW x|

Canductivity [S/m] Momne b '

Dwaen Curent, Beckman/vS! [ub] Nane -|  |Select Mone, Fiter A, or

Dyaen Temperature, ElggkﬂaﬂNSI [deg O] MNaone ¥ | |variable.

Ouwygern, Beckman/Sl [mi] Miaone ;]

Prezzue; Digiquartz [db] Momne j

ok | Cancal |

Filter: Formulas

For a low-pass filter with time constant I
I'=1l/o o =2xf

T = sample interval (seconds)

S():l/r

Laplace transform of the transfer function of a low-pass filter (single pole)
with a time constant of " seconds is:

HO= T msy

Using the bilinear transform:

A 2(1-z7h . 2(@-1
$-12) = Ta+zH T TTaea)
1 z'+1
H(z) = L 2G@n 2 1-2/TS,
T(z+1)S, TSo {1+ 1+2/Ts0) }
2
1 S
Iff A= B= 0
2 2
1+ 1+
TS() TSO
-1
Then: H(z)= Yz) _ AC Hl)
X(z) (1+Bz™)

Where z ' is the unit delay (one scan behind).

y[N] = current output

y[N-1] = previous output

x[N] = input data (current scan)

x[N-1] = previous input data (from previous scan)

Y2)(1+BzH)=X@2z)A@z"+1)
yIN] + By[N-1] = Ax[N-1] + Ax[N]
yIN] = A(x[N] + x[N-1]) - By[N-1]
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Example: Time constant = 0.5 second, sample interval = 1/24 second
1

A= 072%05%24) (1124 004
1-24

B=(1-2*%05%24)A= ——_ =-0.92
1+24

Filter adds the following to the data file header:

Label Description
Filter date Date and time that module was run.
Filter in Input .cnv file.
Filter low pass tc A Time constant for filter A.
Filter low-Pass tc B Time constant for filter B.
Filter low pass A vars | List of variables filtered with time constant A.
Filter low pass B vars | List of variables filtered with time constant B.
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Loop Edit

Note:

Data Conversion calculates
velocity with a 2-second
window (e.g., 48 scans for an
SBE 9plus), giving a much
smoother measure of velocity.

Note:

The File Setup tab and
Header View tab are similar
for all modules; see Section 2:
Installation and Use.

If selected, scans related to surface

Loop Edit marks scans bad by setting the flag value associated with the scan to
badflag in input .cnv files that have pressure slowdowns or reversals (typically
caused by ship heave). Optionally, Loop Edit can also mark scans associated
with an initial surface soak with badflag. The badflag value is documented in
the input .cnv header.

Loop Edit operates on three successive scans to determine velocity. This is
such a fine scale that noise in the pressure channel from counting jitter or other
unknown sources can cause Loop Edit to mark scans with badflag in error.
Therefore, you must run Filter on the pressure data to reduce noise
before you run Loop Edit. See Filter for pressure filter recommendations for
each instrument.

The Data Setup tab in the dialog box looks like this:

EEE Loop Edit |

File Options Help

_lof (|
Minimum velocity type:
Fixed minimum velocity - If CTD velocity <
specified Minimum CTD Velocity, or
pressure < previous maximum pressure,
scan is marked with badflag.
Percent of mean speed - For each scan,

Filz Setup  Data Setup |

Finimum velocity type

Fired minimum welocit

Mivirum CTD velocity [mrs] o285

Window size [z] 300

Percent of mean speed

mean speed over last Window Size seconds
is computed. If CTD velocity < specified
Percent of Mean Speed, or pressure <
previous maximum pressure, scan is marked
with badflag. Minimum CTD Velocity is used

—

to evaluate data points in first time window.

soak are marked with badflag,
based on Minimum soak depth and
Maximum soak depth (note that
Surface soak depth is not actually
used in calculation of surface

soak scans). See drawing below
for details.

» If selected, scans previously
marked with badflag (for example,
in a previous run of Loop Edit) will
not be evaluated.

If not selected, scans previously
marked with badflag will be
reevaluated, and scan’s flag will
be reset accordingly.

¥ Remove suface soak

Surface zoak depth [m]

T
—
T

v Use deck pressure as pressure offset

tikirmumm zoak. depth [m]
[default = znak depth / 2]

td aximum soak depth [m]
[default = soak depth * 2]

If selected, pressure from first scan in file is used
as a pressure offset in determining scans related
to surface soak. See drawing below for details.
Note: This affects only marking of surface soak
scans, and has no effect on pressure data in file.

¥ Euxclude scans marked bad

E «it I

Cancel

Begin processing data. Status field

/Start Process |

on File Setup tab shows Processing
complete when done.

Return to SBE Data Processing window.

o If Confirm Program Setup Change was selected in Options menu - If you made changes

Depth

Algorithm
for removal
of surface
soak data

and did not Save or Save As, program asks if you want to save changes.
o If Confirm Program Setup Change was not selected in Options menu - Button says Save
& Exit. If you do not want to save changes, use Cancel button to exit.

\Deck pressure

Minimum
.soak depth
reached

= = 5cans marked with badflag

Time
Minimum pressure between
when minimum soak depth was
reached and maximum soak
depth was reached (First scan
not automatically marked
with badflag)

Surface soak depth

Maximum
— -soak depth
reached




Section 6: Data Processing Modules

Loop Edit adds the following to the data file header:

Label Description
Loopedit_date Date and time that module was run.
Loopedit_in Input .cnv file.

If Fixed Minimum Velocity was selected -
minimum CTD velocity for good scans;
scans with velocity less than this are marked
with badflag.

Loopedit_minVelocity

If Percent of Mean Speed was selected -
minimum CTD velocity for first time
Loopedit_percentMeanSpeed | window, window size, and percent of mean
speed for good scans; scans that do not meet
this criteria are marked with badflag.

If Remove surface soak was selected —
minimum soak depth, maximum soak depth,
and whether to use deck pressure as a
pressure offset (1 = yes, 0 = no).

Loopedit_surfaceSoak

If yes, do not evaluate scans marked with
badflag in a previous run of Loop Edit.

Loopedit_excl bad_scans
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Wild Edit

Note:

Wild Edit marks individual data (for
example, a conductivity value) with
badflag, but does not mark the entire
scan (which may include other data
that is valid, such as temperature,

pressure, etc.).

Note:

The File Setup tab and Header View
tab are similar for all modules; see
Section 2: Installation and Use.

The Data Setup tab in the dialog box looks like this:

Wild Edit marks wild points in the data by replacing the data value with
badflag. The badflag value is documented in the input .cnv header.

Wild Edit’s algorithm requires two passes through the data: the first pass
obtains an accurate estimate of the data’s true standard deviation, while the
second pass replaces the appropriate data with badflag.

B Wild Edit =|0Op= iWiId Edit operates

Flle Options Help

File Setup  Data Setup | Hesder View |

Standard deviations for pass one

If selected, data from
scans marked with
badflag in Loop Edit
will not be used in
calculating mean and
standard deviation.

'S;éndard deyiations for pass two

Seans pet block

v Exclude scans marked bad

Select which variables
to run Wild Edit on.

T Seleot Wild Edit Mariables. |

Begin processing
data. Status field on
File Setup tab shows
Processing complete
when done.

Jr—
pr—
—

K.eep datawithin thiz distance of the meah in

Do not flag data within this distance of mean,
even if it falls outside specified standard
deviation. Set to a value where difference
between data and mean would indicate a wild
point. May need to use if data is very quiet (for
example, a single bit change in voltage may
cause data to fall outside specified standard
deviation and be marked bad). A typical
sequence for using parameter follows:

1. Run Wild Edit for all desired variables, with
parameter set to O.

2. Compare output to input data. If a variable’s
data points that are very close to mean were
set to badflag:

A. Rerun Wild Edit for all other variables,
leaving parameter at 0 and overwriting
output file from Step 1.

B. Rerun Wild Edit for quiet variable only,
setting parameter to desired value to
prevent flagging of data close to mean.

as follows:

1. Compute mean and
standard deviation of
data in block
(specified by Scans
per Block) for each
selected variable.
Temporarily flag
values that differ from
mean by more than
standard deviations
specified for pass 1.

2. Recompute mean and
standard deviation,
excluding temporarily
flagged values. Mark
values that differ from
mean by more than
standard deviations
specified for pass 2 by
replacing data value
with badflag.

3. Repeat Steps 1 and 2
for next block of
scans.

o [f last block of data
in input file has less
than specified
number of scans,
use data from
previous block to fill
in block.

Start Process

Y, Exit I

Cange|

/

/

Return to SBE Data Processing window.

o If Confirm Program Setup Change was selected in Options menu - If you made
changes and did not Save or Save As, program asks if you want to save changes.

« |f Confirm Program Setup Change was not selected in Options menu - Button says
Save & Exit. If you do not want to save changes, use Cancel button to exit.
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If the data file is particularly corrupted, you may need to run Wild Edit more
than once, with different block sizes and number of standard deviations.

If the input file has some variables with large values and some with relatively
smaller values, it may be necessary to run Wild Edit more than once, varying
the value for Keep data within this distance of mean so that it is meaningful
for each variable. Better results may also be obtained by increasing Scans per
block from 100 to around 500.

Example

Sensor A’s range is approximately 1000 and Sensor B’s range is
approximately 10. Run Wild Edit on Sensor A, using Keep data
within this distance of mean = 10. Then run Wild Edit on
Sensor B, using Keep data within this distance of mean = 0.1

Wild Edit adds the following to the data file header:

Label Description
Wildedit date Date and time that module was run.
Wildedit_in Input .cnv file.

Wildedit passl nstd Number of standard deviations for pass 1 test.

Wildedit_pass2 nstd Number of standard deviations for pass 2 test.

Wildedit pass2 mindelta | Keep data within this distance of mean.

Wildedit npoint Number of points to include in each test.

Wildedit vars List of the variables tested for wild points.

If yes, values in scans marked with badflag
Wildedit_excl bad scans | (in Loop Edit) will not be used to determine
standard deviation.
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Window Filter

Window Filter provides four types of window filters and a median filter for
data smoothing of .cnv files:

Note:
The File Setup tab and

Installation and Use.

Header View tab are similar
for all modules; see Section 2:

Window filters calculate a weighted average of data values about a center
point and replace the data value at the center point with this average.

The median filter calculates a median for data values about a center point
and replaces the data value at the center point with the median.

EE Window Filter
Eile Options - Help

File Setup Data Setup | Header View |

Interval befiveen soans, senonds = 0 1416667

If selected, data
from scans marked
with badflag in Loop
Edit will not be used.

| IV ‘Exclude scanz marked bad

‘Speciy ‘u&ﬁnd;-w Filbers:..

/

Select which variables to run
Window Filter on, and specify the
filters.

The Data Setup tab in the dialog box looks like this:

- 10] x|

Return to SBE Data Processing window.
o If Confirm Program Setup Change was selected in Options menu - If you made

changes and did not Save or Save As, program asks if you want to save changes.

o |f Confirm Program Setup Change was not selected in Options menu - Button says

Save & Exit. If you do not want to save changes, use Cancel button to exit.

N\

Start Process I

Exit I Cancel

The Specify Window Filters dialog box looks like this:

Specify Window Filters

W ariable Mame urit] Filter Type. Parameters Clear A I
' Pressure; [ll'giqumtz_[d_l:ul Gaussian | = 5,1.000,0.000
_T_ETE_EE’FH"?'_['T_E@D:EQQ Hone 3 Select none, boxcar, cosine,
i Z2ITS-50, deg O] gnne ~ Gaussian, median, or triangle filter.
£ (S /m] LEes A dialog box appears to enter
_E- _d_tt_ [_2[&, I 'l"m: applicable filter parameters, which
SR MGaussian = then display in Parameters column.
Densiy figmathets, Ko/m"3] HMedan .
S aliity [P5L] Nore =] |

ok I Eani:ell
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Window Filters: Descriptions and Formulas

Shape and length define filter windows:

e  Window Filter provides four window shapes: boxcar, cosine, triangle,
and Gaussian.

e  The minimum window length is 1 scan, and the maximum is 511 scans.
Window length must be an odd number, so that the window has a center
point. If a window length is specified as an even number, Window Filter
automatically adds 1 to make the length odd.

The window filter calculates a weighted average of data values about a center
point, using the following transfer function:

L/2

ym) = 2 w(k)x(n-k)

The figure below shows the impulse response of each of the four filter types
for a filter of length 17 scans. The impulse response of a filter is obtained by
filtering a data set that has zeros everywhere except one data value that is set
to 1.

Begin processing data. Status field
on File Setup tab shows
Processing complete when done.

Boxcar Cosine

Maghnitude

Triangle Gaussian

Time
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Note:

In the window filter equations:

e L =window length in scans,
(always an odd number)

e n = window index, -L/2 to +L/2,
with 0 the center point of
the window

¢ w(n) = set of window weights

The window filtering process is similar for all filter types:
1. Filter weights are calculated (see the equations below).
2. Filter weights are normalized to sum to 1.

e  When a bad data point is encountered (scan marked with badflag if
exclude scans marked bad was selected or data value marked with
badflag), the weights are renormalized, excluding the filter element
that would operate on the bad data point.

Boxcar Filter

1 L-1 L-1
wn)= — forn= - .

L 2 2
Cosine Filter

wn)=1 forn=0

nxm L-1 L-1
w(n) = cos forn= - Y R
L+1 2 2
Triangle Filter
win)=1 forn=0
[n| L-1 L-1
w(n) = forn= - S R
K 2 2
L-1
where K = +1
2

Gaussian Filter

offset (sec)

phase =
sample interval (sec)

sample rate 2
scale =log(2) x f 2 x
half width (scans)

W(n) =e -phase x phase x scale forn=0

, L-1 L-1
w(n) —e -(n - phase)” x scale forn= - AR O
2

The Gaussian window has parameters of halfwidth (in scans) and offset (in
time), in addition to window length (in scans). These extra parameters allow
data to be filtered and shifted in time in one operation. Halfwidth determines
the width of the Gaussian curve. A window length of 9 and halfwidth of 4
produces a set of filter weights that fills the window. A window length of 17
and halfwidth of 4 produces a set of filter weights that fills only half the
window. If the filter weights do not fill the window, the offset parameter may
be used to shift the weights within the window without clipping the edge of the
Gaussian curve.
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Pressure

Example: Window length is 33 scans and halfwidth is 4 scans. Offset is
-3 seconds in left curve, 0 in middle curve, and +3 seconds in right curve.

Shifted 0 seconds
Pa

-
A
\

Shifted — hy

-3 seconds |

I

1
ra
[
I

1

1

1

' ™ Shifted
+3 seconds

Magnitude

1
1
1
1
]
1
i
]
1
1
1
1
1
1
1

|
T T 1 1 1 -
3 6 9 12 15 18 21 24 27 Time

Note that the window length in the example is larger than the halfwidth. This
allows the complete Gaussian curve to be expressed in the window when the
offset parameter shifts the curve forward or backward in time. If the halfwidth
was larger, the trailing edge of the -3 second offset curve would be truncated
and the leading edge of the +3 second curve would be truncated. The offset
parameter moves the Gaussian shape of the window weights forward or
backward in time. Since the weighted average is calculated for a data value in
the center of the window, this has the effect of shifting the data that the filter is
operating on forward or backward in time relative to the other data in the file.
This capability allows filtering and time shifting to be done in one step.

Median Filter: Description

The median filter is not a smoothing filter in the same sense as the window
filters described above. Median filtering is most useful in spike removal.

A median value is determined for a specified window, and the data value at the
window’s center point is replaced by the median value.

\

™y
1
T

O
P *Median-Filtered Data,
4 T /J window length 17

- salinty
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Window Filter has the following /x parameter when run from the Command
Line Options dialog box, from the command line, or with batch file processing:

/x Parameter Description
Jxwihilter-diff Output difference between original and filtered value

instead of outputting filtered value.
See Appendix I: Command Line Options, Command Line Operation, and Batch File Processing
for details on using parameters.

Window Filter adds the following to the data file header:

Label Description
Wifilter date | Date and time that module was run.
Wrfilter in Input .cnv file.
Wfilter_excl | If yes, values in scans marked with badflag in
bad scans Loop Edit will not be used.
Wrfilter action | Data channel identifier, filter type, filter parameters.
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Section 7: File Manipulation Modules

Module Name

Module Description

ASCIl In

Add header information to a .asc file containing rows
and columns of ASCII data.

ASCII Out

Output data portion and/or header portion from .cnv file
to an ASCII file (.asc for data, .hdr for header).

Useful for exporting converted data for processing by
other (non-Sea-Bird) software.

Section

Extract rows of data from .cnv file.

Split

Split data in .cnv file into upcast and downcast files.

Strip

Extract columns of data from .cnv file.

Translate

Convert data format in .cnv file from ASCII to binary,
or vice versa.
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ASCIl In

ASCII In adds a header to a .asc file that contains rows of ASCII data. The
data can be separated by spaces, commas, or tabs (or any combination of
spaces, commas, and tabs). The output file, which contains both the header and
the data, is a .cnv file. ASCII In can be used to add a header to data that was
generated by a non-SEASOFT program.

Note: The Data Setup tab in the dialog box looks like this:

The File Setup tab is similar

for all modules; see Section 2: Hie.. Dot Hiala
Installation and Use. et

Select whether interval between
scans is based on time,
pressure, or depth, and indicate
the interval value (time, pressure,
or depth between scans). This
information is put in header.

FileSetup DataSetup |

_Séah: ih'h'a:rv,a] ina[iahlﬁ %
Sean irterval valus: ID_ 5

Selict Colurnr Narmes._ |

Select variable name associated
with each column of data, to be
put in header. Selection list
includes all variables that can be
output by Data Conversion and
Derive, as well as user-defined
variable names.

Return to SBE Data Processing window.

o If Confirm Program Setup Change was selected in Options menu - If you made
changes and did not Save or Save As, program asks if you want to save changes.

o If Confirm Program Setup Change was not selected in Options menu - Button says
Save & Exit. If you do not want to save changes, use Cancel button to exit.

Begin processing data. Status field \ |

on File S_etup tab shows Start Process | ’;mit g |
Processing complete when done. . -

ASCII In creates a data file header containing the following information:

Label Description

Number of columns (fields) of data.

NOTE: ASCII In automatically adds 1 field to number of fields
Nquan in input .asc file (i.e., if the .asc file contains 3 columns of data,

then nquan=4). This field, initially set to 0, is used by Loop Edit
to mark bad scans.

Nvalues | Number of scans converted.

Specified (indicates units are specified separately for each

Units variable).

Name n | Sensor (and units) associated with data in column n.

Span n Span (highest - lowest value) of data in column n.

Interval | Scan rate (seconds).

Start time | Start time for when ASCII In was run.

Provided for information only; value that Loop Edit will
Bad flag | use to mark bad scans and Wild Edit will use to mark
bad data values.

Asciiin_in | Input .asc file.

File type | Selected output file type - ASCII data.
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ASCII Out

ASCII Out outputs the header portion and/or the data portion of a converted

data file (.cnv).

e The data portion is written in ASCII engineering units to a .asc file, and
may be useful if you are planning to export converted data for processing
by other (non-Sea-Bird) software.

e  The header portion is written to a .hdr file.

Note:
The File Setup tab and The Data Setup tab in the dialog box looks like this:

peaclor View tab are simiar =lolx|

for all modules; see Section 2: S R
Installation and Use. e P If columns are labeled at top of each

page, form feed character is inserted
after selected number of lines/page.

v Output header file Lines per page |557
If selected, scans marked . ]
with badflag in Loop Edit will I Output data file Column label for output data file: Top of file,
not be output in data file. \F Bl st Top of each page, or No column labels.

I*% 1
Label columns -
No column labels B2 Column separator for output data file:

space, tab, semi-colon, or colon.
If selected, elapsed and/or system time
Il

is converted to this format - for e)gample, Julian days conversion famat |.Ju|ian Hagis \;I\ _
04/10/2005 13:43:56 (applicable if (Datel_fortr)r;at_ fft?jr outpult datg file
applicable if date selected as

elapsed time and/or system time
\F Corvert elapsed and spstem time to mmiddfyyyy hh:mm:ss output variable).

selected as output variable).
/l-_ Add first column

First column name I

File Setup Data Setup | Header YView I

Calumn separator Space =l

If selected, 1 column is
inserted before first column of
data, with specified column

First colurnn value I

name and data value.
If selected, all occurrences of badflag in input file
I¥ Replace bad lam ———— (occurrences in flag column as well as in data columns)
are replaced with specified value in output file. This
Select which variables to e (A |9-E'9'3"02S may be useful for plotting purposes, as SBE Data
include in output data file. \ . Processing uses a very small number (-9.990e-29) for
Select Dutput Y ariablss. .. | badflag, which looks like 0 in a plot.

Begin processing data. Status field I

on File Setup tab shows Start Process | Exit I Cancel |

Processing complete when done. AV

N\
Return to SBE Data Processing window.
o |f Confirm Program Setup Change was selected in Options menu - If you made
changes and did not Save or Save As, program asks if you want to save changes.
o |f Confirm Program Setup Change was not selected in Options menu - Button says
Save & Exit. If you do not want to save changes, use Cancel button to exit.

ASCII OUT has the following /x parameter when run from the Command Line
Options dialog box, from the command line, or with batch file processing:

/x Parameter Description

string = value (maximum of 11 characters) placed in
each row of column inserted before first column
of data.

/xascii_out:first
column_value=string

/xascii_out:label
format=mon/day/yr
hh:mm

mon/day/yr is heading for date column;
hh:mm is heading for time column.

See Appendix I: Command Line Options, Command Line Operation, and Batch File Processing
for details on using parameters.

ASCII Out does not add anything to the data file header. The output header
(.hdr) file contains the header from the input (.cnv) file.
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Section

Note:

The File Setup tab and
Header View tab are similar
for all modules; see Section 2:
Installation and Use.

Section extracts rows of data from the input .cnv file, based on a pressure
range or scan number range, and writes the rows to an output .cnv file.

The Data Setup tab in the dialog box looks like this:

&= Sechon Ei[=]

Eie Options - Help

File Setup  Diata Setup | Header iew |

Sectior based on

Select Upcast or Downcast if
section is based on pressure.

|~ Pressire sectior cast Iﬁm

Miniraurn vl |D
: > Section writes to output file all rows

b airnuimn s |D of data that fall within this range of

Section based on a pressure range or
a scan range.

pressure or scan number.

Return to SBE Data Processing window.

o If Confirm Program Setup Change was selected in Options menu - If you made
changes and did not Save or Save As, program asks if you want to save changes.

« If Confirm Program Setup Change was not selected in Options menu - Button says
Save & Exit. If you do not want to save changes, use Cancel button to exit.

Begin processing data. Status field
on File Setup tab shows
Processing complete when done.

N\ l

Start Process I

Bt \ I Cancel |

Section adds the following to the data file header:

Label Description
Section_date Date and time that module was run.
Section in Input .cnv file.

Section_type

Evaluate data based on pressure or scan range.

Section_range

Range of (pressure or scan count) data to keep.
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Split
Split separates the data from an input .cnv file into upcast (pressure
Note: decreasing) and downcast (pressure increasing) files. Split writes the data to an
Bin Average provides the option of output .cnv file(s). The upcast output file name is the input file name prefixed
processing upcast, downcast, or by u. The downcast output file name is the input file name prefixed by d.
both, possibly removing the need to
run Split.

The Data Setup tab in the dialog box looks like this:

EE Sph W
Note: : o SR =Rl
The File Setup tab and Header View Eie  DOptions  Help
tab are similar for all modules; see ; __
Section 2: Installation and Use. File Setup  Data Setup l Header View l Output an upcast file (prefix u) and
S downcast (prefix d) file, or just a
DUtpu'[ NES lpcast and downcast / downcast (prefix d) file.

WV ' Excludescans maked bad

If selected, scans marked with badflag (in
Loop Edit) will not be used to identify
maximum pressure. Maximum pressure
defines when downcast ends and upcast
begins.

Note: Pressure values marked with
badflag in Wild Edit are never used to
determine maximum pressure.

Return to SBE Data Processing window.

o If Confirm Program Setup Change was selected in Options menu - If you made
changes and did not Save or Save As, program asks if you want to save changes.

« |f Confirm Program Setup Change was not selected in Options menu - Button says
Save & Exit. If you do not want to save changes, use Cancel button to exit.

Begin processing data. Status field \ |
on File Setup tab shows Start Process Evit I E‘ﬂﬂﬁel |

Processing complete when done.

Split adds the following to the data file header:

Label Description
Split date Date and time that module was run.
Split_in Input .cnv file.

If Yes, pressure from scans marked with badflag
(in Loop Edit) were not used to determine
maximum pressure (for determining when
downcast ends and upcast begins).

Split_excl bad scans
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Strip
Strip outputs selected columns of data from the input .cnv file. Strip writes the
data to an output .cnv file.
Note: The Data Setup tab in the dialog box looks like this:
The File Setup tab and Header View EEE Strip HEi=l B3
tab are similar for all modules; see File  Dptiors  Help
Section 2: Installation and Use.
File Setup  Data Setup | HeaderView |

e _ :
Select which variables (columns
of data) to output.

Return to SBE Data Processing window.

¢ If Confirm Program Setup Change was selected in Options menu - If you made
changes and did not Save or Save As, program asks if you want to save changes.

¢ If Confirm Program Setup Change was not selected in Options menu - Button says
Save & Exit. If you do not want to save changes, use Cancel button to exit.

Begin processing data. Status field \ I
on File Setup tab shows = AN i
Processing complete when done. Start Process I Exit I Cancel |

Strip adds the following to the data file header:

Label Description

Strip_date | Date and time that module was run.

Strip_in Input .cnv file.
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Translate
Translate changes the converted data file format from binary to ASCII or vice
versa, and writes the data to an output .cnv file.
Note: The Data Setup tab in the dialog box looks like this:
The File Setup tab and Header View BE Translate [_[OI %]
tab are similar for all modules; see il Diticis: el
Section 2: Installation and Use. SR

Flle Setup  Data Setup | Headeriew |

Transtation [ginan-» AsCll i
s, -J \ Switch from:
{ e Binary to ASCII,

Translaté to opposite ° A.SC” to binary, or .
e Binary to ASCII or ASCII to binary,

as applicable

Return to SBE Data Processing window.

¢ If Confirm Program Setup Change was selected in Options menu - If you made
changes and did not Save or Save As, program asks if you want to save changes.

¢ If Confirm Program Setup Change was not selected in Options menu - Button says
Save & Exit. If you do not want to save changes, use Cancel button to exit.

Begin processing data. Status field / |

on File Setup tab shows = ’—‘—I o
Processing complete when done. Start Process | Et Cance| |

Translate changes the following in the data file header:

Label Description

File type File type - changes to ASCII or binary, as applicable.
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Section 8: Data Plotting Module — Sea Plot

Note:

Converted data (.cnv) files are typically

created in Data Conversion and

manipulated in other SBE Data

Processing modules. Sea Plot can plot

data at any point after Data

Conversion has been run.

e For SBE 37 (firmware < 3.0), 39,
39-IM, and 48, a converted (.cnv)
data file is created from an
uploaded .asc file using the Convert
button in SEATERM'’s Toolbar.

e For SBE 37 with firmware version
3.0 and later, a converted (.cnv)
data file is created from an
uploaded .xml file using Convert
XML data file in the Tools menu in
SeatermV2, Seaterm232,
Seaterm485, or SeatermIM.

Sea Plot can be used to plot C, T, and P, as well as derived variables and data
from auxiliary sensors, from any converted .cnv data file. Sea Plot can:

e Plot up to 5 variables on one plot, with a single X axis and up to four
Y axes or a single Y axis and up to four X axes.

e Plot any variable on a linear or logarithmic scale (logarithmic scale not
applicable to TS plots).

e Derive and plot derived salinity and/or derived density, if conductivity,
temperature, and pressure data are in the input file. This allows you to
skip running Derive if salinity and density are the only derived parameters
you are interested in. Alternatively, you can calculate and plot derived
salinity and/or derived density even if salinity and density are already in
the input file; the values may differ because of processing steps performed
on C, T, or P after Derive was run.

Note:

When plotting date and time, the

following restrictions apply:

e On the Plot Setup tab, select Single
X — Multiple Y or
Single X — Multiple Y, Overlay
for plot type

e On the X Axis tab, select Julian days
or Elapsed time for the variable, and
select Show as Date/Time.

e On the X Axis tab, do not select
Reverse scale direction.

e Plot time series data; the time scale selections include Julian Days,
elapsed time in hours, minutes, or seconds, or date and time.

e Create contour plots, generating density (sigma-t or sigma-theta) or
thermosteric anomaly contours on temperature-salinity (TS) plots.

e Process and plot multiple input files that contain the same variables and
with the same setup parameters, each on their own plot, allowing the user
to quickly switch the view from one file to the next.

e  Process and plot multiple input files that contain the same variables on an

overlay plot, allowing the user to view multiple sets of data at the
same time. If desired, the user can offset each file on the plot to create a
waterfall plot.

e Zoom in on plot features.
e Send plots to a printer, save plots to the clipboard for insertion in another
program (such as Microsoft Word), or save plots as graphic files in

bitmap, metafile, or JPEG format.

e Run in batch processing mode. See Appendix I: Command Line Options,
Command Line Operation, and Batch File Processing.

The Sea Plot dialog box differs somewhat from the other SBE Data Processing

modules. Each tab of the Sea Plot dialog box is described below, as well as
options for viewing, printing, and saving a plot.
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Sea Plot File Setup Tab

Note:
Versions 5.30a and earlier of SBE
Data Processing used program setup

files with a .psu extension instead of a

.psa extension. Program setup files
with a .psa extension can be opened,

viewed, and modified in any text editor

or XML editor.
SBE Data Processing can still use

your existing .psu files. However, if you

make any changes to the setup (for
example, change output variables),
SBE Data Processing will save the
changes to a new .psa file.

The File Setup tab defines the Program Setup file; input data file(s); and

like this:

Input data directory and file names.
Select to pick a different file.

To process multiple files from
same directory:

output type, orientation, and (if applicable) file name. The File Setup tab looks

File to store all information input in File, Plot, and Axis Setup tabs. Open to select a
different .psa file, Save or Save As to save current settings, or Restore to reset all
settings to match last saved version.

1. Click Select.

2. In Select dialog box, hold down
Ctrl key while clicking on each
desired file.

If multiple files selected, header in each

file must contain same set of sensors

and variables.

For overlay plots:

o If Sort Input Files selected in Options
menu: Sea Plot sorts input files in
alphabetical order.

e If Sort Input Files not selected in
Options menu: Sea Plot maintains
order of files as you selected them
using Ctrl key. Use this feature if
there is a particular data set you
want to use as base on a waterfall
overlay plot. Note that using Shift
key to select files will not maintain
selected order.

Output Information is default only,
and can be easily changed while
viewing plot.

e Output to: Printer, Metafile (.wmf),
JPEG (.jpg), or Bitmap (.bmp). When
viewing plot, you can also output to
clipboard; from clipboard, you can
paste plot into another application
(such as Microsoft Word).

e Orientation: if outputting to printer.
Driver default, Landscape, or
Portrait. If Driver default selected,
orientation determined by default for
printer you select.

e Print full page: Applicable for
outputting to printer. If selected, Sea
Plot sizes plot to fit 81/2 x 11 inch
paper. If not selected, input desired
plot size (Units, Width, and Height).

e Units, Width, and Height: Plot size.

L1

File

File Setup I Plat Setup

Ciptions

=10l x|

Help

Frogram setup file

Temperature | S aliriby I Header Wigw |

{H:4data\DebbietSeaPlot psa 4

Open...

Save Save Az Restore |

Input directon

" |H:datatDebbie

Input files, 1 selected

i Z33al aligndervealignderive. crv

_"J Select... |

Dutput ko IF'rinter vl Origntation ILandSI:ape vI [~ Print full page
L riiks: |Mi||imeters -..-I Width I‘|E|j Height I‘|2|j

Output direchary

{H:\datatDebbie

Mame append

Select... I

Default directory and file name (can be easily changed while
viewing plot) for outputting .wmf, .jpg, or .bmp graphic file.
* If more than 1 file to be processed, Output file field disappears

Output file 'W; and output file names are set to match input file names. For
example, if processing test.cnv and testl.cnv, and outputting
.ipg files, output files will be test.jpg and testl.jpg.

Mat proceszing e Sea Plot adds Name append to (each) output file name,

\ before extension. For example, if processing test.cnv and
testl.cnv with a Name append of CTDpH, and outputting .jpg
files, output files will be testCTDpH.jpg and test1CTDpH.jpg.

2
\

E xit Cancel |

Start Process ~|\\

Applicable when outputting to printer
(if Print full page was not selected),
or to graphics file.

N

Return to SBE Data Processing window.

Click Start Process to begin .
processing data. Status field
shows Processing complete
when done. .

If Confirm Program Setup Change selected in Options
menu - If you made changes and did not Save or Save
As, program asks if you want to save changes.

If Confirm Program Setup Change not selected in

Options menu - Button says Save & Exit. If you do not
want to save changes, use Cancel button to exit.
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Sea Plot Plot Setup Tab

The Plot Setup tab defines the plot type, scans to be included, and plot layout
(title, color, font grid lines, etc.). The Plot Setup tab looks like this:

e Single X - Multiple Y: 1 X axis and up to 4 Y axes

¢ Single X - Multiple Y, Overlay: 1 X axis and up to 4 Y axes, overlaying data from
multiple files on 1 plot

e Single Y - Multiple X: 1 Y axis and up to 4 X axes

e Single Y - Multiple X, Overlay: 1 Y axis and up to 4 X axes, overlaying data from
multiple files on 1 plot

e TS Plot: temperature vs. salinity, with density or thermosteric anomaly contours

e R SR rl e TS Plot, Overlay: TS plot, overlaying data from multiple files on 1 plot

Plot Title and Title color. Select
Add file name to title to add

input data (.cnv) file name to title | ' File Options Help -

(for overlay plots, it adds first file Enab_led if TS plot
name (o title). For example, if you| - Fig Setup Flot Setup | v duis | s s 1 | 3¢ wis 2| 20 s 3| 3¢ s 4 type is selected.
enter title as P vs T, select Add See below.
file name to title, and data file R : e R o
name is Octoberl.cnv, title will Wp |SlngleY - Multiple ¥ :] werlay b-:—tl.-p\\l 115 Rlat Setup.. 7] | |
be P vs T, October 1.cnv. - -
\T'I Enabled if overlay plot type is
HlE |P v T selected. See below.
Plot Font type and Font size

(small, medium, or large). Sea Title Calar... | . Iv fdd file name to title

Plot displays example of font
type to right of selection. List of

fonts depends on what fonts are [——ont tupe |Arial j IiaBbCCDdEeFf-U'] 2345|

installed on your computer. Font si Grid lines (none, horizontal and vertical, horizontal, or
ALl |Small "i vertical), Grid style (solid, dotted, or dashed line), and
whether to place Grid in front of plotted data.

Inside Background Color

doﬂltr;iejecglgglz\gtrrgg:gecsélor Girid lines IHc:nzu:untaI and Yertical j %y_m:;oéllsrilg’gi(;mgef;?q;(inﬁg o

defines color outside axes. Grid style Iﬁhin Solidline B8 i frequent), i Monoéhrome
plot selected. If too frequent,

Size (small, medium, or large) of symbols create illusion of

symbol for each variable, if Inzide Background Colar... | D Outside Background Color... | D very thick line, making details

Monochrome plot or Plot difficult to see.

symbols only selected.

\Symb'j e |__'_'1|.1=5II ,l Symbol frequency Ih—j IT

e Mark data points: Mark

e Monochrome plot: Substitute individual data points with
black lines with symbols for IL Monachiome plat IL Flot symbals only }7 Show line legends a dot, and connect dots. If
colors (Colors and symbols not selected, Sea Plot just
are defined on Axis setup tabs i Mark data poirits woo plot shadaw I Black test aes draws a continuous line
for non-overlay plots. For between data points.
overlay plots, click Overlay ; e Show plot shadow:
Setup button to define). Auto range padding % |5_j Process Options... Create shadow effect to

Enables you to set up axes

with colors for viewing on _
k See below. ¢ Black text axes — Create
screen, and then switch to labels for all axes in black.

black lines with symbols for If not selected:
black and white printing.

- - Axis label color matches
¢ Plot symbols only: Mark Start Process | selected plot color for
\

bottom and right of axes.

each individual data point with each variable.
a symbol, and do not connect - For overlay files, colors

symbols with a line (Symbols Define space between axes and maximum and match colors for variables

are defined on Axis setup tabs minimum plotted values, if Auto range selected in first file.

gz,re?gn-o}/;gaégftcs)\;ﬂ; on Axis setup tabs. For 0%, maximum and
Y pots, y minimum values plot on axes.

Setup button to define).

e Show line legends: Show line
legends below plot title.
Legend indicates line color
and type (for color plots) or
line symbol and type (for
monochrome plots). For
overlay plots, legend indicates
line color or symbol only for
first file.
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Plot all scans in file. If not
selected, plot Scans to process.

Process Options

If the Process Options button is clicked on the Plot Setup tab, the following

dialog box appears:

Process Options

\F Process scans to end of file

Skip these scans at beginning of cast, and then plot
remaining scans or number of scans designated by
Scans to process. Example: If Scans to process

is 100 and Scans to skip at start is 10,
Sea Plot processes scans 10 through 109.

Scans to process 100

— Scanz to skip at shart

Plot scans that were marked with bad flag in
Loop Edit. If not selected, Sea Plot omits those
data points from plot. See illustration below.

——F Flot zcans marked bad by loop edit

Plot scans marked bad by loop edit selected.
Lift pen over bad data not selected.

Hep | oK,

IEI
Scans to skip between points ||:| N

[ Lift pen over bad data\

Cahcel | R

X

Total number of scans to process.
|

Skip this number of scans between
each scan to plot.

Example: If Scans to process is 10 and
Scans to skip at start is 2, Sea Plot
plots every other scan (scans 0, 2, 4, 6,
and 8).

Create a discontinuous line:

o Lift pen over data marked with bad
flag in Wild Edit, and

Lift pen over scans marked with

bad flag in Loop Edit (if Plot scans

badflag from
o WILD EDIT
(not plotted)

badflag from
LOOP EDIT

marked bad by loop edit was
not selected).
See illustration below.

Plot scans marked bad by loop edit not selected.
Lift pen over bad data not selected.

Plot scans marked bad by loop edit selected.
Lift pen over bad data selected.

badflag from

LOOP EDIT

(not plotted)
(o}

badflag from
OWILD EDIT
(not plotted)

<

badflag from

LOOP EDIT
badflag from
o WILD EDIT
(not plotted)

Plot scans marked bad by loop edit not selected.

Lift pen over bad data selected.

N

badflag from

LOOP EDIT

(not plotted)
o

~

badflag from
oWILD EDIT
(not plotted)
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Overlay Setup

If an overlay plot type is selected on the Plot Setup tab, the Overlay Setup
button is enabled. If clicked, the following dialog box appears:

Overlay Setup x|

Axis offsets define distance to separate plot from

each file, for each axis. Offset units match axis wiz 1 offsat I—
units. For example, if Axis 1 is temperature in °C, a e

0.2 offset means that file 1 plots at actual data Buis 2 offset ID.DE

points, file 2 plots at 0.2 °C more than actual data :

points, file 3 plots at 0.4 °C more than actual data Az 3 offset |1

points, etc. This creates a waterfall effect and allows :

user to see changes in shape that would be difficult Auis 4 offset [

to see if plots were not offset from each other.
Note: Axis offsets are not applicable for TS plots.

Line Cal Select line colors for each
Ing c'm'":l— axis, for each file. See below.

LLine Symbols,.. |
Select line types for each axis,
;l— for each file. See below.

Select line symbols for each axis, for each file.
Applicable if Monochrome Plot or Plot symbols
only selected on Plot Setup tab. See below.

ine Types...

Help | Ok, I Eancell

Line Colors

Double click on an axis heading to select a range of colors for that
axis, for all files. Color wheel dialog box appears (see below).

Double click on
a file (Set)
heading to
select a range of
colors for that
file, for all axes.

# .ﬂnlis 1 Kowiz2 | Karzd | xbuzd

Double click on a box to pick a

Color wheel color for selected axis in
dialog box selected file. Color dialog box
appears appears; select desired color
(see below). and click OK.

Defaults I

Help

Note:

If more than 10 files
were selected on the
File Setup tab, Sea
Plot repeats the colors
defined for files 1-10.
For example, if 20 files
were selected, files 1
and 11 have the same
color, 2 and 12 have
the same color, etc.

Select Starting Color I ID.DD .
Select Ending Color | [30.00 []

/Bightness |-|2 vl [T Advance clockwise

lor

ast bright;

Help |

[u]4 | Cancel |
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Click Select Starting Color and click desired

color in color wheel; then click Select Ending

Color and click desired color in color wheel.

Sea Plot calculates evenly spaced colors

(10 evenly spaced colors if you selected an

axis or 4 evenly spaced colors if you selected

a file).

¢ Advance clockwise not selected: Sea Plot
calculates colors moving counterclockwise
around circle from starting to ending color.

e Advance clockwise selected: Sea Plot
calculates colors moving clockwise around
circle from starting to ending color.

To set 1 color for all selected lines, click Select
Starting Color and enter desired color value in
box; then tab to Select Ending Color box and
enter same value again.
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Line Symbols

Double click on axis heading to select same line symbol for that axis, for all
files. Line symbol dialog appears; make desired selection and click OK.

Line Symbols

Double click on file (Set)
heading to select same
line symbol for that file,
for all axes. Line symbol
dialog appears; make
desired selection and
click OK.

Note:

If more than 10 files were
selected on the File Setup
tab, Sea Plot repeats the line
symbols and types defined for
files 1-10. For example, if

20 files were selected, files 1
and 11 have the same line
symbol and type, 2 and 12
have the same line symbol
and type, etc.

Set # iz * Dz 2

1 Salid Circle * | Solid Upward Trianagle -

2 Solid Circle * | Solid Upward Triangle -

e 3 Solid Circle * | Solid Upward Triangle -

4 Solid Circle * | Solid Upward Triangle - Pull down on box to
5 Salid Circle * | Solid Upward Triangle -. pick line symbol for
B Solid Circle ~ | Solid Upward Triangle - selected axis in

7 | Solid Circle « | Solid Upward Triangle = selected file.

2 Solid Circle * | Solid Upward Triangle -

9 Solid Circle * | Solid Upward Triangle -

10 Salid Circle * | Solid Upward Trianagle -

| | ]
Defaults I Help | k. Cancel
Line Types

Double click on axis heading to select same line type for that axis, for all
files. Line type dialog appears; make desired selection and click OK.

109

Set # iz » Lz 2
1 Thin Solid i = | Thin Solid 5
Eougﬂe click Cin file (Set) lm—2 Thin Solid Thin Solid
eading to select same - 1 - 5
line type for that file, for 3 Th!n SD'!d Th!n 5'3'!':1 Pull down on box to
all axes. Line type 4 Thin Solid Thin Salid pick line type for
dialog appears; make 5 Thin Solid Thin Solid selected axis in
i i lected file.
gltie(:sll(r((e)dgelectlon and 5 Thin Solid Thin Solid selected file
7 Thin Solid Thin Solid
8 Thin Solid Thin Solid
3 Thin Solid Thin Solid
10 Thin Solid Thin Solid
4| ]
Defaults | Help | Ok I Cancel



Section 8: Data Plotting Module — Sea Plot

TS Plot Setup

If a TS plot type is selected on the Plot Setup tab, the TS Plot Setup button is
enabled. The TS Plot Setup defines the contour lines for the plot; the user

selects from the following contour types:

e  Density contours — Sea Plot calculates and plots sigma-t contours
if temperature is plotted, or sigma-theta contours if potential
temperature is plotted (see Axis Setup Tabs below for selection of

temperature parameter).
e  Thermosteric anomaly contours

The units for the parameters in the input data file do not affect the contour
calculations. For example, temperature could be in °C or °F, ITS-90 or
ITS-68; Sea Plot performs the required conversions to calculate the contours.

The following table defines the required input parameters for various

combinations of temperature, salinity, and contours:

To plot:

Input .cnv file must
include:

temperature, salinity, density sigma-t  or
temperature, salinity, thermosteric anomaly

temperature, salinity

temperature, derived salinity, density sigma-t  or
temperature, derived salinity, thermosteric anomaly

temperature,
conductivity, pressure

potential temperature, salinity, density sigma-theta  or
potential temperature, salinity, thermosteric anomaly

potential temperature,
salinity

potential temperature, derived salinity, density sigma-t  or
potential temperature, derived salinity, thermosteric anomaly

potential temperature,
temperature *,
conductivity, pressure

*Derived salinity requires actual temperature in the input file. Potential
temperature cannot be used in calculation of derived salinity.

If the TS Plot Setup button is clicked, the following dialog box appears:

Variable to be calculated and plotted on

contour lines — density (sigma-t or sigma-theta) | g Efis] AU AT A
or thermosteric anomaly. These variables are -

calculated by Sea Plot from data in input file,
and do not need to be in input file.

X

Contour wanable I Diensity [K.g/m ™3]

=)

Significant digits to right of decimal
point for contour line labels.

Starting contour value

Define contour line smoothness
(10 = least smooth, 200 = smoothest).

Starting contour value is lowest value
of contour variable to be plotted. First

|20
Contavr inkeryal ||:|_1 ; contour line is plotted at this value;
\

subsequent lines are plotted at every

Significant digits (0 - 10 |2 Contour Interval.

Type size of contour line labels
(1 = smallest, 10 = largest).

[ Paints per line (10 - 2000 I‘”:I Distance of contour line labels from

Eabel o % Y axis as a % of X axis size
abel pozition < |5 —— (0% = label contour lines on Y axis,

100% = label contour lines at far

| T Label size [1 - 10) |@ right of plot).

Select contour line color for color plots.
Button is not enabled if monochrome plot was
selected on Plot Setup tab.

| — Contour line colar... I.

Contour line type I Medium\ﬂ\ |
Select contour line thickness.

Help | ] I Eancell
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Sea Plot Axis Setup Tabs

Each Axis Setup tab defines a plot variable, scale, and line type.

Axis tabs are labeled X Axis and Y Axis if an X-Y plot was selected on
the Plot Setup tab.

Axis tabs are labeled Temperature and Salinity if a TS plot was selected
on the Plot Setup tab.

X-Y Axis Setup Tabs

An Axis Setup tab looks like this for X-Y plots (X Axis 2 tab shown;
other axis tabs are similar):

Drop down list includes all variables in data (.cnv) file. Sea Plot indicates range of data for selected variable, to assist setup of plot scale.
Range is full range of data in file(s), and does not reflect your selection of Scans to process, Scans to skip at start, Scans to skip
between points, etc. in Process Options dialog box. If file contains data collected while instrument was in air, range reflects these values. If
multiple files were selected on File Setup tab, range is lowest value in all files to highest value in all files. If selected variable is derived
salinity or derived density, variable range shown is 0 to 0, because Sea Plot does not know derived salinity or density values until you click
Start Process and it begins to calculate derived values.

Order in drop down list reflects order of variables in file. If file contains multiple occurrences of a variable (for example, you calculated
salinity in Data Conversion and then again in Derive, after aligning and filtering data), list adds a suffix (1%, 2", 3", etc.) to variable name;
do not confuse this with labeling for data from duplicate sensors (for example, Salinity, 2 [PSU] 1™ is first occurrence in file of salinity
calculated from secondary temperature and conductivity sensor data). Make sure to select desired variable for plotting.

=10 x|

Include this axis in plot. Sea Plot [ilaElgule BN
can plot up to 5 variables (1 Y File  Options  Help
and 4 X, or1 X and 4 Y). At least
1 X and 1Y variable is required,
so this selection is available only
on Axis Setup tab for third,
fourth, and fifth axis.

Note: If you deselect an axis, all
axes numbered above that axis

File Setup | Plot Setup | * duis | % duis 7 | is 3| 3¢ wis 4| Header view |

— ¥ Include axis

Wariable Canductivity [S/m]

are automatically deselected. Select desired Line type, color,

and symbol.
Selection of color or monochrome

Yariable range iz from 2. 887419 to 3. 666363,

Select to label axis with variable *

name as listed in drop down
Variable list, or enter a Custom
label for axis.

— v Label axiz with variable name

Custom label I

Line type | Thin Solid =] /

Auto range: Sea Plot selects
axis Minimum and Maximum
values, number of Major
divisions on axis, and number
of Minor divisions between
major divisions.

Auto divisions: Sea Plot
selects number of major
divisions on axis, and number
of minor divisions between
major divisions. User

selects axis Minimum and
Maximum values.

Any values that fall outside user-
selected Minimum to Maximum
range will plot at minimum or
maximum, as applicable.

Lire Calar... | . Line spmbol |5._-.|..-J pward Triangls

plot, and inclusion of symbols in plot,
is made on Plot Setup tab, and
applies to all axes.

If an overlay plot was selected on
Plot Setup tab, line type, color, and
symbol are grayed out — select these
for all files using Overlay Setup
button on Plot Setup tab.

Scaletype: €% Linear  Log

Plot this axis on linear or logarithmic scale.

IV Auta range

¥ uto divisions M ajor Mircr

o

Minirnurn ||:|_|;||_'||;||_'| [ =R |'||:|_;;||:||:||:|
Il_

|_F‘E%sc:ale direction
Plot axis from highest to lowest value. Typically

used when pressure or depth is plotted on Y axis,
so pressure / depth starts at 0 at top of plot and
increases as you move down vertically.

Start Process E xit

I Cancel
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TS Plot Axis Setup Tabs

An Axis Setup tab looks like this for TS plots (Temperature axis tab shown;
Salinity axis tab is similar):

Drop down list includes all applicable variables in data (.cnv) file - temperature and potential temperature (for Temperature tab) and salinity
(for Salinity tab), as well as derived salinity (for Salinity tab). Sea Plot indicates range of data for selected variable, to assist you in setup of
plot scale. Range is full range of data in .cnv file(s), and does not reflect your selection of Scans to process, Scans to skip at start,
Scans to skip between points, etc. in Process Options dialog box. If file contains data collected while instrument was in air, range reflects
these values. If multiple files were selected on File Setup tab, range is lowest value in all files to highest value in all files. If selected
variable (on Salinity tab) is derived salinity, variable range shown is 0 to 0, because Sea Plot does not know derived salinity values until
you click Start Process and it begins to calculate derived values.

Order in drop down list reflects order of variables in file. If file contains multiple occurrences of a variable (for example, you calculated
salinity in Data Conversion and then again in Derive, after aligning and filtering data), list adds a suffix (1%, 2", 3", etc.) to variable name;
do not confuse this with labeling for data from duplicate sensors (for example, Salinity, 2 [PSU] 1* is first occurrence in file of salinity
calculated from secondary temperature and conductivity sensor data). Make sure to select desired variable for plotting.

== Sea Plot, Beta 1.2a
File Options  Help

=10l x|

File Setupl Plot Setup  Temperature L4 alinity Header"-.-‘iewl

Wariable ITemperature [ITS-EIEL/deg C] j
Warniable range is from 0.9556 to 11,7613, Select desired Line type, color,
Select to label axis with variable and symbol.
name as listed in drop down 7 Labil itk eaicibi ¢ Selection of color or monochrome
Variable list, or enter a Custom lalehetd il A plot, and inclusion of symbols in plot,
label for axis. \C label is made on Plot Setup tab, and
uistomn labe I applies to all axes.
o If an overlay plot was selected on
: Plot Setup tab, line type, color, and
Line type |Thin % alid j / symbol are grayed out — select these
for all files using Overlay Setup
Line Colar... I . Line =yrnbol |":i.:.||d Cicle button on Plot Setup tab.
Scaletppe: F Linesr € Log
« Auto range: Sea Plot selects 47 Auta range Minimum [0 oo Masimum [0 0000
axis Minimum and Maximum
values, number of Major ¥ suto dvizions b ajar Igr Mirar |1
divisions on axis, and number
of Minor divisions between T Reverse scale direction

major divisions.

e Auto divisions: Sea Plot
selects number of major
divisions on axis, and number
of minor divisions between
major divisions. User
selects axis Minimum and
Maximum values.

Any values that fall outside user-

selected Minimum to Maximum

range will plot at minimum or
maximum, as applicable.

Start Process Exit I Caticel
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Sea Plot Header View Tab

The Header View tab allows you to view the existing header in the input
file(s). The Header View tab looks like this:

(=T

File Options Help
File Setup | Plot Setup | ¥ Asis | %uis1 | %asis 2] 9w 3| Kbuis 4 HeaderView |
1

View existing header in input file(s). If multiple input files are to be processed,
switch between input file headers by using Prior and Next buttons.

* Sea-Bird SBE 25 Data File: -
* FileM arne = NCTLO2ENBOO.HE

* Software Yerzion 4. 246

* Temperature Sk =2339

* Conductivity SMN = 1897

*Syztem pload Time = Sep 27 2000 22:06:04

= Ship:

= Cruise: - — - -

= Shatiar e Header lines beginning with * contain header

| ahbude: information copied from raw input data file.

* Longitide: o Header lines beginning with # contain header

"ds information describing input converted data (.cnv) file

*SBEZ5CTD W 4.0b5SM  (not applicable to example shown). As each module is
* emternal pressure senzol  run, it adds information to the header, such as the input
*utal = 3437338 clk =3] file name for the module, date and time the module
*hoaste=2 szamples =4 was run, and input parameters. Thus, the header

: ) . contains a complete record of how the data has been

* CTD configuration; converted, edited, and manipulated.

*rumber of scans averad, oSl string *END* flags end of header information.
* 1eal time data transmitte

* rriinimum conductivity fregquency for prump turnon =10
* purmp delay = 45 zeconds

* battery bype = ALKALIME

* 4 gxternal voltages sampled

*ztored voltage # 0 = external voltage O _ILI
4| | »

Start Process | E it I Cancel |
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Viewing Sea Plot Plots

Shown below are three examples:

e  Multiple X-Y plots, no overlay

e  Multiple TS plots, no overlay

e X-Y overlay plot

Following the examples is a detailed description of the plot’s menus.

Multiple X-Y Plots, No Overlay

B Sea Plot View. 1/3

Output  Options  View \

Test Plot, KBOO1 .CNV‘

=1 x|

0.0+

2.5

5.0+

7.5

db]

100+
]

Pressure

1289

1504

1759

20.04

If plotting multiple files, title bar indicates which file number is
shown and total number of files plotted. Use View menu or
keyboard Arrow, Home, or End keys to switch between files.

Zoom in to enlarge details by clicking and dragging
to select a rectangular area. You can zoom in
several times before reaching program limits. Undo
zoom by selecting Undo Zoom in View menu.

Double click on axis or axis label (temperature,
pressure, etc.), and appropriate Axis Setup tab
appears, allowing you to make changes and
reprocess data with new plotting parameters.

Double click on plot title, and Plot
Setup tab appears, allowing you to
make changes and reprocess data.

\I< 110

3]
Temperature [ITS-68, deg C]
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Multiple TS Plots, No Overlay

If plotting multiple files, title bar indicates which file number is
shown and total number of files plotted. Use View menu or
keyboard Arrow, Home, or End keys to switch between files.

£ Sea Plot View, 1/14 =13

Cutput  Options  View
DI10011.cnv w_

Contour lines — example reflects following
choices in TS Plot Setup dialog box:

o Contour variable - density (so Sea Plot Double click on plot title, and Plot

calculated and plotted sigma-t). | _———|Setup tab appears, allowing you to
e Contour interval - 0.2 make changes and reprocess data. |——|
o Significant digits — 2

e Label position — 5%

., salinity), and appropriate Axis Setup tab appears,
= __{allowing you to make changes and reprocess data
with new plotting parameters.

&)
% O 880
5
g ;L Zoom in to enlarge details by clicking and dr_agging
oL to select a rectangular area. You can zoom in
E_r several times before reaching program limits. Undo
g #_ A& zoom by selecting Undo Zoom in View menu. |
5oL ;
ST ym é-
FoE "E'-\

Pl Double click on axis or axis label (temperature or

7.40

i

]
Il

I | I I I | I I
34.35 34.40 3445 34.50 \44.55 34,50 34,85 34,70 34.75 34.80
Salinity [PSU]
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Section 8: Data Plotting Module — Sea Plot
X-Y Overlay Plot

In View menu, select Show Plot Legends to view complete list of Double click on plot title, and Legend shows line color and
file names and plot colors or plot symbols (if monochrome plot was Plot Setup tab appears, type for each axis in first file
selected on Plot Setup tab). You can highlight 1 line, all lines in allowing you to make if Show line legends selected
1 file, or 1 line in all files with color or line symbol. See below. changes and reprocess data. on Plot Setup tab.
B% Sea Plot Yiew, Dverlay = | & ll
Qutput  Options  View

2a3A6d.c

Temperature [T3-90, deg C] Ceygen Current, BeckmanY'S1 [ud]
Oxygen Current BeckmanNSI LIA]

Base lines (from first file) plotted at actual
data points. Other lines are offset from base
10004 line by amounts defined in Overlay Setup

L dialog box (access from Plot Setup tab).

1500+
_ Zoom in to enlarge details by clicking and dragging
& to select a rectangular area. You can zoom in
= several times before reaching program limits. Undo
o 2000+ zoom by selecting Undo Zoom in View menu.
wn
o
i}
w
C
u
5 2o
r
E
'_

3000+

L Double click on axis or axis label
= (temperature, time, etc.), and

= appropriate Axis Setup tab
3500+ appears, allowing you to make

I changes and reprocess data with ;
r new plotting parameters. RS 5 i

| | | | | | | |
5.0 T 1on 1248 \4 15.0 1748 200 235 250
Temperature [ITS-80, deg C]

If you select Show Plot Legend in the View menu, the Plot Legend dialog box
shows the color for each line in each file, and allows you to apply a highlight
color to a selected line or lines. The dialog box looks like this:

Note:
If Monochrome plot or
Plot symbols only were

selected on the Plot Plot Legend (=1

Setup tab, the Plot Click to select desired Double click on axis
:ggﬁ?ﬂg'gﬁsz??nz?gf highlight color. ~Highlight Calor.. | [ | {neading, and all ftes for
. Color dialog box selected axis change to
of eaCh line color, and appears; make : highlight color.
provides for user selection and click OK. 2 Aiis |
selection of a highlight 2a3A6d.cny
symbol instead of a TRl e DOCl]JbIel C"tdeon color,
iahli i i = ¢ __and selected axis in
highlight color. E;rl;zl‘eacr:ldc;?“;gz T _cadadeny | : = | |selected file changes
(all axes) for selected @__ to highlight color.
file change to
highlight color. Help | Cancel |

With the highlight color applied, you can view the plot on screen and output to
the printer, file, or clipboard. When you click Cancel in the Plot Legend dialog
box, the colors return to what they were before you applied the highlight.
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Plot Menus
The Sea Plot View window’s menus are described below:

Output - Directs Sea Plot to output plot now to printer, clipboard, or a file. If
multiple files are plotted (but not as an overlay), you can output plot shown on
screen or plots for all files. How plot is output (size, file type, etc.) is
controlled by Options menu.

Options - Sets up how plot is output to printer, clipboard, or a file.
e Print-
» Orientation — landscape, portrait, or print driver default
»  Print full page - scale plot to fit 8 1/2 x 11 inch page. If not selected,
Size determined by -
Sea Plot View Dimensions - dimensions of plot as shown on screen
File Setup tab entries - entries on File Setup tab for Width and Height
Values Entered Below - dimensions entered in dialog box (in mm)
o File-
» Data format - Metafile (.wmf), Jpeg (.jpg), or Bitmap (.bmp)
»  Size determined by
Sea Plot View Dimensions - dimensions of plot as shown on screen
File Setup tab entries - entries on File Setup tab for Width and Height
Values Entered Below - dimensions entered in dialog box (in mm)
e Clipboard -
» Data format - Metafile (.wmf), Jpeg (.jpg), or Bitmap (.bmp)
»  Size determined by -
Sea Plot View Dimensions - dimensions of plot as shown on screen
File Setup tab entries - entries on File Setup tab for Width and Height
Values Entered Below - dimensions entered in dialog box (in mm)

View — Sets up viewing options.

e Show cursor position — Directs Sea Plot to show the coordinates of the
cursor as you move the cursor around when viewing a plot.

e Next Plot, Prior Plot — Directs Sea Plot to switch between plots, if you
selected multiple files on File Setup tab but are not doing an overlay plot.

e File name — Lists, and allows you to select from, all input files, if you
selected multiple files on File Setup tab but are not doing an overlay plot.

e Show plot legends — For overlay plots only, allows you to view a complete
list of file names and plot colors or plot symbols (if monochrome plot was
selected on Plot Setup tab).

e Undo Zoom — Directs Sea Plot to return plot to original ranges specified
on Axis Setup tabs. Undo Zoom is grayed out unless you have zoomed in
(by clicking and dragging to select a rectangular area) to enlarge details.

e Set Zoomed Ranges — Directs Sea Plot to substitute current zoomed ranges
of plot for Minimum and Maximum plot ranges on Axis Setup tabs. This
gives you ability to save ranges of zoomed view, so you can go to exactly
same view next time you run Sea Plot. Set Zoomed Ranges is grayed out
unless you have zoomed in (by clicking and dragging to select a
rectangular area) to enlarge details.
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Section 9: Miscellaneous Module —
SeacalcW

SeacalcW is a seawater calculator that computes a number of derived variables
from one user-input scan of temperature, pressure, etc.

The dialog box looks like this:

& Seacalcw Yersion 1.0 B ] |

- Depth, salt(m) = 2.983
Enter temperature in ITS-68 or ITS-90. FREEE Y e D tFI': i h( )_ 3059

SeacalcW automatically computes other Temp (ITS-68) = 2.000000 _ SR, A(m) -
parameter. < T T Sigmart (kgfm"3) = 3964391
Temp (ITS-40) = Uil Sigratheta (ko/m”3) = 39.64394
Enter conductivity or salinity. SeacalcW Conductivity (S/m] = 4.200000 Sigmarref (kg/m”3) = 39.64394
automatically computes other parameter. Salinity (PSU) = k352440 Fot Temp (ITSES deg C) = 1.99376
Reference Press (dbar) = 0.0 Sound YWel. Chen (m/s) = 1477.343
: . Sound Vel Wilson (mfs) = 1475.656

Used to compute Sigma-ref. L Latitude (Ded) = 0o

alitude (Deg) Sound Vel DelGrosso (mys) = 1477.160

Used to compute gravity and
salt water depth.

Choygen Saturation (mlfl) = 6.926
Gravity (myfs"2) = 9.780318

Help |/Ealculate| Spec Yol Anom (m”~3Kg1078) =-1073.347

Click to calculate derived variables.

SeacalcW remembers whether the user last changed conductivity or salinity,
and calculates other parameters based on this. For example, if you change
conductivity, salinity is recalculated; if you then change temperature, salinity
is recalculated again (based on the input conductivity and temperature).
Conversely, if you change salinity, conductivity is recalculated; if you then
change temperature, conductivity is recalculated again (based on the input
salinity and temperature).

See Appendix V: Derived Parameter Formulas for formulas used
by SeacalcW.
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Appendix I: Command Line Options,

Command Line Operation, and

Batch File Processing

Command Line Options

Notes:

Command line options can be used to assist in automating processing, by

e The default program setup (.psa) file
is the last saved .psa file for

the module. PostProcSuite.ini
contains the location and file name
of the last saved .psa file for each
module. PostProcSuite.ini is in
%USERPROFILE%\

Local Settings\Apps\Sea-Bird\
(example

c:\Documents and
Settings\dbresko\Local Settings\
Apps\Sea-Bird\PostProcSuite.ini).
Versions 5.30a and earlier of SBE
Data Processing used program
setup files with a .psu extension
instead of a .psa extension. Program
setup files with a .psa extension can
be opened, viewed, and modified in
any text editor or XML editor. SBE
Data Processing can still use your
existing .psu files. However, if you
make any changes to the setup (for
example, change output variables),
SBE Data Processing will save the
changes to a new .psa file.

overriding information in an existing program setup (.psa) file or designating a
different .psa file.

Access the Command Line Options dialog box by selecting Command Line
Options in the SBE Data Processing window’s Run menu:

E=E SBE Data Processing 18]l
Run  Configure  Help

1. Dakta Conversian..,
. Filter. ..,

. Align CTD...

. Zell Thermal Mass., ..
. Loop Edit. ..

, Detive,..

. Bin Average. .,

b SR VT o) R R o N )

3. Bottle Summary. ..
9, Mark Scan. ..
P 10, Buo'yancy'. ..
11, Wwild Edit. ..
12, Window Filker, ..

13, ASCIT In...
14, ASCIT Out. ..
15, Section. ..
16, Split...

17, Skrip. .,

1. Translate...

19, SeaPlat, ..

20, Seacalcw Yersion 1.0..,

Command Ling Opkions, , .

Exit

The Command Line Options dialog box looks like this:

Command Line Options ] EI

Optiohs ||

[ Ao start

Ok I Cancel
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The option parameters are:

Parameter Description

Use String as instrument configuration (.con) file. String must
include full path and file name.

Note: If using this parameter, you must also specify input file
name (using /iString).

/eString

Use String as input file name. String must include full path and

file name.

The /iString option supports standard wildcard expansion:

e 7 matches any single character in specified position within
file name or extension.

e *matches any set of characters starting at specified position
within file name or extension and continuing until end of
file name or extension or another specified character.

/iString

/oString |Use String as output directory (not including file name).

/fString  |Use String as output file name (not including directory).

/aString | Append String to output file name (before extension).

Use String as Program Setup (.psa) file. String must include full

/pString path and file name.

Use String to define an additional parameter to pass to Module.
Not all modules have x parameters; see module descriptions.
If specifying multiple x parameters, enclose in double quotes
and separate with a space; do not specify x parameter more
/xModule: |than once.

String  |Example: Run Data Conversion, telling it to skip first
1000 scans, and also run Window Filter, telling it to output
difference between original and filtered value:
/x“datenv:skip1000 wfilter:diff” Correct
/xdatenv:skip1000 /xwfilter:diff Incorrect

If specifying multiple parameters, insert one or more spaces or tabs
between each parameter in the list.

Example: You set up and saved .psa files for Filter, Loop Edit, Bin Average,
and Derive within each module’s dialog box, and ran each module
successively. The input and output file names in all the .psa files were the
same - c:\Ist\test.cnv (this has the effect of overwriting the module input with
the module output).

You now want to run each process again, using a different input and output
file - c:\2nd\test1.cnv. You enter the following in SBE Data Processing’s
Command Line Options dialog box:

/ic:\2nd\testl.cnv /ftestl.cnv /oc:\2nd

When you pull down on the Run menu and select Filter, you see in the Filter
dialog box that the program substituted c:\2nd\test1.cnv for c:\Ist\test.cnv as
the input data and output data path and file. Similarly, testl.cnv is shown as
the input and output data file in all the modules. You can run each process
rapidly in succession, without needing to enter the new path and file name

individually in each module.
Note:

If you do not select Auto Start,
when you select a module the
module dialog box appears,

allowing you to review the selected . . .
input files and data setup before Select this and then select the desired module to have SBE Data Processing

beginning processing. automatically run the module with the last saved setup parameters (defined by
the .psa file) and any entered Command Line Options.

Auto Start (for running a module)

e Ifyou select Auto Start, a Run Minimized selection box appears. If
selected, SBE Data Processing minimizes its window while processing the
data, allowing you to do other work on the computer. When processing is
complete, the SBE Data Processing window reappears.
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Command Line Operation

The following modules can be run from the command line (default location for
files is c:\Program Files\Sea-Bird/SBEDataProcessing-Win32):

Module Executable File Name
Align CTD AlignCTDW.exe
ASCII In ASCII InW.exe
ASCII Out ASCII OutW.exe
Bin Average BinAvgW.exe
Bottle Summary BottleSumW.exe *
Buoyancy BuoyancyW.exe
Cell Thermal Mass CellTMW .exe
Data Conversion DatCnvW.exe
Derive DeriveW .exe
Filter FilterW.exe
Loop Edit LoopEditW.exe
Mark Scan MarkScanW.exe
SeacalcW SeacalcW.exe
Sea Plot SeaPlotW.exe
Section SectionW.exe
Split SplitW.exe
Strip StripW.exe
Translate TransW.exe
Wild Edit WildEditW.exe
Window Filter W _FilterW.exe

Notes:

e The default program setup (.psa)
file, used when running a module
from the command line, is the last
saved .psa file for the module.
PostProcSuite.ini contains a list of
the location and file name of the last
saved .psa file for each module.
PostProcSuite.ini is in
%USERPROFILE%\

Local Settings\Apps\Sea-Bird\
(example

c:\Documents and Settings\dbresko\
Local Settings\Apps\Sea-Bird\
PostProcSuite.ini).

¢ Versions 5.30a and earlier of
SBE Data Processing used program
setup files with a .psu extension
instead of a .psa extension. Program
setup files with a .psa extension can
be opened, viewed, and modified in
any text editor or XML editor. SBE
Data Processing can still use your
existing .psu files. However, if you
make any changes to the setup (for
example, change output variables),
SBE Data Processing will save the
changes to a new .psa file.

* Bottle Summary’s executable file name was previously RosSumW.exe.

BottleSumW.exe will run if BottleSumW.exe or RosSumW .exe is typed on

command line.

Command line parameters can be used to override existing information in the
.psa file. The command line parameters are:

Parameter

Description

/eString

Use String as instrument configuration (.con) file. String must
include full path and file name. Note: If using /cString, must
also specify input file name (using /iString).

/iString

Use String as input file name. String must include full path and

file name.

This parameter supports standard wildcard expansion:

e ? matches any single character in specified position within
file name or extension

e *matches any set of characters starting at specified
position within file name or extension and continuing until
end of file name or extension or another specified character

/oString

Use String as output directory (not including file name).

/fString

Use String as output file name (not including directory).

/aString

Append String to output file name (before file name extension).

/pString

Use String as Program Setup (.psa) file. String must include full
path and file name.

/xModule:
String

Use String to define an additional parameter to pass to Module.
Not all modules have x parameters; see module descriptions.

If specifying multiple x parameters, enclose in double quotes
and separate with a space.

Example: Run Data Conversion from command line, telling it to
skip first 1000 scans: datcnvw.exe /xdatcnv:skip1000

/s

Start processing now.

If specifying multiple parameters, insert one or more spaces or tabs
between each parameter in the list.
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Note:

If you have not modified your
autoexec.bat file to put the .exe
files in the path statement, specify
the full path of the .exe file in the
Run dialog box.

Example: The specified input file directory contains test.dat, testl.dat, and
test2.dat. Select Run in the Windows Start menu. The Run dialog box appears.

Run

== Type the name of a program, folder, documen, of [rtemet
resource; and Windows will aper it for yau.

1l

Oper: |datcnvw. ewe ftest” dat /s

Concel | Browse.. |

:I

For the command line shown (datcnvw.exe /itest*.dat /s), SBE Data
Processing will process test.dat, testl.dat, and test2.dat using Data Conversion.
If the ? wildcard symbol is used (datcnvw /itest?.dat) instead of the *, Data
Conversion will process only testl.dat and test2.dat.

Batch File Processing

Note:

A duplicate copy of SBEBatch.exe
is placed in the Windows folder
when SBE Data Processing is
installed. This allows the user to run
SBEBatch.exe from anywhere,
without having to specify its path.

Note:
SBEBatch can also launch system

Traditional DOS batch file processing cannot be used with the 32-bit
processing modules because Win 95/98/NT/2000/XP will start the second
process before the first process is finished. The program SBEBatch.exe
(default location c:\Program Files\Sea-Bird\SBEDataProcessing-Win32) or the
Windows Scripting Host can be used to process a batch file to automate data

processing tasks. The format for SBEBatch is:

sbebatch filename parameters

The parameters are referenced in the batch file in the same way as the DOS
batch file, using the percent sign (%) followed by numbers 1 through 9. %1 in
the batch file is replaced by the first command line parameter, %2 in the batch
file is replaced by the second command line parameter, and so on until %9.

Each line in the batch file contains the process name followed by command

line arguments. The process names are:

commands, such as copying or Module Process Name
renaming a file, deleting a file from Align CTD Alignetd
an intermediate step, etc. ASCII In Asciiin
Additiqnally, it can launch non- ASCII Out Asciiout
Sea-Bird programs, such as Word - 2
Pad. If you call a program that does Bin Average Binavg
not run and then shut down Bottle Summary Bottlesum *
automatically, such as Word Pad, Buoyancy Buoyancy
you must manually close the Cell Thermal Mass Celltm
program before batch processing Data Conversion Datenv
will continue to the next step. ; -
Derive Derive
Filter Filter
Loop Edit Loopedit
Mark Scan Markscan
Sea Plot Seaplot
Section Section
Split Split
Strip Strip
Translate Trans
Wild Edit Wildedit
Window Filter Wrilter

* Bottle Summary’s process name was previously Rossum. Bottlesum will run if

Bottlesum or Rossum is used in the batch file.
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Notes:
e The default program setup (.psa) file
is the last saved .psa file for the

module. PostProcSuite.ini contains a

list of the location and file name of
the last saved .psa file for each
module. PostProcSuite.ini is in
%USERPROFILE%\
Local Settings\Apps\Sea-Bird\
(example
c:\Documents and Settings\dbresko\
Local Settings\Apps\Sea-Bird\
PostProcSuite.ini).

¢ Versions 5.30a and earlier of SBE
Data Processing used program
setup files with a .psu extension

instead of a .psa extension. Program

setup files with a .psa extension can
be opened, viewed, and modified in
any text editor or XML editor. SBE
Data Processing can still use your
existing .psu files. However, if you
make any changes to the setup (for
example, change output variables),
SBE Data Processing will save the
changes to a new .psa file.

The batch file can also contain comment lines to document the file purpose.
Any line beginning with @ is a comment line, and does not affect the results.

Parameters specified in the batch file can be used to override existing
information in the .psa file. These parameters are:

Parameter

Description

/cString

Use String as instrument configuration (.con) file. String must
include full path and file name.

Note: If using /cString, must also specify input file name
(using /iString).

/iString

Use String as input file name. String must include full path

and file name.

This parameter supports standard wildcard expansion:

e 7 matches any single character in specified position within
file name or extension

e *matches any set of characters starting at specified
position within file name or extension and continuing
until the end of file name or extension or another
specified character

/oString

Use String as output directory (not including file name).

/fString

Use String as output file name (not including directory).

/aString

Append String to output file name (before extension).

/pString

Use String as Program Setup (.psa) file. String must include
full path and file name.

/xModule:
String

Use String to define an additional parameter to pass to
Module. Not all modules have x parameters; see module
descriptions. If specifying multiple x parameters, enclose in
double quotes and separate with a space.

Example: Run Data Conversion, telling it to skip first

1000 scans:  /xdatenv:skip1000

w

Wait for user input at start of Module, allowing user to review
setup before processing data for a particular Module. After
reviewing setup, user clicks Start Process in Module dialog
box to continue.

/d

Pause processing data at end of Module, allowing user to
review output from a particular Module before continuing with
rest of processing.

If specifying multiple parameters, insert one or more spaces or tabs
between each parameter in the list.

Parameters specified on the Run line can also be used to control the process:

#m

Minimize SBE Data Processing window while processing
data, allowing you to do other work on computer.

#w

Wait for user input at start of each Module, allowing user
to review setup before processing data for each Module.
After reviewing setup, user clicks Start Process in Module
dialog box to continue.

#d

Pause processing data at end of each Module, allowing
user to review output from each Module before continuing
with rest of processing.
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Note:

For Sea Plot, enter the desired
choices in the File Setup, Plot
Setup, and Axis Setup tabs.

To process data using a batch file:

1.

Run each software module, entering the desired choices in the File Setup
and Data Setup dialog boxes. Upon completing setup, press Save or Save
As on the File Setup tab. The configuration is stored in the Program Setup

File (.psa).

2. Create a batch file to process the data.

Following are two examples of typical batch files.

Example 1 — Process Single File, and Save All Intermediate Files

The data file is c:\leg1\cast5.dat, and the .con file is c:\leg1\cast5.con.

1. Set up each software module, entering desired choices in Setup dialog
boxes. In the File Setup dialog boxes, delete the output file name (this
allows program to base output file name on input file name and any
appended text), and set the output file path as c:\legl.

2. Create a batch file named prcast.txt in c:\legl, which contains:

@ Lines starting with @ are comment lines

@ Comment lines have no effect on the result
datenv /ic:\leg1\%]1.dat /cc:\legl\%]1.con /a%?2
wildedit /ic:\leg1\%1%2.cnv /asl
filter /ic:\leg1\%1%2s1.cnv /as2
loopedit /ic:\leg1\%1%2s1s2.cnv /as3
derive /ic:\leg1\%1%2s1s2s3.cnv /cc:\legl\%]1.con /as4
seaplot /ic:\leg1\%1%2s1s2s3s4.cnv
Module names and options are separated by one or more spaces or tabs.

3. Select Run in the Windows Start menu. The Run dialog box appears.

4. Type in the program name and parameters as shown:
sbebatch c:\legl\prcast.txt cast5 testl
(batch filename is c:\leg1\prcastl.txt; parameter %] is cast5;
parameter %?2 is testl)

5. The data is processed as follows (all input and output files are in c:\legl):

Module Input File(s) Output File
Data Conversion cast5.dat
castStest]l.cnv
(datcnv) cast5.con
Wild Edit (wildedit) castStestl.cnv castStestlsl.cnv
Filter (filter) castStestlsl.cnv castStestlsls2.cnv
Loop Edit (loopedit) castStest1sls2.cnv castStest1s1s2s3.cnv

Derive (derive)

castStestlsls2s3.cnv
cast5.con

castStestls1s2s3s4.cnv

Sea Plot (seaplot)

castStest1s1s2s3s4.cnv

castStest1s1s2s3s4.jpg
(if File Setup tab was
set to output to jpeg)
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Example 2 — Process Several Files, and Overwrite All Intermediate Files

Process all data files in c:\legl. The data files are c:\legl\castl.dat and
c:\legl\cast2.dat, and the .con file is c:\legl\cast.con.

1. Set up each software module, entering desired choices in Setup dialog
boxes. In the File Setup dialog boxes, delete the output file name (this
allows program to base output file name on input file name and any
appended text). Set the output file path as c:\leg1.

2. Create a batch file named prallcasts.txt in c:\legl, which contains:

@ Lines starting with @ are comment lines
@ Comment lines have no effect on the result
datenv /i%1\*.dat /c%1\cast.con /0%l
wildedit /i%1\*.cnv /01%
filter /i%1\*.cnv /01%
loopedit /i%1\*.cnv /01%
binavg /i%1\*.cnv /aavg /0%l
derive /i%1\*avg.cnv /c%]1\cast.con /0%l
seaplot /i%]1\*.cnv
Module names and options are separated by one or more spaces or tabs.
3. Select Run in the Windows Start menu. The Run dialog box appears.
4. Type in the program name and parameters as shown:
sbebatch c:\legl\prallcasts.txt c:\legl
(batch filename is c:\leg1\prallcasts.txt; parameter %1 is c:\legl)
5. The data is processed as follows (all input and output files are in c:\legl):
Module Input File(s) Output File
castl.dat cast] cnv
Data Conversion (datcnv) cast2.dat ’
cast2.cnv
cast.con
. o . castl.cnv castl.cnv
Wild Edit (wildedit) cast2.cnv cast2.cnv
. castl.cnv castl.cnv
Filter (filter) cast2.cnv cast2.cnv
. . castl.cnv castl.cnv
Loop Edit (loopedit) cast2.cnv cast2.cnv
. . castl.cnv castlavg.cnv
Bin Average (binavg) cast2.cnv cast2avg.cnv
castlavg.cnv cast] cnv
Derive (derive) cast2avg.cnv ’
cast2.cnv
cast.con
castl.jpg
cast2.jpg
Sea Plot (scaplot) castl.env 2o pile Setup tab
cast2.cnv
was set to output
to jpeg)
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Appendix Il: Configure File Format

Note:
For an easier-to-read report of .con file Shown below is a line-by-line description of the .con file contents, which can
contents, see Appendix Ill: Generating be viewed in a text editor.
.con File Reports — ConReport.exe.
Line Contents
1 Conductivity sensor serial number
2 Conductivity M, A, B, C, D, CPCOR
3 Conductivity cell_const, series_r, slope, offset, use GHIJ coefficients?
4 Temperature sensor serial number
5 Temperature FO, A, B, C, D, slope, offset, use GHIJ coefficients?
6 Secondary conductivity sensor serial number
7 Secondary conductivity M, A, B, C, D, PCOR
8 Secondary conductivity cell_const, series r, slope, offset, use GHIJ coefficients?
9 Secondary temperature sensor serial number
10 Secondary temperature FO, A, B, C, D, slope, offset, use GHIJ coefficients?
11 Pressure sensor serial number
12 Pressure T1, T2, T3, T4, T5
13 Pressure C1 (A1), C2 (AD), C3, C4 (A2) - parameters in parentheses for strain gauge sensor
14 Pressure D1, D2, slope, offset, pressure sensor type, AD590 M, AD590 B
15 Oxygen (Beckman/YSI1 type) sensor serial number
16 Oxygen (Beckman/YSI1 type) M, B, K, C, SOC, TCOR
17 Oxygen (Beckman/YSI1 type) WT, PCOR, TAU, BOC
18 pH sensor serial number
19 pH slope, offset, VREF
20 PAR light sensor serial number
21 PAR cal const, multiplier, M, B, surface cc, surface r, offset
22 Transmissometer (SeaTech, Chelsea AlphaTracka, WET Labs Cstar) sensor serial number
23 Transmissometer (SeaTech, Chelsea AlphaTracka, WET Labs Cstar) M, B, path length
24 Fluorometer SeaTech sensor serial number
25 Fluorometer SeaTech scale factor, offset
26 Tilt sensor serial number
27 Tilt XM, XB, YM, YB
28 ORP sensor serial number
29 ORP M, B, offset
30 OBS/Nephelometer D&A Backscatterance sensor serial number
31 OBS/Nephelometer D&A Backscatterance gain, offset
32 Altimeter scale factor, offset, hyst, min pressure, hysteresis
33 Microstructure temperature sensor serial number
34 Microstructure temperature pre m, pre_b
35 Microstructure temperature num, denom, AO, Al, A3
36 Microstructure conductivity sensor serial number
37 Microstructure conductivity A0, Al, A2
38 Microstructure conductivity M, B, R
39 Number of external frequencies, number of bytes, number of voltages, instrument type, computer
interface, scan rate, interval, store system time?
40 Data format channels 0 - 9
41 Data format channels 10 - 19
42 Data format channels 20 - 39
43 SBE 16: use water temperature?, fixed pressure, fixed pressure temperature
44 Firmware version
45 Miscellaneous: number of frequencies from SBE 9, number of frequencies from SBE 9 to be
suppressed, number of voltages from SBE 9 to be suppressed, voltage range, add surface PAR
voltage?, add NMEA position data?, include I0W sensors? Add NMEA depth data?
46 0OBS/Nephelometer IFREMER sensor serial number
47 OBS/Nephelometer IFREMER VMO, VDO, DO, K
48 OBS/Nephelometer Chelsea sensor serial number
49 OBS/Nephelometer Chelsea clear water voltage, scale factor
50 ZAPS sensor serial number
51 ZAPS m, b
52 Conductivity sensor calibration date
53 Temperature sensor calibration date
54 Secondary conductivity sensor calibration date
55 Secondary temperature sensor calibration date
56 Pressure sensor calibration date
57 Oxygen (Beckman/YSl type) sensor calibration date
58 pH sensor calibration date
59 PAR light sensor calibration date
60 Transmissometer (SeaTech, Chelsea AlphaTracka, WET Labs Cstar) sensor calibration date
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61 Fluorometer (SeaTech) sensor calibration date

62 Tilt sensor calibration date

63 ORP sensor calibration date

64 OBS/Nephelometer D&A Backscatterance sensor calibration date

65 Microstructure temperature sensor calibration date

66 Microstructure conductivity sensor calibration date

67 IFREMER OBS/nephelometer sensor calibration date

68 Chelsea OBS/nephelometer sensor calibration date

69 ZAPS sensor calibration date

70 Secondary oxygen (Beckman/YSI type) sensor serial number

71 Secondary oxygen (Beckman/YSI type) sensor calibration date

72 Secondary oxygen(Beckman/YSI type) M, B, K, C, SOC, TCOR

73 Secondary oxygen(Beckman/YSI type) WT, PCOR, TAU, BOC

74 User polynomial 1 sensor serial number

75 User polynomial 1 sensor calibration date

76 User polyl A0, Al, A2, A3

77 User polynomial 2 sensor serial number

78 User polynomial 2 sensor calibration date

79 User polynomial 2 A0, Al, A2, A3

80 User polynomial 3 sensor serial number

81 User polynomial 3 sensor calibration date

82 User polynomial 3 A0, Al, A2, A3

83 Dr. Haardt Chlorophyll fluorometer sensor serial number

84 Dr. Haardt Chlorophyll fluorometer sensor calibration date

85 Dr. Haardt Chlorophyll fluorometer AO, Al, BO, B1l, which modulo bit, gain range switching

86 Dr. Haardt Phycoerythrin fluorometer sensor serial number

87 Dr. Haardt Phycoerythrin fluorometer sensor calibration date

88 Dr. Haardt Phycoerythrin fluorometer AO, Al, BO, B1l, which modulo bit, gain range switching

89 Dr. Haardt Turbidity OBS/nephelometer sensor serial number

90 Dr. Haardt Turbidity OBS/nephelometer sensor calibration date

91 Dr. Haardt Turbidity OBS/nephelometer AO, Al, BO, B1l, which modulo bit, gain range switching

92 I0W oxygen sensor serial number

93 I10W oxygen sensor calibration date

94 I10W oxygen AO, Al, A2, A3, BO, Bl

95 10W sound velocity sensor serial number

96 10W sound velocity sensor calibration date

97 I0W sound velocity A0, Al, A2

98 Biospherical natural fluorometer sensor serial number

99 Biospherical natural fluorometer sensor calibration date

100 Biospherical natural fluorometer Cfn, Al, A2, B

101 Sea tech 1s6000 OBS/nephelometer sensor serial number

102 Sea tech 1s6000 OBS/nephelometer sensor calibration date

103 Sea tech 1s6000 OBS/nephelometer gain, slope, offset

104 Fluorometer chelsea Aqua 3 sensor serial number

105 Fluorometer chelsea Aqua 3 sensor calibration date

106 Fluorometer chelsea Aqua 3 scale factor, slope, offset, Vacetone, VB (static), Viug/I

107 Fluorometer turner sensor serial number

108 Fluorometer turner sensor calibration date

109 Fluorometer turner scale factor, offset; or
turner-10au-005 full scale concentration, full scale voltage, zero point concentration

110 Conductivity G, H, 1, J, ctcor, cpcor

111 Temperature FO, G, H, I, J

112 Secondary conductivity G, H, 1, J, ctcor, cpcor

113 Secondary temperature FO, G, H, 1, J

114 WET Labs AC3 beam transmission transmissometer sensor serial number

115 WET Labs AC3 beam transmission transmissometer sensor calibration date

116 WET Labs AC3 beam transmission transmissometer Ch2o, Vh2o, Vdark, x, chlorophyll absorption
Kv, Vh2o, a”x

117 WET Labs WETStar fluorometer sensor serial number

118 WET Labs WETStar fluorometer sensor calibration date

119 WET Labs WETStar Vblank, scale factor

120 Primary conductivity sensor using g, h, i, j coefficients calibration date

121 Primary temperature sensor using g, h, i, j coefficients calibration date

122 Secondary conductivity sensor using g, h, i, j coefficients calibration date

123 Secondary temperature sensor using g, h, i, j coefficients calibration date

124 FGP pressure sensor #0 serial number

125 FGP pressure sensor #0 calibration date

126 FGP pressure sensor #0 scale factor, offset

127 FGP pressure sensor #1 serial number

128 FGP pressure sensor #1 calibration date

129 FGP pressure sensor #1 scale factor, offset

130 FGP pressure sensor #2 serial number

131 FGP pressure sensor #2 calibration date

132 FGP pressure sensor #2 scale factor, offset

133 FGP pressure sensor #3 serial number
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134 FGP pressure sensor #3 calibration date

135 FGP pressure sensor #3 scale factor, offset

136 FGP pressure sensor #4 serial number

137 FGP pressure sensor #4 calibration date

138 FGP pressure sensor #4 scale factor, offset

139 FGP pressure sensor #5 serial number

140 FGP pressure sensor #5 calibration date

141 FGP pressure sensor #5 scale factor, offset

142 FGP pressure sensor #6 serial number

143 FGP pressure sensor #6 calibration date

144 FGP pressure sensor #6 scale factor, offset

145 FGP pressure sensor #7 serial number

146 FGP pressure sensor #7 calibration date

147 FGP pressure sensor #7 scale factor, offset

148 OBS/Nephelometer seapoint turbidity meter sensor serial number
149 0OBS/Nephelometer seapoint turbidity meter sensor calibration date
150 Primary OBS/Nephelometer seapoint turbidity meter gain, scale
151 Secondary OBS/Nephelometer seapoint turbidity meter sensor serial number
152 Secondary OBS/Nephelometer seapoint turbidity meter sensor calibration date
153 Secondary OBS/Nephelometer seapoint turbidity meter gain, scale
154 Fluorometer Dr. Haardt Yellow Substance sensor serial number
155 Fluorometer Dr. Haardt Yellow Substance sensor calibration date
156 Fluorometer Dr. Haardt Yellow Substance AO, Al, BO, B1l, which modulo bit, gain range switching
157 Fluorometer Chelsea Minitraka serial number

158 Fluorometer Chelsea Minitraka calibration date

159 Fluorometer Chelsea Minitraka vacetone, vacetonelOO, offset

160 Seapoint fluorometer serial number

161 Seapoint fluorometer calibration date

162 Seapoint fluorometer gain, offset

163 Primary Oxygen (SBE 43) serial number

164 Primary Oxygen (SBE 43) calibration date

165 Primary Oxygen (SBE 43) Soc, Tcor, offset

166 Primary Oxygen (SBE 43) Pcor, Tau, Boc

167 Secondary Oxygen (SBE 43) serial number

168 Secondary Oxygen (SBE 43) calibration date

169 Secondary Oxygen (SBE 43) Soc, Tcor, offset

170 Secondary Oxygen (SBE 43) Pcor, Tau, Boc

171 Secondary sea tech 1s6000 OBS/nephelometer sensor serial number
172 Secondary sea tech 1s6000 OBS/nephelometer sensor calibration date
173 Secondary sea tech 1s6000 OBS/nephelometer gain, slope, offset
174 Secondary Chelsea Transmissometer sensor serial number

175 Secondary Chelsea Transmissometer calibration date

176 Secondary Chelsea Transmissometer M, B, path length

177 Altimeter serial number

178 Altimeter calibration date

179 WET Labs AC3 serial number

180 WET Labs AC3 calibration date

181 Surface PAR serial number

182 Surface PAR calibration date

183 SEACATplus temperature sensor serial number

184 SEACATplus temperature sensor calibration date

185 SEACATplus temperature sensor A0, Al, A2, A3, slope, offset

186 SEACATplus serial sensor, scans to average, mode

187 Pressure (strain gauge with span TC) serial number

188 Pressure (strain gauge with span TC) calibration date

189 Pressure (strain gauge with span TC) ptempAO, ptempAl, ptempA2, pTCAO, pTCAl, PTCA2
190 Pressure (strain gauge with span TC) pTCBO, pTCB1, pTCB2, pAO, pAl, pA2, offset
191 SBE 38 temperature sensor serial number

192 SBE 38 temperature sensor calibration date

193 Turner SCUFA fluorometer serial number

194 Turner SCUFA fluorometer calibration date

195 Turner SCUFA fluorometer scale factor, offset, units, mx, my, b
196 Turner SCUFA OBS serial number

197 Turner SCUFA OBS calibration date

198 Turner SCUFA OBS scale factor, offset

199 WET Labs ECO-AFL fluorometer serial number

200 WET Labs ECO-AFL fluorometer calibration date

201 WET Labs ECO-AFL fluorometer vblank, scale factor

202 Userpoly 0 name

203 Userpoly 1 name

204 Userpoly 2 name

205 CAPSUM METS serial number

206 CAPSUM METS calibration date

207 CAPSUM METS D, AO, A1, BO, B1, B2, T1, T2

208 Secondary PAR sensor serial number
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209 Secondary PAR sensor calibration date

210 Secondary PAR sensor cal const, multiplier, M, B, offset

211 Secondary WET Labs WETStar Fluorometer sensor serial number

212 Secondary WET Labs WETStar Fluorometer sensor calibration date

213 Secondary WET Labs WETStar Fluorometer Vblank, scale factor

214 Secondary Seapoint Fluorometer sensor serial number

215 Secondary Seapoint Fluorometer sensor calibration date

216 Secondary Seapoint Fluorometer gain, offset

217 Secondary Turner SCUFA Fluorometer sensor serial number

218 Secondary Turner SCUFA Fluorometer sensor calibration date

219 Secondary Turner SCUFA Fluorometer scale factor, offset, units, mx, my, b

220 WET Labs WETStar CDOM sensor serial number

221 WET Labs WETStar CDOM sensor calibration date

222 WET Labs WETStar CDOM Vblank, scale factor

223 Seapoint Rhodamine Fluorometer sensor serial number

224 Seapoint Rhodamine Fluorometer sensor calibration date

225 Seapoint Rhodamine Fluorometer gain, offset

226 Primary Gas Tension Device sensor serial number

227 Primary Gas Tension Device sensor calibration date

228 Primary Gas Tension Device type

229 Secondary Gas Tension Device sensor serial number

230 Secondary Gas Tension Device sensor calibration date

231 Secondary Gas Tension Device type

232 Sequoia LISST-25A sensor serial number

233 Sequoia LISST-25A sensor calibration date

234 Sequoia LISST-25A Total Volume Conc Const, Sauter Mean Diameter Cal, Clean Water Scattering,
Clean Water Trans

235 SBE 45 output conductivity? Output salinity? Output sound velocity? Use 90402 junction box?
SBE 38 remote temperature?

236 SBE 21 remote temperature type

237 SBE 50 serial number

238 SBE 50 calibration date

239 Secondary Chelsea Aqua 3 fluorometer serial number

240 Secondary Chelsea Aqua 3 fluorometer calibration date

241 Secondary Chelsea Aqua 3 fluorometer scale factor, slope, offset, vacetone, vb, vl

242 Chelsea UV Aquatracka serial number

243 Chelsea UV Aquatracka calibration date

244 Chelsea UV Aquatracka a, b

245 SBE 49 temperature sensor serial number

246 SBE 49 temperature sensor calibration date.

247 SBE 49 temperature sensor A0, Al, A2, A3, slope, and offset.

248 Secondary Turner SCUFA OBS serial number

249 Secondary Turner SCUFA OBS calibration date

250 Secondary Turner SCUFA OBS scale factor, offset

251 OBS D&A 3+ serial number

252 OBS D&A 3+ calibration date

253 OBS D&A 3+ a0, al, a2

254 Secondary OBS D&A 3+ serial number

255 Secondary OBS D&A 3+ calibration date

256 Secondary OBS D&A 3+ a0, al, a2

257 SBE 16, 19, 19plus, 21, 25, or 49 scan time added? NMEA time added? NMEA device connected to
PC?

258 SBE 43 Oxygen sensor: use Sea-Bird equation, Soc2007, A, B, C, E, Voffset, Tau20, DO, D1, D2,
H1, H2, H3

259 Secondary SBE 43 Oxygen sensor: use Sea-Bird equation, Soc2007, A, B, C, E, Voffset, Tau20,
DO, D1, D2, H1, H2, H3

260 File version of SB _ConfigCTD.dIl which saved the .con file

261 IFREMER 0OBS/nephelometer sensor serial number

262 Primary Beckman Oxygen Temperature sensor — calibration date

263 Primary Beckman Oxygen Temperature sensor — serial number

264 Secondary Beckman Oxygen Temperature sensor — calibration date

265 Secondary Beckman Oxygen Temperature sensor — serial number

266 I0W Oxygen Temperature sensor — calibration date

267 10W Oxygen Temperature sensor — serial number

268 Methane Gas Tension, Capsum METS sensor — calibration date

269 Methane Gas Tension, Capsum METS sensor —serial number

270 Secondary WET Labs ECO-AFL fluorometer serial number

271 Secondary WET Labs ECO-AFL fluorometer calibration date

272 Secondary WET Labs ECO-AFL fluorometer vblank, scale factor
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Appendix Ill: Generating .con File Reports
— ConReport.exe

The .con file report is an ASCII .txt file that shows all parameters in the .con

file in an easy-to-read form. The .txt report is for viewing and printing only,

and cannot be used to modify parameters in the .con file for processing data.

The .txt file is generated by:

e Clicking Report in a Configuration dialog box (see Instrument
Configuration in Section 4: Configuring Instrument (Configure)), or

e Using ConReport.exe.

ConReport.exe is run from the command line, and accepts wildcards for
the file names, so multiple reports can be produced at one time, and
reports can be placed into a specified directory. ConReport.exe is
automatically installed when you install SBE Data Processing (default location
c:\Program Files\Sea-Bird\SBEDataProcessing-Win32). The format for
running ConReport is:

Conreport InputFilename OutputDirectory /S

Parameter Description

InputFilename is .con file for which you want to generate a
report. Must include full path and file name.

This parameter supports standard wildcard expansion

with *:

InputFilename * matches any set of characters starting at specified
position within file name or extension and continuing
until the end of file name or extension or another
specified character.

OutputDirectory (optional) Full path to location to store output .txt file(s). If

not specified, defaults to location of input .con file(s).
/S (optional) Do not echo messages to screen.

If specifying multiple parameters, insert one or more spaces or tabs

between each parameter in the list.

Example — Generate Reports for All .con Files in Directory, and Save to
Different Directory

The .con files test1.con, test2.con, and test3.con are in c:\legl, and you want to
generate the .txt reports and save them to c:\CruiseSummary.

At the DOS prompt, starting in the directory where ConReport is located
(default c:\Program Files\Sea-Bird\SBEDataProcessing-Win32), type in the
program name and parameters as shown:

conreport c:\legl\*.con c:\CruiseSummary
The program responds:

c:\CruiseSummary\test1.txt

c:\CruiseSummary\test2.txt

c:\CruiseSummary\test3.txt
3 reports written to c:\CruiseSummary
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Appendix IV: Software Problems

Considerable effort has been made to test and check this software before its
release. However, because of the wide range of instruments that Sea-Bird
produces (and interfaces with) and the many applications that these
instruments are used in, there may be software problems that have not been
discovered and corrected. If a problem occurs, please contact us via phone
(425-643-9866), email (seabird@seabird.com), or fax (425-643-9954) with the
following information:

e Instrument serial number

e  Version of the software originally shipped with the instrument
e  Version of the software you are attempting to run

o Complete description of the problem you are having

If the problem involves the configuration or setup of the software, in most
cases a phone call to Sea-Bird will be sufficient to solve the problem. If you
phone, we would appreciate it if you would be ready to run the software
during the phone conversation.

If the problem involves data processing, you may be asked to send a sample of
the data to Sea-Bird for evaluation.

Known Bugs/Compatibility Issues

1. Some users have reported that SBE Data Processing is incompatible with
Windows NT when:

e Internet Explorer is installed on Windows NT, and
e  Active Desktop was installed from Internet Explorer 4.0.

Problem Symptoms: SBE Data Processing works, but Internet Explorer
does not operate properly. Problems include error messages upon opening
Internet Explorer, and/or the inability to cut, paste, copy, delete, or rename
files in Internet Explorer. Uninstalling SBE Data Processing eliminates
the problem with Internet Explorer.

Solution: Uninstall Active Desktop before installing

SBE Data Processing. Internet Explorer and SBE Data Processing
will work properly.
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Appendix V: Derived Parameter Formulas

Note:

Algorithms used for calculation of
derived parameters in Data
Conversion, Derive, SeacalcW, and
Seasave are identical, except as
noted.

For formulas for the calculation of conductivity, temperature, and pressure, see
the calibration sheets for your instrument.

Formulas for the computation of salinity, density, potential temperature,
specific volume anomaly, and sound velocity were obtained from "Algorithms
for computation of fundamental properties of seawater", by N.P. Fofonoff and
R.C Millard Jr.; Unesco technical papers in marine science #44, 1983.

Temperature used for calculating derived variables is IPTS-68.
Following the recommendation of JPOTS, Tgg is assumed to be

1.00024 * Ty (-2 to 35 °C).

Salinity is PSS-78, and by definition is valid only in the range of 2 to 42
psu. Sea-Bird uses the PSS-78 algorithm in our software, without regard
to those limitations on the valid range. Unesco technical papers in marine
science 62 "Salinity and density of seawater: Tables for high salinities
(42 to 50)" provides a method for calculating salinity in the higher range
(http://unesdoc.unesco.org/images/0009/000964/09645 I mb.pdf).

Equations / descriptions are provided for the following parameters:

density (density, sigma-theta, sigma-1, sigma-2, sigma-4, sigma-t)
thermosteric anomaly

specific volume

specific volume anomaly

geopotential anomaly

dynamic meters

depth (salt water, fresh water)

salinity

sound velocity (Chen-Millero, DelGrosso, Wilson)
average sound velocity

potential temperature (reference pressure = 0.0 decibars)
potential temperature anomaly

plume anomaly

specific conductivity

oxygen (if input file contains pressure, temperature, and either
conductivity or salinity, and has not been averaged into pressure or
depth bins) - also requires oxygen current and oxygen temperature
(for SBE 13 or 23) or oxygen signal (for SBE 43)

oxygen saturation
oxygen percent saturation
nitrogen saturation

derivative variables (descent rate and acceleration) - if input file has not
been averaged into pressure or depth bins

corrected irradiance (CPAR)
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density=p=p (s, t,p) [kg/m?]
(density of seawater with salinity s, temperature t, and pressure p, based on the
equation of state for seawater (EOS80))

Density calculation:
Using the following constants -
BO = 8.24493e-1, Bl = -4.0899e-3, B2 = 7.6438e-5, B3 = -8.2467e-7, B4 = 5.3875e-9,
-5.72466e-3, Cl = 1.0227e-4, C2 = -1.6546e-6, DO = 4.8314e-4, AO = 999.842594,
Al = 6.793952e-2, A2 = -9.095290e-3, A3 = 1.001685e-4, A4 = -1.120083e-6, A5 = 6.536332e-9,
FQO = 54.6746, FQ1 = -0.603459, FQ2 = 1.09987e-2, FQ3 = -6.1670e-5, GO = 7.944e-2, Gl = 1.6483e-2,

(@)
o
Ino

G2 = -5.3009e-4, i0 = 2.2838e-3, il = -1.098le-5, i2 = -1.6078e-6, JO =1.91075e-4, MO = -9.9348e-7,
M1 = 2.0816e-8, M2 = 9.1697e-10, EO = 19652.21, E1 = 148.4206, E2 = -2.327105, E3 = 1.360477e-2,

E4 = -5.155288e-5, HO = 3.239908, H1 = 1.43713e-3, H2 = 1.16092e-4, H3 = -5.77905e-7,

KO = 8.50935e-5, K1 =-6.12293e-6, K2 = 5.2787e-8

C Computer Code -
double Density(double s, double t, double p)
// s = salinity PSU, t = temperature deg C ITPS-68, p = pressure in decibars
{
double t2, t3, t4, t5, s32;
double sigma, k, kw, aw, bw;
double val;

t2 = t*t;
t3 = t*t2;
t4 = t*t3;
t5 = t*t4;

if (s <= 0.0) s = 0.000001;

s32 = pow(s, 1.5);

p /= 10.0; /* convert decibars to bars */

sigma = A0 + Al*t + A2*t2 + A3*t3 + A4*t4 + A5*t5 + (BO + Bl*t + B2*t2 + B3*t3 + B4*t4)*s +
(CO + C1*t + C2*t2)*s32 + DO*s*s;

kw = EO + E1*t + E2*t2 + E3*t3 + E4*t4;
aw = HO + H1*t + H2*t2 + H3*t3;
bw = KO + KI1*t + K2*t2;

k = kw + (FQO + FQ1*t + FQ2*t2 + FQ3*t3)*s + (GO + G1*t + G2*t2)*s32 + (aw + (i0 + il*t +
12*t2)*s + (J0*s32))*p + (bw + (MO + M1*t + M2*t2)*s)*p*p;

val =1 - p / k;

if (val) sigma = sigma / val - 1000.0;

return sigma;

Sigma-theta=c4=p (s, 6(s, t, p, 0), 0) - 1000 [kg/m?]

Sigma-1=06,=p (s, 6(s, t, p, 1000), 1000) - 1000  [kg/m?]

Sigma-2=06,=p (s, 6(s, t, p, 2000), 2000) - 1000  [kg/m?]

Sigma-4=06,=p (s, 6(s, t, p, 4000), 4000) - 1000 [kg/m?]

Sigma-t=c;=p (s, t,0) - 1000 [kg/m?]

thermosteric anomaly = 10° ((1000/(1000 + o)) - 0.97266) [10 ® m3/kg]

specific volume = V(s, t,p) = 1/p  [m3/kg]

specific volume anomaly = § = 108 (V(s, t, p) - V(35,0,p))  [10 ¥ m3/kg]
p=p

geopotential anomaly = 10* Y, (8xAp) [J/kg] = [m%s?]

Ap, p=0

dynamic meters = geopotential anomaly / 10.0
(1 dynamic meter = 10 J/kg;
(Sverdup, Johnson, Flemming (1946), UNESCO (1991)))
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Note: depth= [m]

You can also enter the latitude on (When you select salt water depth as a derived variable, SBE Data Processing
the Miscellaneous tab in Data prompts you to input the latitude, which is needed to calculate local gravity.
Conversion or Derive, as SBE Data Processing uses the user-input value, unless latitude is written in the
applicable. input file header [from a NMEA navigation device]. If latitude is in the input

data file header, SBE Data Processing uses the header value, and ignores the
user-input latitude.).

Depth calculation:

C Computer Code —

// Depth

double Depth(int dtype, double p, double latitude)

// dtype = fresh water or salt water, p = pressure in decibars, latitude in degrees

double x, d, gr;

if (dtype == FRESH_WATER) /* fresh water */
d=p * 1.019716;

else { /* salt water */
x = sin(latitude / 57.29578);
X =X * X;
gr = 9.780318 * (1.0 + (5.2788e-3 + 2.36e-5 * xX) * x) + 1.092e-6 * p;
d = (((-1.82e-15 * p + 2.279e-10) * p - 2.2512e-5) * p + 9.72659) * p;
if (gr) d /= gr;

return(d);

salinity = [PSU]
(Salinity is PSS-78, valid from 2 to 42 psu.)

Salinity calculation:
Using the following constants -

Al = 2.070e-5, A2 = -6.370e-10, A3 = 3.989e-15, Bl = 3.426e-2, B2 = 4.464e-4, B3 = 4.215e-1,
B4 = -3.107e-3, CO = 6.766097e-1, Cl = 2.00564e-2, C2 = 1.104259e-4, C3 = -6.9698e-7,

C4 = 1.0031e-9

C Computer Code —

static double a[6] = {/* constants for salinity calculation */
0.0080, -0.1692, 25.3851, 14.0941, -7.0261, 2.7081
};

static double b[6]={ /* constants for salinity calculation */
0.0005, -0.0056, -0.0066, -0.0375, 0.0636, -0.0144

};
double Salinity(double C, double T, double P) /* compute salinity */
// C = conductivity S/m, T = temperature deg C ITPS-68, P = pressure in decibars
{

double R, RT, RP, temp, suml, sum2, result, val;

int i;

if (C <=0.0)

result = 0.0;
else {
/* convert Siemens/meter to mmhos/cm */

14;
* 3*R+B4*R*T;
(A2 + P * A3))) / val;
2+ T*(C3+T=*CA))));

suml = sum2 = 0.0;

for (i = 0;1 < 6;i++) {
temp = pow(RT, (double)i/2.0);
suml += a[i] * temp;
sum2 += b[i] * temp;

}
val = 1.0 + 0.0162 * (T - 15.0);
if (val)
result = suml + sum2 * (T - 15.0) / val;
else

result -99.;

return result;

}
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sound velocity =  [m/sec]
(sound velocity can be calculated as Chen-Millero, DelGrosso, or Wilson)

Sound velocity calculation:

C Computer Code —
// Sound Velocity Chen and Millero
double SndvVelC(double s, double t, double p0) /* sound velocity Chen and Millero 1977 */

/* JASA,62,1129-1135 */

// s = salinity, t = temperature deg C ITPS-68, p = pressure in decibars
{

double a, a0, al, a2, a3;

double b, b0, bl;

double c, c0, cl, c2, c3;

double p, sr, d, sv;

p =p0 / 10.0; /* scale pressure to bars */

if (s <0.0) s = 0.0;

sr = sqrt(s);

d = 1.727e-3 - 7.9836e-6 * p;
7.3637e-5 + 1.7945e-7 * t;
-1.922e-2 - 4.42e-5 * t;
= b0 + bl * p;
(-3.389%e-13 * t + 6.649e-12) * t + 1.100e-10;
((7.988e-12 * t - 1.6002e-10) * t + 9.1041e-9) * t - 3.9064e-7;
(((-2.0122e-10 * t + 1.0507e-8) * t - 6.4885e-8) * t - 1.2580e-5) * t + 9.4742e-5;
(((-3-21e-8 * t + 2.006e-6) * t + 7.164e-5) * t -1.262e-2) * t + 1.389;
a=((@ *p+a2) *p+al) *p + a0;
(-2.3643e-12 * t + 3.8504e-10) * t - 9.7729%e-9;
(((1.0405e-12 * t -2.5335e-10) * t + 2.5974e-8) * t - 1.7107e-6) * t + 3.1260e-5;
(((-6.1185e-10 * t + 1.3621e-7) * t - 8.1788e-6) * t + 6.8982e-4) * t + 0.153563;
((((3-1464e-9 * t - 1.47800e-6) * t + 3.3420e-4) * t - 5.80852e-2) * t + 5.03711) * t +

a3

)
N
I nn

¢}
N
I nn

c0

1402.388;
c=((c3*p+c2) *p+cl) *p+ cO;
sv=c+ (@a+b*sr +d=*s) *s;
return sv;

}

// Sound Velocity Delgrosso
double SndvelD(double s, double t, double p) /* Delgrosso JASA, Oct. 1974, Vol 56, No 4 */
// s = salinity, t = temperature deg C ITPS-68, p = pressure in decibars
{
double c000, dct, dcs, dcp, dcstp, sv;
c000 = 1402.392;

p =p 7/ 9.80665; /* convert pressure from decibars to KG / CM**2 */
dct = (0.501109398873el - (0.550946843172e-1 - 0.22153596924e-3 * t) * t) * t;
dcs = (0.132952290781el + 0.128955756844e-3 * s) * s;

dcp = (0.156059257041e0 + (0.244998688441e-4 - 0.83392332513e-8 * p) * p) * p;

dcstp = -0.127562783426e-1 * t * s + 0.63519161338%-2 * t * p + 0.265484716608e-7 * t * t *
p * p - 0.159349479045e-5 * t * p * p + 0.522116437235e-9 * t * p * p * p - 0.438031096213e-6 * t *
t*t™*p- 0.161674495909e-8 * s * s * p * p + 0.968403156410e-4 * t * t * s + 0.485639620015e-5 *
t*s *s *p - 0.340597039004e-3 * t * s * p;

sv = c000 + dct + dcs + dcp + dcstp;

return sv;

}

// sound velocity Wilson
double SndvelW(double s, double t, double p) /* wilson JASA, 1960, 32, 1357 */
// s = salinity, t = temperature deg C ITPS-68, p = pressure in decibars

{
double pr, sd, a, vO, vl, sv;
pr = 0.1019716 * (p + 10.1325);
sd = s - 35.0;
a = (((7.9851e-6 * t - 2.6045e-4) * t - 4.4532e-2) * t + 4.5721) * t + 1449.14;
sv = (7.7711e-7 * t - 1.1244e-2) * t + 1.39799;
vO = (1.69202e-3 * sd + sv) * sd + a;
a = ((4.5283e-8 * t + 7.4812e-6) * t - 1.8607e-4) * t + 0.16072;
sv = (1.579e-9 * t + 3.158e-8) * t + 7.7016e-5;
vl = sv * sd + a;
a = (1.8563e-9 * t - 2.5294e-7) * t + 1.0268e-5;
sv = -1.2943e-7 * sd + a;
a = -1.9646e-10 * t + 3.5216e-9;
sv = (((-3-3603e-12 * pr + a) * pr + sv) * pr + vl) * pr + vO;
return sv;
b
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pP=p
di
R Ap,p=min
average sound velocity = [m/s]
p=p
d i / Vi
Ap,p=min

Average sound velocity is the harmonic mean (average) from the surface to
the current CTD depth, and is calculated on the downcast only. The first
window begins when pressure is greater than a minimum specified pressure
and salinity is greater than a minimum specified salinity. Depth is calculated
from pressure based on user-input latitude (regardless of whether latitude data
from a NMEA navigation device is in the data file).
e In Derive, the algorithm is based on the assumption that the data has been
bin averaged already. Average sound velocity is computed scan-by-scan:
d; = depth of current scan — depth of previous scan  [meters]
Vi = sound velocity of this scan (bin) [m/sec]
e In Seasave and Data Conversion, the algorithm also requires user input of a
pressure window size and time window size. It then calculates:
d; = depth at end of window — depth at start of window [meters]
Vi=
(sound velocity at start of window + sound velocity at end of window) / 2 [m/sec]

When you select average sound velocity as a derived variable, SBE Data
Processing prompts you to enter the minimum pressure, minimum salinity, and
if applicable, pressure window size and time window size.

Note:

You can also enter the user-input
parameters on the Miscellaneous
tab in Data Conversion or Derive,
as applicable.

Surface

Average

> Minimum specified pressure and salinity —g———— sound velocit
und velocity

y di andv; Average

sound velocity

A

d; and v;

v

136



Appendix V: Derived Parameter Formulas

potential temperature [IPTS-68]1=6 (s, t,p, pr) [°C]

(Potential temperature is the temperature an element of seawater would have if
raised adiabatically with no change in salinity to reference pressure p;.
Sea-Bird software uses a reference pressure of 0 decibars).

Potential Temperature [IPTS-68] calculation:

C Computer Code -
// ATG (used in potential temperature calculation)
double ATG(double s, double t, double p) /* adiabatic temperature gradient deg C per decibar */

/* ref broyden,h. Deep-Sea Res.,20,401-408 */

// s = salinity, t = temperature deg C ITPS-68, p = pressure in decibars
{

double ds;

ds = s - 35.0;

return((((-2.1687e-16 * t + 1.8676e-14) * t - 4.6206e-13) * p + ((2.7759%9e-12 * t - 1.1351e-
10) * ds + ((-5.4481e-14 * t + 8.733e-12) * t - 6.7795e-10) * t + 1.8741e-8)) * p + (-4.2393e-8 * t
+ 1.8932e-6) * ds + ((6.6228e-10 * t - 6.836e-8) * t + 8.5258e-6) * t + 3.5803e-5);

// potential temperature
double PoTemp(double s, double tO, double p0O, double pr) /* local potential temperature at pr */
/* using atg procedure for adiabadic lapse rate */
/* Fofonoff,N.,Deep-Sea Res.,24,489-491 */
// s = salinity, t0O = local temperature deg C ITPS-68, pO = local pressure in decibars, pr =
reference pressure in decibars

{

double p, t, h, xk, g, temp;

p = po;

t = t0;

h = pr - p;

xk = h * ATG(s,t,p);

t += 0.5 * xk;

q = xk;

p += 0.5 * h;

xk = h * ATG(s,t,p);

t += 0.29289322 * (xk-q);

q = 0.58578644 * xk + 0.121320344 * (q;

xk = h * ATG(s,t,p);

t += 1.707106781 * (xk-Q):

q = 3.414213562 * xk - 4.121320344 * q;

p += 0.5 * h;

xk = h * ATG(s,t,p);

temp =t + (xk - 2.0 * q) /7 6.0;

return(temp);
3

potential temperature [ITS-90] =0 (s, t, p, py) / 1.00024 [°C]
potential temperature anomaly =
potential temperature - a0 - al x salinity
or

Note: potential temperature - a0 - al x Sigma-theta
You can also enter the user-input (When you select potential temperature anomaly as a derived variable,
parameters on the Miscellaneous SBE Data Processing prompts you to enter a0, al, and the selection of salinity
tab in Data Conversion or Derive, or sigma-theta.)
as applicable.

plume anomaly =
potential temperature (s, t, p, Reference Pressure) — Theta-B

— Theta-Z / Salinity-Z * (salinity — Salinity-B)
Note: (When you select plume anomaly as a derived variable, SBE Data Processing

You can also enter the user-input prompts you to enter Theta-B, Salinity-B, Theta-Z / Salinity-Z, and
parameters on the Mlscellaneous Reference Pressure.)

tab in Data Conversion; plume
anomaly is not available as a
derived variable in Derive.

specific conductivity = (C * 10,000) / (1 + A* [T —25]) [microS/cm]

(C = conductivity (S/m), T = temperature (° C),
A = thermal coefficient of conductivity for a natural salt solution
[0.019 - 0.020]; Sea-Bird software uses 0.020.)
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Note:

You can also enter the oxygen
window size, and enable / disable the
Tau and hysteresis corrections, on the
Miscellaneous tab in Data Conversion
or Derive, as applicable.

Note:

The hysteresis correction can be
performed to calculate and output
oxygen voltage and/or calculated
oxygen (ml/l, etc.) in Data Conversion.
Hysteresis-corrected voltage from
Data Conversion can be further
processed in other modules (such as
Align CTD) before calculating oxygen
values (ml/l, etc.) in Derive.

Oxygen [ml/1] is calculated as described in Application Note 64: SBE 43
Dissolved Oxygen Sensor or Application Note 13-1: SBE 13, 23, 30 Dissolved
Oxygen Sensor Calibration & Deployment.

When you select oxygen as a derived variable, Data Conversion prompts you
to enter the window size (seconds), and asks if you want to apply the Tau
correction and the hysteresis correction:

e Tau correction — The Tau correction ([tau(T,P)*5V/5t] in SBE 43 or
[tau*doc/dt] in SBE 13 or 23) improves response of the measured signal
in regions of large oxygen gradients. However, this term also amplifies
residual noise in the signal (especially in deep water); in some situations
this negative consequence overshadows gains in signal responsiveness.

If the Tau correction is enabled, oxygen computed by Seasave and Data
Conversion is somewhat different from values computed by Derive. Both
algorithms compute the derivative of the oxygen signal with respect to
time (with a user-input window size for calculating the derivative), using a
linear regression to determine the slope. Seasave and Data Conversion
compute the derivative looking backward in time, since they share
common code and Seasave cannot use future values of oxygen while
acquiring data in real time. Derive uses a centered window (equal number
of points before and after the scan) to obtain a better estimate of the
derivative. Use Seasave and Data Conversion to obtain a quick look at
oxygen values; use Derive to obtain the most accurate values.

e  Hysteresis correction (SBE 43 only, when using Sea-Bird equation) -
Under extreme pressure, changes can occur in gas permeable Teflon
membranes that affect their permeability characteristics. Some of these
changes (plasticization and amorphous/crystalinity ratios) have long time
constants and depend on the sensor’s time-pressure history. These slow
processes result in hysteresis in long, deep casts. The hysteresis correction
algorithm (using H1, H2, and H3 coefficients entered for the SBE 43 in
the .con file) operates through the entire data profile and corrects the
oxygen voltage values for changes in membrane permeability as pressure
varies. At each measurement, the correction to the membrane permeability
is calculated based on the current pressure and how long the sensor spent
at previous pressures.

Hysteresis responses of membranes on individual SBE 43 sensors are very
similar, and in most cases the default hysteresis parameters provide the
accuracy specification of 2% of true value. For users requiring higher
accuracy (1 pmol/kg), the parameters can be fine-tuned, if a complete
profile (descent and ascent) made preferably to greater than 3000 meters
is available. H1, the effect’s amplitude, has a default of -0.033, but can
range from -0.02 to -0.05 between sensors. H2, the effect’s non-linear
component, has a default of 5000, and is a second-order parameter that
does not require tuning between sensors. H3, the effect’s time constant,
has a default of 1450 seconds, but can range from 1200 to 2000.
Hysteresis can be eliminated by alternately adjusting H1 and H3 in the
.con file during analysis of the complete profile. Once established, these
parameters should be stable, and can be used without adjustment on other
casts with the same SBE 43.

When you select oxygen as a derived variable, Derive prompts you to enter
the window size (seconds), and asks if you want to apply the Tau correction
(described above for Data Conversion). You cannot apply the hysteresis
correction in Derive, to prevent users from applying the correction to oxygen
voltage in Data Conversion and then applying it again in Derive, providing
erroneous results.

44660
Sigma-theta + 1000

oxygen [umoles/kg] = oxygen [mi/I]
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Oxygen saturation is the theoretical saturation limit of the water at the

local temperature and salinity value, but with local pressure reset to zero

1’\'Ifc1)éec;xygen saturation equation based (1 atmosphere). This calculation represents What.the local parcel of water

on work from Garcia and Gordon could have absorbed from the atmosphere when it was last at the surface (p=0)
(1992) reduces error in the Weiss but at the same (T,S) value. Oxygen saturation can be calculated as Garcia and
(1970) parameterization at cold Gordon, or Weiss —

temperatures.

Garcia and Gordon:

Oxsol(T,S) = exp {A0 + A1(Ts) + A2(Ts) > + A3(Ts) > + A4(Ts) * + A5(Ts) >
+S * [BO + B1(Ts) + B2(Ts) > + B3(Ts) *] + CO(S) %}

where

e  Oxsol(T,S) = oxygen saturation value (ml/l)

e S =salinity (psu)

e T =water temperature (°C)

e Ts=In[(298.15-T)/(273.15+T)]

e A0=2.00907 A1=3.22014 A2 =4.0501
A3 =4.94457 A4=0.256847 A5 =3.88767
e B0=-0.00624523 B1=-0.00737614
B2 =-0.010341 B3 =-0.00817083
e C0=-0.000000488682
Weiss:

Oxsat(T,S) =exp {[Al + A2 * (100/T,) + A3 * In(T,/100) + A4 * ( T,/100)]
+S * [B1 + B2 * (T,/100) + B3 * (T,/100)* ]}

where

Oxsat(T,S) = oxygen saturation value (ml/1)

S = salinity (psu)

T =water temperature (°C)

T, =absolute water temperature (°C +273.15)

Al1=-173.4292 A2=249.6339 A3=143.3483 A4=-21.8492

B1=-0.033096 B2=0.014259 B3 =-0.00170

Oxygen, percent saturation is the ratio of calculated oxygen to oxygen

saturation, in percent:

(Oxygen / Oxygen saturation) * 100%.

The Oxygen Saturation value used in this calculation is the value that was used

in the Oxygen calculation —

e SBE 43 -if you selected the Sea-Bird equation in the .con file, the
software uses the Garcia and Gordon Oxsol in this ratio; if you selected
the Owens-Millard equation in the .con file, the software uses the Weiss
Oxsat in this ratio.

e SBE 13, 23, or 30 — the software uses the Weiss Oxsat for this ratio.

Nitrogen saturation is the theoretical saturation limit of the water at the

local temperature and salinity value, but with local pressure reset to zero
Note: (1 atmosphere). This calculation represents what the local parcel of water could

The nitrogen saturation equation is have absorbed from the atmosphere when it was last at the surface (p=0) but at
based on work from Weiss (1970). the same (T,S) value.

N2sat(T,S) =exp {[Al + A2 * (100/T,) + A3 * In(T,/100) + A4 * (T,/100) ]
+S * [B1 + B2 * (T,/100) + B3 * (T,/100)* ]}

where

e N2Sat(T,S) = nitrogen saturation value (ml/l)

e S =salinity (psu)

T =water temperature (°C)

T, =absolute water temperature (°C + 273.15)

Al =-172.4965  A2=248.4262 A3=143.0738 A4=-21.7120

B1=-0.049781 B2=0.025018 B3 =-0.0034861
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Appendix V: Derived Parameter Formulas

Descent rate and acceleration are computed by calculating the derivative of
the pressure signal with respect to time (with a user-input window size for
calculating the derivative), using a linear regression to determine the slope.
Values computed by Seasave and Data Conversion are somewhat different
from values computed by Derive. Seasave and Data Conversion compute the
derivative looking backward in time (with a user-input window size), since
they share common code and Seasave cannot use future values of pressure
while acquiring data in real time. Derive uses a centered window (equal
number of points before and after the scan; user-input window size) to obtain a

better estimate of the derivative. Use Seasave and Data Conversion to obtain a
quick look at descent rate and acceleration; use Derive to obtain the most
accurate values.

(When you select descent rate or acceleration as a derived variable, SBE Data
Processing prompts you to enter the window size (seconds).)

Note:

You can also enter the descent rate
and acceleration window size on the
Miscellaneous tab in Data Conversion
or Derive. as applicable.

Corrected Irradiance [CPAR] =

,l;lgrtibmplete description of ratio . ~100* ratip multiplier * underwater PAR / surface PAR [%0]
multiplier, see Application Note (Ratio multiplier = scaling factor used for comparing light fields of disparate
11S (SBE 11plus Deck Unit) or intensity, input in .con file entry for surface PAR sensor;

47 (SBE 33 or 36 Deck Unit). Underwater PAR = underwater PAR data;

Surface PAR = surface PAR data)
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